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Sending Mail Messages

This screen allows you to prepare new mail messages and replies.

Circulation messages
Addressing your message
The subject field
Confirmation of reading
Confirmation of delivery
Keeping a copy of your message
Urgent messages
Encryption
Rich text
Signatures
Editing your message
Attachments
Other message options
Importing text from other sources

The editor toolbar



Circulation messages

A circulation message is a specialised form of mail message where instead of being sent to all the 
addressees you enter, the message is sent to each recipient in turn and then automatically forwarded 
onto the next recipient when he or she has finished with it.

Each recipient can opt to add comments to the message and when it leaves the final recipient, it is 
automatically returned to the original sender. Circulation messages are an extremely easy and powerful 
way of passing ideas around for comment and discussion between multiple people.

To start a circulation message, choose Circulation message from the New message submenu of the File 
menu. This will open a message editor window that looks and behaves in almost exactly the same way as
a regular message editor. You can enter any text you wish in the message, including formatted text, and 
you can add attachments to the message as well.

When you select the addresses through which the message is to be circulated, remember that the 
message passes to each person in order, so if there are people who need to see the message more 
urgently than others, enter their addresses at the start of the list. You can use a distribution list if you wish 
- the message will be circulated using the order of addresses in the list.

You cannot specify a CC or BCC address with a circulation message, since this would interfere with the 
circulation process. When the message is sent, a small informational section is attached to your message
giving instructions to the recipients.

If you request confirmation of reading for a circulation message, then you will receive confirmation when 
the message is opened by each recipient, and also a separate confirmation when each recipient forwards 
the message to the next recipient. This allows you to track the progress of the message as it circulates.



Addressing your message

Just as the postal service needs an address to be able to deliver a letter, Pegasus Mail requires an 
address to be able to send your electronic mail. Depending on your system and network you might be 
able to use any of several types of address, each slightly different. There are many ways you can enter 
addresses into Pegasus Mail's To and CC address fields, and many types of address you can potentially 
use.

Local addresses: You can enter the username of any user on your file server, or on any other file 
server to which Pegasus Mail can deliver. If you are running on a Novell NetWare LAN, then you 
should using the standard NetWare username syntax for your server type

Bindery (NetWare 3.x) USERNAME, or SERVER/USERNAME
NDS (NetWare 4.x) username (current context) or username.context

You can obtain a list of local users at any time by pressing <F2>; you can drag and drop addresses 
from that list into any address field.

Internet Addresses: If your system has an SMTP gateway, then you can enter any valid Internet 
address in the address fields.

NetWare MHS Addresses: If your system has an MHS gateway then you can enter any valid NetWare
MHS address in the address fields. If you are using an advanced MHS transport, you can access 
MHS directory services from the Addresses menu.

Aliases ("nicknames", to Eudora users): You can enter the "name" field from any entry in any of your 
addressbooks as if it were an address - Pegasus Mail will replace it with the correct address when the
message is sent. You can also drag any addressbook entries and drop them directly into the address 
fields of the message if you wish.

Recently-used addresses: The "?" button next to each address field brings up a list of addresses you 
have used recently - double-click any of these addresses to use them in the address field of your 
message.

Specialised directory services: Pegasus Mail's Addresses menu contains a number of specialised 
services, such as LDAP and PH clients, which you may be able to use to look up addresses. Consult 
your system manager for information on whether or not these services are available in your local 
environment, and on how to set them up.

You can also prepare distribution lists, or lists of addresses you use frequently.



The To: field of a message indicates the primary recipient of a message



A CC (carbon copy) recipient of a message is someone you want to "listen in" to the message you are 
sending to the primary recipient. CC recipients receive the message normally but their addresses do not 
appear in the To: field of the message.



Use a BCC (Blind Carbon Copy) when you want to send a copy of your message to someone other than 
the primary recipient without the primary recipient knowing you have done so. Unlike CC, when you use 
BCC, there is no indication in the primary recipient's copy of the message that you have copied anyone 
else. BCC is very handy for office politics.



An SMTP gateway allows you to send mail to machines on the Internet (a huge world-wide computer 
network), or to machines which use the Internet RFC821/822 message protocols. Almost all Unix systems
and many mainframe and minicomputer systems can receive mail using this protocol.



NetWare MHS is Novell's messaging system. There are several versions of it for both NetWare and non-
NetWare environments. Pegasus Mail supports all versions of NetWare MHS, including NetWare Global 
MHS. Ask your system administrator if you're unsure whether or not this option is available on your 
server.



The Subject field

Enter a short summary of your message in the subject field. Because the recipient will use the subject line
as a filing key, you should try to make it as descriptive and helpful as possible. When replying to a 
message, it is customary for the subject to be Re: <the original subject>: Pegasus Mail will automatically 
format the subject this way for you when preparing replies.

The subject field can be up to 128 characters long.



Confirmation of reading

If you want to be notified when the recipient reads your message, check the confirm reading box in the 
message editing window. A small message will be sent back to you when the message is read. Note: the 
recipient must be using a version of Pegasus Mail for receipt confirmation to work. Some MHS mail 
systems may also be able to provide receipt confirmations.

The System administrator can allow users to refuse confirmation of reading because many people feel 
that it is an invasion of privacy. If you attempt to mail to a local user who will not provide confirmation of 
reading, a small dialog will appear when you send the message advising you of this. If you mail to a non-
local Pegasus Mail user who will not permit confirmation of reading you will not receive any notification at 
all.

The default state of the confirm reading control is "sticky" - Pegasus Mail will remember its setting from 
message to message and between sessions. You can also set it to be always on or always off by default 
in your message settings preferences.



Confirmation of Delivery

Checking the confirm delivery box in the message editing window tells Pegasus Mail to ask for 
confirmation that your message has been delivered successfully. Confirmation of delivery differs from 
confirmation of reading in that you are only advised that the message has been delivered to the recipient, 
not that it has been read.

Confirmation of delivery is always available if you are using NetWare MHS. You will never get 
confirmation of delivery on local mail (because Pegasus Mail will tell you immediately if it fails to deliver 
your message). With Internet mail, you may or may not receive confirmation of delivery, because there 
are no guaranteed ways of asking for it.

The default state of the confirm delivery control is "sticky" - Pegasus Mail will remember its setting from 
message to message and between sessions. You can also set it to be always on or always off by default 
in your message settings preferences.



Keeping a copy of your message

If you want to keep a copy of the messages you send, check the copy self box in the message editing 
window. Pegasus Mail will file a copy of your message in a folder called "Copies to self" which it will 
create automatically when necessary. Pegasus Mail can also ask you whether you want a copy to self on 
a message by message basis, and can prompt you to select a folder for the copy to self at the time the 
message is sent (see the Sending mail page of of the Tools | Options preferences dialogs for these 
settings).

If your "Copies to self" folder becomes too full, you can force Pegasus Mail to create a new copyself 
folder by simply renaming the existing one. You can move your copies-to-self folder anywhere in your 
folder hierarchy.

You can specify the name Pegasus Mail should use for your copy-to-self folder in your preferences.

The default state of the copy self control is "sticky" - Pegasus Mail will remember its setting from message
to message and between sessions. You can also set it to be always on or always off by default in your 
message settings preferences.



Urgent Messages

Check the urgent box in the message editing window if you want your message to be sent at the highest 
priority available on the message transport your system uses. The effect of setting this flag will vary from 
system to system. Many MHS mailers will recognize it, as will some Internet mailers. Pegasus Mail 
displays urgent messages at the top of the new mail folder in red text, and sends a different new mail 
notification to the recipient to indicate that the message is urgent.

Note: You should use the urgent flag with care: urgent messages can be annoying, and overuse of the 
feature seriously impacts on its usefulness.



Pegasus Mail's encryption module

If your message contains sensitive or private information, you might want to encrypt it. An encrypted 
message is scrambled, and can only be read by someone who knows the correct password. You can 
encrypt your message using Pegasus Mail's built-in encryptor, or if you have one, using a third party 
encryption module.

To encrypt your message, click the Encrypt button in the message editor. A small dialog will open into 
allowing you to select an encryptor. If you choose Built-in encryptor (the default) then you can enter a 
password using the following rules: the password should have from five to eight characters and is case-
sensitive - so FOOBAR and foobar are different passwords. Press OK to add the password, or Cancel to 
remove it. Pegasus Mail will encrypt the message using your password when it sends it.

The recipient must know the password, so you will have to make arrangements in advance to agree on a 
suitable choice. Don't forget the password! If you forget it, you will never be able to read your message 
again; even the author of Pegasus Mail cannot break the encryption method it uses.



Rich text

Pegasus Mail allows you to incorporate complex text formatting in your message - things like bold, italics, 
font changes, indenting and so forth: this kind of complex formatting is called Rich text. Unfortunately, not 
all mail programs support the display of messages containing rich text, so you may wish to be careful 
about using it.

When you make a change to your message that will result in it being sent in a rich text format, the Rich 
text control in the message editor will be automatically checked. You can force the message to be sent as 
plain text, regardless of any formatting it contains, by unchecking this control. Once you have unchecked 
it, it will not come back on automatically no matter what formatting you apply. If you wish, you can also 
check this control to force a message to be sent in rich text format - this may occasionally be necessary 
after pasting formatted data from other programs, since Pegasus Mail cannot always detect the presence 
of formatting in such data.

You can tell Pegasus Mail that it should never generate messages containin rich text using the options in 
the Sending mail preferences page.



Signatures

See also: Preferences overview
Tutorial: editing your signatures

A signature is a small fragment of text which Pegasus Mail will automatically add to the end of messages 
you send. You should usually put your name, address and phone/fax number in your signature, although 
some people like to place a witty saying or other text there as well.

Pegasus Mail supports nine different signatures that you can select on a message by message basis. 
Because Pegasus Mail supports a variety of message formats and delivery transports, each "signature" is
actually a set of three signatures - one that Pegasus Mail will attach any time you send mail locally using 
its own built-in delivery agent, one that will be attached to Internet mail messages you send, and a third 
that will be attached to any messages you send via Novell MHS (if you are using it). Note that the 
selection of a signature is based on the transport mechanism, so if you send a message to a user on your
file server but do so via an Internet transport such as Mercury or Charon, your Internet signature will be 
attached to the message. Each signature set can be given a short name to jog your memory.

For each of your nine signature sets, you can create both formatted and unformatted versions of your 
signatures: the unformatted version will be attached to plain text messages, while the formatted version 
will be attached to any message that contains formatting - pictures, tables, bold and so on. The formatted 
variants of your signatures can themselves contain tables and pictures if you wish.

Why do you need signature sets? Usually the information you present in your signature will include 
things like your e-mail address, which may be different on different transports. For example, if you are 
sending Local and Internet mail you may well express your address differently (possibly "THALIA/DAVID" 
for your local address, but "david@pmail.gen.nz" for your Internet address). Having separate signatures 
for each transport allows you to present information that is appropriate in each environment.

You can select the signature that should be used by default using the Signatures preferences page of the 
Tools | Options dialog. You can also specify that no signature should be added by default in the same 
location. Pegasus Mail's identity feature allows you to select a different default signature for each identity 
you use.

To edit a signature set, choose Options from the Pegasus Mail Tools menu, select the Signatures page, 
and click Edit signatures. In the signature editor that opens, select the signature set, transport (local, 
internet or MHS) and variant (formatted or unformatted) you want to edit and make any changes you 
need. You can make changes to more than one signature without closing the window - Pegasus Mail will 
prompt you to save any changes you have made before switching to the next signature. 

You do not have to create signatures for transports you do not use, so if you only ever send Internet and 
Local mail, you do not have to create an MHS signature.

Add this variant of the default signature upon message creation    If you would prefer to have your 
signature added to the message at the time you edit it instead of at the time the message is sent, check 
this control, which will enable the list box containing the various signature variants in the set. Choose the 
one you would like Pegasus Mail to add when the message editor window is created.

To select a signature set for your mail message, simply choose it in the Signature list control in the 
message editor. You can also choose "No signature" in this control if you don't want a signature added to 
your message.

Variable signatures:    Pegasus Mail can place a piece of text selected at random from a list you provide in
your signature -- for more information on preparing a variable signature, examine the sample quotes file 
RQUOTES.R in the RESOURCE\ subdirectory of the directory where you installed Pegasus Mail. To flag 
the location in your signature where you want the variable text to be placed, use the special characters ~!.



Be careful when using variable signatures -- people's tastes differ hugely all around the world, and 
something which seems witty to you may be offensive to other people.



Editing your message

Edit your message in the large message box at the bottom of the message editing window. The message 
text will word-wrap when it reaches the right hand margin, or you can press <Enter> to end a line at any 
time. You can cut text from and paste text into your message using the Edit menu, or using the options on
the right-click menu in the editor itself.

You can check your spelling by positioning the cursor at the point in the message where checking should 
begin and selecting Check spelling from the Tools menu, or by pressing Ctrl+K, or by clicking the Check 
spelling button. 

Ctrl+Y deletes the current line in the message, Ctrl+T deletes the word to the right of the cursor, and 
Ctrl+J reformats the current paragraph so that all its text falls between the left and right margin.

ASCII indenting    Ctrl+D opens the Indenting dialog, which contains commands that allow you to reformat 
your text with indented left and/or right margins, using only ASCII spaces. This approach differs from 
using the indenting commands on the message editor's toolbar in that no tabs are used, and the results 
are guaranteed to be readable in even the most basic mail readers. The downside of using ASCII 
indenting as opposed to regular indenting is that paragraphs will no longer wordwrap correctly after you 
have applied it, so if you plan to use this feature, always do so after you have fully edited your text.

You can store abbreviations for commonly-used text in Pegasus Mail's glossary, and expand it at any time
by pressing <Ctrl+E>.

Send your message at any time by clicking the Send button, or by pressing <Ctrl+Enter>.



Attachments

You can attach files to your mail message by clicking on the Attach button in the message editing window.
The message editor view will change to one which allows you to choose files and control the way 
Pegasus Mail will deal with them. When your message has attachments, a small attachment indicator, like

this  will appear to the right of the tab controls in the message editor.

Pegasus Mail will handle your attachments differently, depending on the destination of the message. You 
can have considerable control over this process if you wish, although Pegasus Mail's automatic handling 
is usually more than adequate for all situations.

Choose any of the following items for more information on attachments:

Selecting files to attach
Indicating the file type
Attachment encoding



Selecting files to attach

Before you select files to attach to your message, make sure that the File type and Attachment encoding 
fields in the dialog are set correctly.

For the Win32 version of Pegasus Mail:  click the Add attachment button at the bottom of the window and 
locate the file you want to attach using the standard Windows File Open dialog.

For the Win16 version of Pegasus Mail, there are two ways you can add an attachment:

Use the file and directory lists at the bottom of the window to navigate your disks. Double-clicking a 
filename will add it to the attachment list with the current settings of the file type and attachment 
encoding fields.

Type in the name (including an optional DOS path) of the file in the filename window. When you press
<Enter> or click Add, Pegasus Mail will add the file to the attachment list, or if you have entered a 
directory name, will change the file and directory list boxes to reflect the new directory.

You can remove attachments from the attachment list by highlighting them and clicking Remove. You 
cannot change the settings for an attachment once you have added it to the list - remove it and re-add it 
instead.

Recently-used files, recently-used directories    At the extreme top right of the attachment view, you will 
see a small button labelled "?". Click this button to access a list of files you have attached to recent 
messages. Double-clicking any of these files will attach it to the current message using the selected 
attachment encoding and type options. Next to the Filename edit field, you will see another "?" button: this
accesses a list of directories you have browsed recently: double-clicking any of these directories will 
select it and display its contents in the various controls.



File type

You can tell Pegasus Mail what type of file you are attaching by choosing from a predefined list of file 
types. The file type information is optional and is currently used only for informational purposes - the 
recipient will usually see then file type when examining the list of files attached to the message.

The file type information can be used to provide attachment viewing facilities, or to launch the original 
application with the attachment, so you should get into the habit of filling it in.

If you are uncertain of the type of file, you should use Unknown, the default choice.

Note: Pegasus Mail will not perform file conversion - Pegasus Mail will not convert an MS-Word file to 
WordPerfect format even if you indicate WordPerfect format here - it will simply convey the wrong 
information. It is up to you to ensure that the file type information is appropriate for the file you are 
attaching.

Tip for advanced users:    Pegasus Mail uses a file called FILETYPE.PM, which is located in your home 
mailbox directory, to determine file types. You can edit this file to change or add new types. The sample 
version of this file, which was installed in the RESOURCE subdirectory of the directory where you installed 
Pegasus Mail, contains full documentation on modifying FILETYPE.PM - but do so with care! The file 
format is not forgiving of errors.



Attachment encoding

When you send an attachment, it cannot always be transmitted as-is. Sometimes it is necessary to 
package the attachment in a particular way so that the mail transport system or the recipient's mailer can 
understand it. Pegasus Mail will always make sensible default choices about attachment encoding - you 
should only need to change the attachment encoding in very special cases. Pegasus Mail supports the 
following attachment encodings:

Pegasus Mail decides. The default setting, this tells Pegasus Mail to do whatever is appropriate 
based on the way it sends the message. Attachments to local and MHS addresses will not be 
encoded in any way, while attachments to Internet addresses will be uuencoded prior to transmission.
We strongly recommend that you always use this encoding unless you are very sure of what you are 
doing, and of the need to use another of the specific encodings described below.

No encoding. Instructs Pegasus Mail not to encode the attachment at all. This is an extremely 
dangerous choice in some cases, particularly for Internet mail. Use it only if you know that the 
attachment is a plain text file with no high bit characters.

ASCII text. Indicates that the file is plain text with no formatting or high-bit characters. Pegasus Mail 
will actually send the attachment as a separate message rather than as an attachment.

UUencoding. A scheme used widely on the Internet. If you are mailing via the Internet, or to a user on 
a Unix or mainframe system this encoding is a good choice.

BinHex. Used heavily in the Macintosh world. BinHex is a good format, containing a certain amount of
error checking and compression. Because it is not widely used outside the Macintosh world, you 
should check in advance that the recipient is able to deal with BinHex-encoded files.

MIME Encodings:    MIME (Multipurpose Internet Mail Extensions) is an Internet standard for 
multimedia mail which allows different mail applications to exchange a variety of types of information. 
If you select any of these MIME encodings, Pegasus Mail will attach the information necessary for 
other applications to be able to decode the file. You must choose an appropriate translation - selecting
"GIF image" for a TIFF file will not cause Pegasus Mail to convert the file: it will simply be sent in the 
wrong format. Pegasus Mail will choose basic MIME encoding automatically if you set encoding to 
"Pegasus Mail decides" and have checked the "Use MIME features" control in the "Special" screen of 
the message editing dialog.



Other message options

Select Other message options from the Message menu, or click on the "Special" button in the message 
editing dialog and the screen will change to a dialog which allows you to control less frequently-used 
features for your message.

BCC. Enter any BCC. addresses in this field.

Send replies to. If you want replies to your message to go to an address other than your own, enter that 
address in this field.

Identity    This controls the identity used to create this message. If you select a different identity, some 
other settings for the message, especially your signature, may also change.

Use MIME features for Internet and local mail    MIME is an an Internet standard that allows mailers on 
different systems to exchange binary data and messages using International characters. If you check this 
control, Pegasus Mail will use MIME encodings to represent accented and special characters, and to 
package attachments so that other MIME-compatible mail systems can read and convert them. MIME is a
very powerful standard, and the only time you should not check this control is if you believe your 
correspondent may not be using a MIME-compatible mail system.

Leave the message window open even when successfully sent    If you check this control, Pegasus Mail 
will not close the message editor window after you have successfully sent the message. This allows you 
to make changes to the message and send it again as required. Discard the window when you no longer 
need it by clicking the Cancel button.

Obsolete after. If your message is only meaningful for a certain length of time, enter the time after which it
is obsolete in this area. Obsolete messages appear grey in the folder window, and there is a browser 
command which will purge all obsolete messages. Obsolete mail mail also be purged by utilities run by 
the system manager.

Message width. This field allows you to specify the average length of a line of text in your message. 
Pegasus Mail will adjust the margin of the message editor so that approximately the number of characters
you specify will fit on a line. You cannot enter a width wider than the current width of the editing window.

Average tab width. By default, Pegasus Mail obeys the standard Windows convention that the <Tab> key 
moves from field to field in a dialog. If you enter a width in this field, however, Pegasus Mail will insert the 
<Tab> characters in the message instead. You can only change the tab width if tabs were enabled when 
you started the message. The width you enter is an average based on the average width of characters in 
the current font; it will only be exact if you use a monospace font such as Courier.

Custom headers    This option allows you to add specific message headers directly into the mail message 
generated by Pegasus Mail. It is a very technical option and should only be used if you know exactly what
you are doing. Click Add and Pegasus Mail will open a window prompting you to enter the header you 
want to add. Type it in exactly as it should appear in the message, including the keyword and the colon 
character following it. You may not add any header that Pegasus Mail itself will add to the message, so 
you cannot add fields like From, To, Subject, CC, MIME-Version, Content-type and so on. The principal 
use of this feature is for list managers who need to add approval headers when submitting messages, 
and for internal use by Pegasus Mail itself, which uses it to attach special threading headers to your 
replies.



Importing text from other sources

You can add text from other applications to your message in three ways.

Cut and paste. You can use the standard cut, copy and paste commands on the Edit menu to move text 
around within Windows.

The right click menu    Right-clicking in the editor window opens a context menu containing a number of 
specialized paste options.

Import menu option. The Import file into message option on the Message menu allows you to read a text 
file into your message. A dialog will appear which allows you to navigate using standard file and directory 
lists, or type the name of the file in directly. Note: the file must be a text file for this option to work. Word 
processor files are usually not text files.



Distribution Lists

Pegasus Mail can accept up to 32000 characters in any address line. If you need to send a message to 
more addresses than will fit in this space, or you have lists of users to whom you mail regularly, you can 
create distribution lists.

A distribution list can be any text file containing addresses, one per line, but it's generally easier to use 
Pegasus Mail's distribution list manager, which you can access by pressing the button on the button 
panel, by pressing <F6>, or by selecting Distribution lists from the Addresses menu.

Creating a distribution list
Distribution list options
Using distribution lists



Creating a distribution list

To create a distribution list, press <F6> and click on the New button in the selector window. A dialog will 
open prompting you for a long name for the list and an optional file name. Complete the dialog then click 
OK. You will be returned to the selector window.

Now, highlight the list you created and press the Edit button. A window will open in which you create and 
control your distribution list. The title you gave your list when you created it appears in the Title field.

To add addresses to your distribution list click in the address list area and either type in the addresses or 
select them from address books or the local user list. Make sure that you have only one address per line 
in the list. Any valid address can be entered in the list, including addressbook aliases.

The Pegasus Mail distribution list manager can handle many thousands of addresses.

Distribution list options



Distribution list options

There are several ways you can control and customize the operation of your distribution lists.

To field (suppressing the list of recipients): Entering an address in this field will force Pegasus Mail to 
suppress the listing of all the recipients' addresseses in the To: field when you use the list. Instead of 
showing every member of the list, the To: field will contain only what you enter here. Because of the way 
Internet mail works, you cannot simply enter any piece of text in this field -- you must enter something 
which can be legally processed as if it were an address. We recommend that you use the following format
to create the contents of this field:

"(descriptive text)" <(your own address)>

Replace (descriptive text) with a meaningful name for the mailing list, and put your own address where it 
says (your own address). Recipients will almost always see the descriptive text instead of your address 
so it will not seem as strange as it sounds. The quote characters around (descriptive text) and the angle 
bracket characters around (your own address) are vitally important and must be included exactly as 
shown. It is not possible to suppress the recipient list for MHS mail and this field will be ignored for MHS 
messages.

Reply to: If you want to direct replies to list mailings to a particular address, enter it here. A reply-to field 
you set in the list will override any in the message.

Confirm reading, confirm delivery, urgent, signature: These controls duplicate the same features in the 
message editor. If you set them for the distribution list they will override the values you use when you 
compose the message.



Using a distribution list

Tell Pegasus Mail to use a distribution list in one of three ways:

1: While composing your message, open the distribution list selector by clicking the button in the button 
panel, by pressing <F6> or by choosing Distribution lists from the Address menu, and double-click on the 
address you want to use. Pegasus Mail will paste the appropriate file name into the address field of your 
message.

2:    Leave the distribution list manager window open and drag the lists you want to the address field in 
your message.

3: Type an '@' followed immediately by the DOS path to the file containing the distribution list. You will not
normally use this method, but it may be convenient if you have a mailing list in a suitable format which 
was not created in Pegasus Mail.



Glossaries (abbreviations)

Pegasus Mail allows you to store abbreviations for commonly-used text strings which you can expand at 
any time with a single keypress. To create a glossary entry, choose Edit/create from the Glossary 
submenu of the Edit menu. This provides an easy way of creating "canned" text that can be entered 
quickly into replies or other messages - very useful for helpdesks, technical support, and order handling 
personnel, among others!

In the Glossary dialog, a list of abbreviations appears on the left-hand side of the screen, while the full 
text of the currently-selected abbreviation appears in the edit window to the right. To change a glossary 
entry, simply select it in the list and edit it in the editing window. Pegasus Mail. Adding a glossary entry is 
equally simple - just click the Add button, provide an abbreviation, and edit as before. You can copy and 
paste into your glossary texts using the buttons in the dialog.

To expand a glossary entry in your message, simply type the abbreviation, make sure the cursor is at its 
end, then press <Ctrl+/> or <Ctrl+E>. You can expand glossary entries in the message editor, address 
fields and in the subject line, and in some other places within the program as well.



Browsing mail

The folder browser allows you to manage the mail you receive. It provides functions for moving, copying, 
deleting, forwarding, printing and replying to messages. Special options and functions for sorting folders 
are located on the Folder menu which appears at the end of the menu bar when a folder window is 
frontmost.

Message status indicators
The Folder Manager
The folder selector
Copying and moving messages
Deleting messages
Forwarding messages
Resending copy-to-self messages
Printing messages
Annotating your messages
The Folder menu



Annotations

You can add your own comments to any message you receive in a number of ways:

* By choosing Add/edit annotation from the Folder menu while browsing a folder, or from the Reader 
menu while you are reading a message.

* By pressing <Ctrl+9>

* By double-clicking on the message line in the folder browser in the location where the "annotations" 
status indicator appears or would appear. Messages with annotations appear marked with a green dot 
status indicator in the folder browser.

Annotations are stored in a separate file from the message and are automatically deleted when you 
delete the message. You may put whatever you wish in an annotation - Pegasus Mail does not impose or 
suggest any particular format. When you move a message to another folder, its annotation will move with 
it.

Note: If you make a copy of a message with annotations then delete either the original or the copy, the 
annotations will be deleted as well.



Message status indicators

Pegasus Mail reserves a small space at the left-hand side of the folder window to place status indicators 
that give you visual information about each message.

The attachment indicator will be a dot if the message has conventional attachments, and will be a solid 
square (as shown in the diagram) if the message is a MIME multipart message.

Triangle indicator  If a message has a solid black triangle next to it in the place where the attachment 
indicator normally appears, this indicates that it is in a special format called Multipart/Alternative. This 
format contains more than one version of the same mail message - usually varying in format. As an 
example, someone might send you a message that contains both a fully-formatted rich text version (with 
pictures, font changes, bold, italic and so on), and another version of the same message formatted as 
plain text. The idea of Multipart/Alternative messages is to allow the receiving mail program to display the 
format it is most capable of handling.

Note: for "triangle" messages, you can control which version Pegasus Mail presents to you (plain or 
formatted text) using the options on the Reader Settings preferences page.



A mail folder is simply a place where mail messages are stored. The new mail folder is a special folder 
which changes as you receive, read and delete mail, but you can also create other folders for long term 
storage of messages you wish to keep. Folders can have long descriptive names to aid in filing.



The folder selector

When you choose the Move or Copy options in the folder window, the folder selector will open. In this 
dialog you can create new folders, rename existing ones and delete folders you no longer require.You can
also create Trays, which are a special kind of folder which can contain folders and other trays.Trays allow 
you to organize your mail into a hierarchy, or to group related topics and folders in their own areas.

The folder selector shows a list of all the folders and trays available to you. System-wide folders, which 
are available to all users, appear in their own mailbox within the list: you can read from them, but you 
might not be able to alter their contents. You can select items from the list using the mouse, or by typing 
the first few characters of their names. To open a tray, highlight it and press <Enter>, or click on the Open 
button, and its contents will appear in the list indented one level. You can also and open trays using the 
left and right arrow keys.

At the right-hand edge of the entry for each folder is a pair of numbers, representing the number of 
messages in the folder and the number of unread messages in the folder respectively. Unread mail can 
appear in folders as a result of new mail filtering rules, or when you copy a message you have not read 
from the new mail folders. Folders containing unread mail appear in the list in green.

Special options    you can access special options for many of the folders in the list by right-clicking them. 
You can dismiss the menu without selecting a choice by pressing <Esc> or clicking the mouse outside the
menu.

The right-click options for Pegasus Mail v2.x-format folders are:

Reindex folder    From time to time, a folder's index file may become corrupt, which can result in errors 
when you attempt to open it. Highlight the folder and select this command to force Pegasus Mail to rebuild
the index file. Reindexing will work reliably if the actual messages in the folder are intact, but may result in
the loss of some status information (such as whether or not you have replied to a message, or forwarded 
it). A side-effect of rebuilding a folder is that some deleted messages may reappear the next time the 
folder is opened.

Compress folder    When you delete a message from a folder, Pegasus Mail does not immediately reclaim 
the space it occupies; instead, it waits until you have deleted around 20000 characters from the folder 
then recovers all the space in a single pass. This deferred compression improves the performance of the 
program at the cost of some disk space. Select this option to force Pegasus Mail to compress a folder. 
Compression is always a safe option and does not result in the loss of information.

Check consistency    This option attempts to verify that a folder is intact. On rare occasions folder index 
files can become damaged, which can cause problems in long-term use. Pegasus Mail automatically 
invokes this option before recovering deleted message space from folders ("compressing"), but if you 
want to ensure that a folder is intact, you can perform a consistency check manually at any time.



Copying and moving messages

If you want to make a copy of message in a mail folder, or to move the message from the current folder to
another, click on the Copy button or the Move button. The folder selector will open listing the available 
folders. You can create a new folder if you wish, or else double-click on the destination folder.

Pegasus Mail also provides a feature called Quick Folders which can help you file mail to your most 
commonly-used folders more quickly.

If the message you are copying has not been read, the unread messages counter which shows for the 
folder in the folder selector will increase by one.



Deleting messages

To delete messages you no longer need, highlight them in the folder and click the Delete button, or press 
the <Del> key.

Deleted message tracking: Pegasus Mail has a preferences option which can allow you to recover mail 
messages you delete accidentally. If you have checked Preserve deleted messages until exit in your 
preferences Pegasus Mail will not delete messages from the folder - instead it will move them to a special
folder called Deleted messages which it will create as necessary. When you exit from Pegasus Mail, the 
deleted messages folder is removed and the messages are deleted once and for all. Any time up to the 
point when you exit from Pegasus Mail you may open the deleted messages folder and move or copy 
messages you wish to recover to other folders.

Note: you should not enable deleted message tracking if you are running in an environment with low or 
restricted disk space.



Forwarding messages

If you wish to refer a message to another person or people, then highlight it in the folder list and click the 
Forward button, or press <F>. This will open a dialog asking how you want to forward the message. If 
only one message is selected in the folder, two of the options in the dialog will be greyed-out and 
unavailable. The remaining two choices allow you either to forward the current message normally, or to 
start a new message with the selected message automatically added as an attachment. If two or more 
messages are selected in the folder, the options for forwarding multiple messages will be available

If you select the standard forwarding option, a small dialog will open prompting you for the address to 
which the message should be forwarded. If you click Edit before forwarding, then a message editor will 
open allowing you to change the contents of the message before it is sent, otherwise it will be forwarded 
at once.

When forwarding a mail message, Pegasus Mail changes the subject field so that it starts with the phrase 
(Fwd), to indicate that it has been forwarded.

All standard address selection options including <Shift+F3> (to expand an address book key field into a 
full address) are available in this screen.



Forwarding messages

Forwarding a message is the process of taking a message in one of your folders and sending it on to 
another person or address. Pegasus Mail gives you considerable flexibility in how forwarding should 
occur. When you choose the Forward option in a folder or message reader window, the Forwarding 
Centre will open up, listing the messages to be forwarded, and providing options for processing them.

* Hint    You can forward multiple messages by selecting them as a group within the folder before clicking 
the Forward button.

Forwarding a message involves three steps:

1: Enter the address to which the messages are to be forwarded. You can click the addressbook icon at 
the right of the address field to open the Addressing Centre, where you can select addresses from your 
addressbooks, distribution lists, or from a list of recently-used addresses. Alternatively, if you know the 
address, you can simply type it into the field.

2: Select the way the message should be forwarded.    Pegasus Mail allows you to forward messages in 
four different ways:

* Forwarding with editing    This method allows you to make changes to the 
contents of the message before it is forwarded. The forwarded message will 
appear to be sent by you, rather than by the original sender - this is because 
once you have made changes, it's no longer really the original sender's 
message any more. When you select this option, various other options are 
made available in the forwarding dialog: Wrap long lines in editor allows you to
reformat the text of the original message as you edit it; Forward any 
attachments the message has as well adds any attachments the original 
message had as attachments to the new message you are creating. You can 
remove selected attachments in the message editor later if you only want to 
forward some of them. Finally, the three radio buttons allow you to control how 
much of the original message's headers should be included in the body of the 
new message that gets created - you can choose between all headers (useful 
for reporting abuse or spam), tidy headers (only the most important headers 
are included) or no headers.

* Forwarding without editing    This method, which is also called Bouncing or 
Redirecting in other mail programs, sends the message as-is, as soon as you 
click the Forward button. When you forward using this method, Pegasus Mail 
adds three extra headers to the message to show that you have forwarded it, 
but does not otherwise alter the message in any way. The forwarded message 
will appear in the recipient's new mail folder as being sent by the original 
sender, because it is still wholly his or her content.

* Start a new message with the original attached    This method starts a 
completely new mail message with the messages you are forwarding as 
attachments. This allows you to compose your own text from scratch, referring 
to the attached messages as necessary. The attached messages are complete
and unaltered.

* Create a MIME digest    This special option is only really meaningful if you are 
forwarding multiple messages; it takes the messages and packages them in a 
special format called a MIME digest: when the recipient opens the message in 
a competent mail program, the digest should be presented just like a folder, 
allowing the recipient to browse the messages easily. This option is very useful
for maintaining discussion lists and the like. You can add your own subject field



for the digest (which is what the recipient will see in their folder list when the 
message appears in their new mail folder), but cannot otherwise alter it in any 
way.

3: Click the Forward button.    If you have chosen Edit or make changes before forwarding, or Start a new 
message with the messages attached, a new message editor window will open, set up as you have 
specified; otherwise, the message will be forwarded without further ado.

Selecting an identity for your forwarded message    If you have defined multiple identities in Pegasus Mail,
you can specify which identity the program should use for forwarding the message using the Use this 
identity... control. The identity can control the formatting of the forwarded message, the options used to 
create it and many other settings.

Removing messages you don't want to forward    The list at the bottom of the forwarding window shows 
the messages Pegasus Mail will forward when you click the Forward button. If you find you have added a 
message you don't want to forward, simply select it in the list and click the Remove button. This does not 
delete the message or change it in any way - it simply removes it from the list.

** TIP ** Forwarding messages from more than one folder    If you want to forward messages that reside 
in different folders, simply start by forwarding one, then open the other folders, select the messages there,
then drag them and drop them onto the Forwarding window; they will be added to the list and will appear 
there as soon as you drop them. You can add messages from as many different folders as you wish in 
this way, but make sure you leave the folders open until you have completed the forwarding operation.



Resending copy-to-self messages

If the currently-selected message is a copy to self you have made using the Copy self option in the 
message editor, then you can resend it by right-clicking it and selecting Resend this message... from the 
popup menu.

Pegasus Mail will create a new message editor window filled out as closely as possible to the way it was 
filled out when the message was originally sent. If the copy-to-self was created using Pegasus Mail v3.10 
or later, then attachments and identity settings will be restored as well as basic addressing options. For 
copies-to-self created with earlier versions of Pegasus Mail, attachments and identity settings will not be 
restored.

The resent message is treated as a completely new message by Pegasus Mail: so, if the Copy self 
control in the message editor is checked when you click the Send button, a new copy-to-self will be made 
-- the original copy-to-self is not altered in any way.



Printing messages

You can print messages from the message reader or from the folder list by pressing <Ctrl+P>, or by 
selecting Print from the file menu. The message reader also has a Print button.

When you ask to print a message, the print setup dialog will appear showing the last settings you used. 
Pegasus Mail remembers your print settings from session to session. The currently selected printer (or 
the default Windows printer if this is the first time you have printed your message) appears in the list 
control. You can select other installed printers by clicking on the down arrow at the right-hand end of the 
control.

Print which message headers?    Pegasus Mail lets you choose how much or little of the message's 
headers it will print. Choosing Significant, full will print the headers you normally see in the message 
reader in their entirety, while Significant, first line prints only the first lines of only those headers. Clicking 
All will print the message exactly as it was received, with all headers intact, and clicking None will omit the
header information from the printout altogether.

Reformat long lines:    If the message contains unnaturally long lines (some mailers send messages 
formatted this way), check this control to tell Pegasus Mail that it should wrap those lines during printing. 
Because the data in the message is plain text, the result of reformatting during printing may not be 
optimum - in particular, tables laid out using spaces or tabs may become garbled; as a result, you should 
use this option only when you actually need to do so, rather than as a matter of course.

Omit printed footer:  By default, Pegasus Mail adds a footnote to each printed page indicating the date 
and time, your username and the page number. This is particularly useful when you are printing to a 
network printer, but if you would prefer not to have this footer line, check this control.

The Margin fields allow you to specify a printing margin for the Top/Bottom and Left/Right of the page. 
The default is 20mm (one inch = 25.4mm) all round. Pegasus Mail will not permit you to set margins 
narrower than 10mm. 

The Font button allows you to select a font from those supported by your printer.

The Setup button brings up the standard Windows printer setup dialog, which will vary from printer to 
printer.



The folder menu

When a folder window is frontmost, a Folder menu appears at the right of the menu bar. The folder menu 
contains options which are less frequently-used or are more specialised than the button functions in the 
window.

Searching for text in the folder
Sorting the contents of the folder, and time zone compensation
Extracting messages to files
Special folder options
Quick folder options

Set colour allows you to display messages in different colours, which can be a useful way of reminding 
yourself about their contents. You can sort your message by colour as well.

The last entry on the menu allows you to select the font the folder window will use to display the list. This 
setting is global to all folders and is remembered from session to session. You cannot choose very large 
fonts for the folder display without truncating some of the information it shows. A 14-unit font is normally a 
good size.



Searching for text in a folder

The Find text and Find again options on the Edit menu allow you to search the contents of the current 
folder for a piece of text. Type the text you want to look for in the editing field. The text can contain * and ?
wildcard characters. Searching is always case-insensitive (that is, Pegasus Mail and pegasus mail are 
regarded as the same string).

Search message headers only: If you want Pegasus Mail to restrict its search to the special headers at 
the start of the mesage, check this box. Searching headers only is considerably faster than searching the 
whole message, and is appropriate if you are interested in the subject of a message or who it is from.

Mark all matching messages: Usually Pegasus Mail opens a message reader and displays the first 
message it finds which matches your search criteria. If you want to select all messages in the folder which
match your criteria instead of reading them, click this box. This option is handy if you want to tag all 
messages on the same subject for moving or copying.

Exact matches:  Normally, Pegasus Mail searches for messages containing any of the words you type in, 
then ranks them in order of decreasing relevance, based on the closeness of the match. If you would 
prefer to find messsages that only contain the exact text you have typed, check this control. Note that 
searches are always case-insensitive, even if Exact matches is checked.

Hint - searching for a specific header: If you only want to search for a particular header containing your 
search string, make sure that search message headers only is checked, then enter the search text like 
this example, where we only want messages where the From: field contains the word Otago:

From:*otago*



A wildcard character is one which matches any character or group of characters in the text searched. In 
Pegasus Mail the ? character matches any single character (so "?illy" will match both "Willy" and "Billy"), 
while the * character matches any number of characters (so "j*on" would match "johnson", "johnston" or 
"john's son").



Extracting messages to files

Select this command if you would like to save the text of a message or messages to files on your hard 
disk or file server. What happens when you select this option depends on whether or not you have 
selected more than one message in the folder. If you have only selected one message, the Pegasus Mail 
will simply ask you for a filename and will save the contents of the message to that file. If you have more 
than one message marked, then Pegasus Mail will open a dialog asking you to choose from three 
options:

Extract all messages to a single file    If you choose this option, then Pegasus Mail will ask your for a 
filename and will save the text of all the marked messages in the same file, one after the other in the 
order they appear in the folder.

Extract messages to separate files, asking for names    Choose this option and Pegasus Mail will ask you 
for a filename for each marked message. You will usually use this option when it is important that you 
control the names of the files containing the message text.

Extract to separate files, creating unique names for each    If you choose this option, then Pegasus Mail 
will ask you to enter a single filename. It will then take the filename you supply and create unique 
filenames based on it, saving the text of each message in a separate file. Pegasus Mail creates the 
unique names by removing any file extension you supply and adding a numeric extension starting at 000, 
adding 1 to the extension for each file.You can extract a maximum of 999 messages to files using this 
command.



Sorting folders

The second group of entries on the Folder menu allow you to specify how the folder should be sorted. 
The default for folders is Sort by date. A check mark appears next to the entry which indicates how the 
folder is currently sorted.Most sorting options will perform a secondary sort when the primary sort fields 
are equal.

Sort unread before read splits the folder into two groups of messages - those which have been read and 
those which have not. Each group is sorted according to the current sort order, but all your unread mail 
appears above read mail in the list.

Sort by colour allows you to sort your mail on arbitrary criteria; use the Set colour option on the menu to 
display your messages in any of 15 colours, the use "sort by colour" to group them together, sub-sorted 
by date. You can also set a message's colour using the Highlight action in your new mail filtering rules.

Sort by thread    In this mode, Pegasus Mail sorts by subject, ignoring strings like "Re:", then sub-sorts by 
reverse date. In most cases, this will sort the folder so that related messages appear grouped together in 
chronological order. You can also turn on thread sorting by holding down the <Ctrl> key as you click on 
the Subject header in the folder.

Apply timezone compensation    Normally, Pegasus Mail will attempt to work out the time difference 
between messages in your folder and will allow for that difference when sorting by date. This allows 
messages from (for example) New Zealand and England to sort correctly in chronological order, even 
though there is a 12 hour time difference between the two places. Whether or not this correction can be 
applied is dependent on the messages containing legal time zone specifications - unfortunately, many do 
not. If you would prefer that Pegasus Mail display and sort by the raw date of the message, make sure 
that this option is not checked.

The section header panels in the folder window are buttons which can also be clicked to select a sort 
order. To reverse the direction of a sort, click its column heading again.

Pegasus Mail remembers the sorting option you select from session to session.



Special folder options

The Special entry on the Folder menu has a submenu containing specialised or infrequently-used 
functions.

UUdecode message: Sometimes Pegasus Mail will be unable to recognize that a message is actually an 
attachment sent using a special encoding method called uuencoding. This usually happens if the 
attachment was sent across the Internet by someone using a mail system other than Pegasus Mail. If you
receive a message like this, you can force Pegasus Mail to decode it by highlighting it in the list and 
selecting this option. Pegasus Mail will prompt you for a filename and will attempt to decode the message 
for you.

Un-BinHex message: BinHex is another special transmission format like uuencoding (see above), 
commonly used on Apple Macintoshes. If you receive a BinHexed message which Pegasus Mail does not
recognize as BinHexed, you can force it to unpack it using this option.

Note: BinHexed files from Macintosh users may be useless to you on a PC. The Macintosh has a filing 
system quite unlike that of any other computer and its files are often only usable on other Macintoshes. 
Some programs such as WordPerfect and MS-Excel create data files which are compatible on both 
platforms, but not all do. If you find you cannot use the attachment when you extract it, this may well be 
the reason.

Mark messages as unread:    If for some reason you wish to change the status of a message from having 
been read to not having been read, either choose this option or press <Ctrl+U>; all messages selected in 
the current folder will be marked as unread. Note that marking a message as unread in the new mail 
folder means that any new mail filtering rules you have defined will be applied to it again the next time you
open the new mail folder, and that if the sender has requested confirmation of reading, he or she will 
receive another confirmation the next time you read the message.

Delete all expired messages: Pegasus Mail allows you to set an expiry, or obsolescence date for a 
message - a date after which the message is meaningless; messages which are past their expiration 
dates appear grey in the folder window. This command instructs Pegasus Mail to delete all expired 
messages from the folder, and only works in the New Mail folder.

Add sender to distribution list  When you select this command, Pegasus Mail will open the distribution list 
selector and prompt you to select a list. The addresses of the sender of every marked message in the 
folder will be added to whichever distribution list you select. Pegasus Mail will not duplicate an address 
which already appears in the list.

Remove sender from distribution list    This command removes the sender of every marked message in 
the folder list from whichever distribution list you select.



Address books

Pegasus Mail's address books allow you to store electronic mail addresses and other information about 
people with whom you correspond. You can create as many address books as you wish, and the system 
administrator can also create address books which everyone can see (these appear in blue in the 
address book selector window).

The address book selector
Creating addressbook entries
Using addressbook entries in your mail
Searching address books
The address book menu
Importing and exporting addressbooks

Hint: to add a user's address to an address book, drag a message from that user out of the folder and 
drop it on an open or minimized address book.



The address book selector

When you click on the address books button, or choose address books from the Addresses menu, the 
address book selector window will open. In this dialog you can create new address books, rename 
existing ones and delete address books you no longer require.

The selector shows a list of all the address books available to you. Address books in the list which appear
in blue are system-wide address books available to all users: you can read from them, but you might not 
be able to alter their contents.

To open an address book, either double-click its entry, or highlight it in the list and click on the Open 
button.

Naming address books: when you create an address book in the selector, you can give it any name you 
wish up to a maximum of 50 characters. There are no restrictions on the names you can use in the 
address book long name. If you choose to specify the short name (or filename) for the address book, you 
must enter a legal DOS filename no longer than 8 characters with no extension. Usually, you will leave 
the short name field blank and allow Pegasus Mail to choose a filename for you.



Creating address book entries

When you have opened an address book, a window will open listing the contents of the book in an 
abbreviated form. If you click on an entry in the list, all the details from that entry will appear in the 
information pane at the bottom of the address book window.

To add an entry to your address book press the Add button. A simple data-entry dialog will open 
presenting you with a blank entry template. Fill in the fields and when you are satisfied with what you 
have entered, click the OK button. The fields which you must complete in this screen are the following:

*** Tip *** if you have a mail message from a person you want to add to your address book, you can do so
simply by opening the address book then dragging the message from the folder and dropping it onto the 
address book window.

Name (alias): The person's name. You can use what you enter in this field as an address in any address 
field - it is generally easier to remember that someone is called Peter Smith than to remember his 
address. This use of the name as an address is called aliasing. This field may not contain a comma.

Key: A short search key for the entry. Pegasus Mail allows you to sort the address book either by name or
by key, so the key field gives you an alternative sorting option.

E-mail address: The person's electronic mail address. Any single valid address can be entered in this 
field, including distribution lists and NetWare groups. You may not use an alias in this field.

All other fields in the address book are yours to use in any way you wish.



Using address book entries in your mail

You can use your address books in your mail in three distinct ways

1: You can double-click on an entry in your address book to start a new mail message using that address 
and any others selected in the book.

2: You can click on the Paste button on the address book window. Any highlighted addresses will be 
copied into the last active field in the message you are editing.

3: You can drag the address entries you want to use to any edit control and drop them there. Note that the
edit control need not be in Pegasus Mail - it is possible to drag addresses from Pegasus Mail to edit 
controls in other applications, such as the Windows Notepad program.

Depending on the setting in the address book menu, Pegasus Mail will paste either the alias (the default) 
or the actual e-mail address into the destination field: you may use either approach depending on your 
preference.

Limitations:    Most address fields in Pegasus Mail can only accept at most 256 characters. If you have 
selected addresses with more characters than will fit in the field, Pegasus Mail will issue a warning. When
this happens, you might have to consider creating a distribution list.



Aliasing happens when you use the name field from an address book instead of the e-mail address. 
Pegasus Mail will accept either as an address: if you use the name, then Pegasus Mail will look up the 
real e-mail address at send time. You may prefer to use aliases over e-mail addresses because it is 
generally easier to remember someone's name than their address.



Searching address books

The quickest way to search your address book is to type the first few characters of the name or key you 
want to find. Depending on the current sort order of the address book Pegasus Mail will move the 
highlight to the first entry in the book with a key or name which matches what you type. This process is 
called speed searching.

For more comprehensive searching, the Edit menu contains a Find text command that you can use to 
locate or select entries in your address books. When you choose Find, a small dialog will open asking 
what you want to search for. Enter the string you want to find. If you want Pegasus Mail to search the 
whole address book marking all entries which match your criteria, click the select all matching entries 
button.

You can repeat the last search you made by selecting Find again from the Edit menu. The search text is 
global, so you can search in one book, then open another and choose Search again to continue your 
search in the new book.



The Addressbook menu

When an address book is the frontmost window in Pegasus Mail, the Addressbook menu option becomes 
available at the right of the menu bar. This menu contains actions and commands specific to address 
books.

Searching: To to search for text in the address book, use the Find text and Find again options on the Edit 
menu.

The first options in the Addressbook menu control the sort order for the addressbook. The sort order is 
remembered for each address book separately between sessions. The sort order which is currently active
shows a checkmark in the menu.

Import and export    these options allow you to import data into your addressbook from other programs 
and to export your addressbook. Click here for more information.

The final three options on the menu control the way Pegasus Mail will use addresses from the address 
book. Like the sort order, these settings are local to each addressbook and are remembered between 
sessions. The first two options in the group allow you to choose whether Pegasus Mail should paste the 
alias or the actual e-mail address into messages when you drag and drop or press the Paste button. The 
default is to paste the alias. 

The last option on the menu allows you to tell Pegasus Mail whether or not to resolve aliases in this 
address book. Alias resolution is the process of taking a name and finding the e-mail address which 
matches it from the address book at send time. The process of alias resolution can take quite a while if 
you have many or large address books, so you may want to disable it for some or all of your books. By 
default Pegasus Mail resolves aliases in all address books.

Warning: if you turn off alias resolution for an address book then you can no longer use the Name field 
from entries in that address book as addresses.



Importing and Exporting Addressbook Entries

If you have lists of addresses in other programs, you may be able to import them into your Pegasus Mail 
addressbook. Similarly, Pegasus Mail allows you to export all or selected addresses from an addressbook
to a file that can subsequently be imported into other applications.

Two import/export formats are available: the first, tagged format, is a simple textual format where each 
line contains one field from the entry, starting with a tag, or a name that identifies the field. Only Pegasus 
Mail can usually import this format, but it is easy to read and to incorporate into word processors. The 
second format is tab-delimited text: in this format, each record is held in a single line in the file, and fields 
within the record are separated from each other using <Tab> characters. Tab-delimited format can be 
easily imported into many databases and spreadsheet programs.

When exporting to tagged format, each field is named, so the order of the fields is not important: to see 
the format used during tagged export and import, simply select a couple of records in an addressbook 
and choose Export to tagged text file from the Addressbook menu. Once the export is complete, examine 
the output file.

When exporting to tab-delimited format, the addressbook fields are exported in the following order:

Name/Alias
E-mail address
Key
Department
Phone
Fax
Delivery address
Postal address
Details
Image filename

In tab-delimited format, you must specify a Name/alias field and an E-mail address field - all other fields 
are optional and can be omitted. Fields can also be empty if you wish, and will be safely truncated to 
acceptable lengths if they are too long. When you fail to specify a Key field, Pegasus Mail will attempt to 
create one for you - for this reason, Name/alias fields are best expressed as "Firstname Lastname".



The button panel

See also: Preferences overview

Pegasus Mail's button panel is a set of tools which provides access to the most commonly-used parts of 
the program at the click of a button. Depending on the setting you specify in your Toolbar Preferences 
(see under the Tools | Options menu), the button panel can appear as either a fixed toolbar beneath the 
main menu (the default) or as a small floating window in either horizontal or vertical format.

Pegasus Mail includes a number of pre-configured toolbar formats, each with options suitable for different
environments. You can select any of these styles using the drop-down control in the preferences dialog. It 
is also possible to customize the toolbar layout using a simple text file called TOOLBAR.PM in your home 
mail directory. For more information on customizing your toolbar, please see the file BPANEL.TXT in the 
RESOURCE subdirectory of the directory where you installed Pegasus Mail. Different identities can have 
different toolbars selected.

Pegasus Mail remembers the location and state (open or closed) of the button panel between sessions. 
You can also choose between having the button panel as a toolbar, or as a floating window in vertical or 
horizontal format using the option in your Preferences. You may see a listbox showing the word 
<Default>: this allows you to select a different identity if you have defined any.

The buttons on the toolbar have the following functions:

Compose a new message
Read new mail
Open/manage mail folders
Open/manage address books
Open/manage distribution lists
Open the local user list
New mail filtering rules
Use the noticeboard system
Cut selection to the clipboard
Copy selection to clipboard
Paste the contents of the clipboard
Save or write to disk
Retrieve or import from disk
Print
Select font

The following three buttons will only appear if the built-in TCP/IP mail subsystem (using WINSOCK.DLL) 
is available for use:

Send all outgoing mail waiting in the mail queue
Check your POP3 host for new mail
Check for new mail and send queued mail in one action



Preferences overview

Pegasus Mail allows you to customize many aspects of the way it works to suit your own tastes. These 
settings are called your Preferences (or Options in some other programs), and are stored in a file called 
PMAIL.INI in your new mail directory. You can edit your preference settings while Pegasus Mail is running
by selecting Options from the Tools menu, or by pressing <Alt+F10>: this will open a dialog with a list of 
preference categories on the left, and the settings for the selected category on the right.

The following settings pages are available in the dialog:

General settings
Basic settings
Advanced settings
Mailbox location
Extended features (only available in NetWare mode)

Outgoing mail
Messages and replies
Message formatting
Signatures
Copies to self ('outbox')
Encryption
Sending mail

Incoming mail
Folders and previews
Message reader
Content viewers
Hyperlinks

User interface
Toolbars
Reporting/Logging
Automatic formatting



Basic settings

See also: Preferences overview

The following items can be changed in the Basic Settings preferences page:

Personal name    Pegasus Mail attaches whatever you enter here to your address when you send 
messages, making it easier for the recipient to identify who you are. You should make this entry simple 
and clear. Your personal name should consist only of letters and digits.

Automatically open the new mail folder at startup    If you check this box Pegasus Mail will automatically 
select your new mail folder for you when you run the program, even if it contains no new mail.

Preserve deleted messages until Pegasus Mail closes    If you check this box, Pegasus Mail will save any 
messages you delete in a special folder called Deleted Messages which will be cleared when you exit; 
this option can allow you to save messages that you delete by accident.

Ask for confirmation before deleting objects    If you prefer that Pegasus Mail does not ask you to confirm 
that you really want to delete items such as messages or addressbook entries, uncheck this control. If you
uncheck this control, you increase the risk of accidentally deleting messages you meant to keep, so we 
recommend you consider turning the Preserve deleted messages until Pegasus Mail closes option on.

Allow read messages to stay in the new mail folder  Usually when you close the new mail folder, Pegasus 
Mail moves all the messages you have read but left there to the folder you have specified as your Default 
Folder (see below). If you would prefer new mail to stay in your new mail folder until you explicitly move or
delete it, check this control.

Ask for NetWare password at startup    Check this and Pegasus Mail will prompt you for your NetWare 
password when you run it. It will not run unless you enter the password correctly. This option adds 
security to your mail if you are away from your desk a lot. This control has no effect in non-NetWare 
environments.

Save the Pegasus Mail desktop state between sessions  If this is checked, Pegasus Mail will remember 
the folders, address books, distribution lists and other windows you have open at the end of a session, 
and will automatically reopen them at the start of the next session. Checking this control will also cause 
the Folder Manager window to remember which trays are open between sessions, and to remember any 
mailboxes mounted using the Add mailbox to list command on the Folders menu.

Use system-defined colours in Pegasus Mail's controls    If you check this control, Pegasus Mail will use 
the colours you have defined using the Windows Display control panel for the window background colour, 
list text, selected text and so on. Pegasus Mail uses colour quite extensively, however, and if you find that 
your Windows colour settings clash with the colouration it uses, unchecking this control will tell it to use a 
neutral colour set instead.

Name for default mail folder    This is the name of the folder into which Pegasus Mail should move any 
mail you have read but not otherwise moved or deleted when you close your new mail folder. If the folder 
you have named does not exist, Pegasus Mail will create it automatically .You can simply type in the 
name of a folder, or if you want to use an existing folder for this purpose, you can click the Select button. 
The auto-move behaviour of this folder can be controlled using the Allow read messages to stay in the 
new mail folder option (see above).



Advanced settings

See also: Preferences overview

This page lets you alter some of the more technical aspects of the way Pegasus Mail operates.

Refresh the new mail folder view every x secs  This option controls how frequently Pegasus Mail should 
scan your new mail folder for new mail while the newmail window is in the foreground. The default is to 
update the list every three seconds, but this can generate a lot of Network traffic and can degrade your 
machine's performance, especially if you are connected to your server across a slow link. Setting this field
to -1 will disable new mail polling altogether - the new mail window will only be updated when you 
explicitly choose "New mail" from the "File" menu, or click the "New mail" Icon in the toolbar. If your new 
mail folder contains more than 500 messages, Pegasus Mail will stop doing automatic updates of the 
folder for performance reasons, and will check for new mail in your new mail folder less frequently.

Number of lines to scan for enclosures    When it opens your new mail folder, Pegasus Mail does a short 
scan into each message to see if it can find any obvious signs of attachments: the number of lines 
Pegasus Mail should scan into the message is controlled by this field. Note that selecting the Attachments
view in the message reader always does a full scan of the message looking for attachments and will find 
any there may be -- this option really only affects the likelihood of the attachment marker being displayed 
in the folder window. Setting this field to a larger value will slow down the process of opening the new mail
folder. Note that this setting only applies to old-fashioned non-MIME messages. MIME is a modern e-mail 
format, and when it is used (as it almost always is now) Pegasus Mail can always recognize the presence
of attachments in the message.

Organization string  This field is only used if you are not connected to a NetWare server; you can enter a 
name in this field and Pegasus Mail will place it in the Organization header of all mail sent locally and via 
gateways on your system.

SMTP time zone  This setting is only applied to mail sent using Pegasus Mail's built-in SMTP transport. 
You should enter your time zone in here expressed as a plus or minus offset from Greenwich Mean Time, 
and Pegasus Mail will then use it in the Date field of messages you send. Example: New Zealand is 11 
hours ahead of GMT, so the proper value for this field would be +1100. Pegasus Mail follows the Internet 
recommendations for enforcing timezone specifications as a four digit signed offset and will not allow you 
to enter so-called "vernacular" timezone identifiers like "EST" or "GMT". This setting is ignored if you are 
sending mail via Pegasus Mail's companion SMTP transport product, Mercury - the Mercury timezone 
setting is used instead. If you check the Auto box next to the SMTP time zone field, then Pegasus Mail 
will automatically work out the time zone field by asking your operating system.This means that daylight 
savings adjustments will happen automatically provided your system is properly configured, so if you are 
using either of these operating systems or a later version, we recommend you check this control. When 
the Auto control is checked, the contents of the SMTP time zone field are ignored. There is almost never 
a reason to have Auto unchecked.

Default MIME character set    Controls the character set Pegasus Mail should use by default when writing 
MIME messages that contain international characters. Valid values are ISO8859-x, where “x” is a digit 
between 1 and 9. Pegasus Mail only has full formal support for ISO-8859-1, the other character sets 
being supported to varying levels. If you have added a comprehensive MIME character mapping table 
using an external resource file, you can also enter the name of that character set here. Entering an invalid
character set name may have undefined consequences for people reading your mail – we strongly 
suggest that you only alter this control on advice from Pegasus Mail technical support.

Accept requests to "confirm reading"    This option only applies when you are not connected to a NetWare 
server. It determines whether Pegasus Mail should send automatic answers indicating that you have read 
a message when the "request confirmation of reading" flag is set in that message. If you uncheck it, 
Pegasus Mail will never send confirmation of reading. If you are running on a NetWare LAN this option 
will be greyed and you cannot change it - instead, alter the option in your Extended features preferences.



Deleted messages folder persists between sessions    Normally, if you have turned on deleted message 
tracking in Pegasus Mail, the messages deleted during a session are purged when you exit from the 
program. If you would prefer that Pegasus Mail did not purge the deleted messages folder, check this 
control. When this control is checked, it is up to you to decide when the messages in the deleted 
messages folder should be discarded, either by deleting them from that folder (at which point they are 
gone forever), or by simply deleting the folder when you no longer need it. This option is not available if 
you are running in one of Pegasus Mail's supported Network personality modes.

Winsock loading options  WSOCK32.DLL is a program which provides Pegasus Mail with access to 
TCP/IP (Internet) networking services on your machine. By default, if Pegasus Mail can find a 
WSOCK32.DLL on your system, it will load it and make TCP/IP-based mail services available to you 
using it. If you do not use these features of Pegasus Mail, or if you see errors when Pegasus Mail tries to 
load the DLL, you can disable the automatic loading by clicking the Never button. If you are using 
WinSock across a slow dialup line, such as a SLIP link, you may have to check the Load only on demand 
button: this tells Pegasus Mail to make TCP/IP based services available but only to load WSOCK32.DLL 
when it actually needs to use it, then unload it when it's finished. You might also want to use demand 
loading if your machine has only very limited memory. In normal use on an Ethernet LAN, however, you 
should check the Always button so that Pegasus Mail can get the highest performance from your TCP/IP 
network.



NetWare MHS preferences

See also: Preferences overview

If a version of Novell's MHS transport is installed on your system, then this option allows you to configure 
the way Pegasus Mail will interact with MHS for you. In general, the options in this screen are quite 
complex and you should change them only if instructed to do so by your MHS administrator.

My NetWare MHS username:    This is the username by which MHS knows you. It may be the same as 
your NetWare username but need not be. If you are using an SMF-71 transport such as NetWare Global 
MHS, you can enter a full SMF-71 address (up to 128 characters long) in this field. You may need to enter
a complete address here if you are not a member of the default MHS workgroup.

Mailbox name:    This is the name of the directory in the MHS tree where your MHS new mail folder is 
located. If you are using MHS 1.5, it will usually be the first eight characters of your NetWare username 
(which is the default Pegasus Mail uses) but it may be different, and is likely to be different if you are 
using an SMF-71 transport.

New mail folder:    This is the name of the folder in your new mail folder where Pegasus Mail should 
expect to find your new mail. In technical terms, this field should contain the name of your preferred 
mailer which may or may not be PMail.

Check the MHS newmail folder:    By default, MHS creates a new mail directory for every user called 
MHS, and makes this directory the preferred mailbox for the user. Checking this control tells Pegasus Mail
to check the MHS new mail folder as well as any other you name in the New mail folder field. Checking 
this option is harmless at worst, although it may slow down checks for new mail a little bit.



Signatures

See also: Preferences overview
Tutorial: editing your signatures

A signature is a small fragment of text which Pegasus Mail will automatically add to the end of messages 
you send. You should usually put your name, address and phone/fax number in your signature, although 
some people like to place a witty saying or other text there as well. As a general rule, your signature 
should have no more than 7 lines maximum.

Pegasus Mail supports separate signatures for each type of message you can send - Local, Internet and 
MHS.Note that it bases its selection of signature on the transport mechanism, so if you send a message 
to a user on your file server but do so via an Internet transport such as Mercury or Charon, your Internet 
signature will be attached to the message.

Variable signatures:    Pegasus Mail can place a piece of text selected at random from a list you provide in
your signature -- for more information on preparing a variable signature, examine the sample quotes file 
RQUOTES.R in the RESOURCE\ subdirectory of the directory where you installed Pegasus Mail. To flag 
the location in your signature where you want the variable text to be placed, use the special characters ~!.
Be careful when using variable signatures -- people's tastes differ hugely all around the world, and 
something which seems witty to you may be offensive to other people.



Home mailbox location

See also: Preferences overview

Your home mailbox is where all your mail folders, distribution lists, address books and other Pegasus Mail
related files except unread new mail are stored. By default, it is located in a special directory on the file 
server, but you can specify an alternative location for it using this option.

Note: before using this option, make sure that all windows in Pegasus Mail are closed except the button 
panel (which can also be closed but does not have to be).

You may want to change your home mailbox location if you have limited space on the file server, if you 
are concerned about the privacy of your mail, or for other reasons. You can also have more than one 
mailbox and change between them using this dialog - you might want to do this if you received mail at 
your address for more than one person or organization.

To change your home mailbox location, type in the new path in either DOS or UNC format. If you want to 
change the location but leave all your mail files where they are, make sure that the move mailbox 
contents to new location button is not checked (this is how you would implement more than one mailbox 
as described above). If you have moved your home mailbox but want to revert to the original location on 
the file server, press the Use default button.

If you have chosen to move the contents of your home mailbox, Pegasus Mail will do so as soon as you 
click the Change now button. Clicking the OK or Apply buttons without clicking Change now will leave 
your mailbox location unchanged.



Extended features

See also: Preferences overview

Extended features are special Pegasus Mail features which you only have if the system administrator has 
explicitly granted them to you. If you have been granted access to extended features, then the Extended 
features menu option in the Preferences sub-menu will be available, otherwise it will be grey and you 
cannot select it. Choosing this option opens a dialog which allows you to change the following:

Autoforwarding: Pegasus Mail supports autoforwarding, or the redirection of your mail to another account.
You can autoforward either mail delivered to you from local addresses, mail received from the Mercury 
Internet gateway, both or neither. It is possible to forward one type of mail but not the other. To set 
autoforwarding, place the forwarding address in either or both of the available autoforward fields. You can 
forward local mail to any address Pegasus Mail can understand including NetWare groups and 
distribution lists. Internet mail can only be forwarded to simple local addresses or to Internet addresses. 
Mail arriving via NetWare MHS cannot be autoforwarded.

Deliver mail even if autoforwarding: check this box if you want Pegasus Mail to leave a copy of mail as 
well as forwarding it when you have autoforwarding addresses set. This option has no effect if you are not
forwarding your mail.

Allow 'confirmation of reading' requests. If you uncheck this box, then Pegasus Mail will not return 
confirmation that you have read messages when it is requested. Local users will be told the moment they 
send the message that no confirmation will be supplied, but Internet and MHS mail will receive no such 
notification.

Advise of new mail via broadcasts: When this box is checked, Pegasus Mail will send a NetWare-style 
broadcast message to indicate that a new mail message has arrived. If you find the broadcast messages 
annoying but do not want to use the NetWare CASTOFF command to disable them, uncheck this box..

Disable mail delivery to this address: If checked, it will not be possible to send mail to this address.



Message and reply settings

See also: Preferences overview

This page allows you to change the initial settings for mail the messages and replies you send.

Preferred editor variation for normal messages    This control lets you select the layout of the Pegasus 
Mail message editor you get by default when you press <Ctrl+N> to create a new message. The 
available layouts are shown in the drop-down list box. We suggest you experiment with the different 
layouts to see if there is one there you prefer to the others.

Default settings for new messages

Use MIME features    MIME is an Internet standard for handling mail messages. In general, we strongly 
recommend that you use Pegasus Mail’s MIME features unless you are corresponding with someone 
using a mail system that does not understand or follow the MIME standard. This control determines the 
default state of MIME support in your mail messages - whichever value you select is what Pegasus Mail 
will use each time you start a new message. You can enable or disable MIME support on a message by 
message basis using the control in the Special view of the message editor. When MIME support is turned 
on, Pegasus Mail will use MIME encodings for all attachments, and will use the proper MIME 
transformations to preserve special and accented characters in your messages. Pegasus Mail always 
handles mail you receive that uses MIME formats correctly whether or not this control is turned on.

Confirm reading, confirm delivery, copy to self    These sets of controls let you set the default value for the 
controls they match in the message editor. The On and Off settings are self-explanatory; if Use last 
setting is selected, then Pegasus Mail will remember from message to message the last setting you used 
and will use that. This is also called sticky setting throughout this help file and is the default setting for all 
three controls.

Settings applying to replies only

Remember address selection options in reply dialog    When this control is checked, the five address 
selection controls at the bottom of the reply dialog will remember their settings from message to message,
as will the Copy original's CC field into reply option. Leaving this option unchecked allows these controls 
to work on a per-message basis, resetting them before each reply. Working with this control unchecked 
makes it very easy to select exactly which addresses in a message you wish to use when composing a 
reply, and we recommend that it normally be turned off.

For replies, place the cursor on an initial blank line    When this control is checked, Pegasus Mail will insert
a blank line at the top of your replies and will position the cursor there, ready for you to begin typing.

Use message reader quoting styles in replies    If you check this box, Pegasus Mail will use the same 
styles you have defined in your Message Reader Preferences for highlighting text quoted from previous 
messages in the editor. This is primarily intended as a visual cue for you, and has been specifically 
designed not to cause Pegasus Mail to generate richtext messages, even if the quoting style you use 
contains colours or italic type.

Address completion

Pegasus Mail can complete your addresses for you as you type them. Each time you type a character in 
an address field, such as the To: field in the message editor, Pegasus Mail looks at what you have typed 
and tries to find an address that matches it in either your addressbooks, or in the list of addresses to 
which you have sent mail recently. If it can find a match, it fills out the address field with the matching 
address, selecting the text it has added: if you type more characters, the suggested text will be replaced 
and the process will be repeated. The two controls in this dialog allow you to choose where Pegasus Mail 
should look when trying to complete addresses for you: if neither is checked, Pegasus Mail will not 



attempt to complete addresses at all.

Note that completing addresses from your addressbooks may be very slow if you have several 
addressbooks, or if your addressbooks have many entries.



Settings for sending mail

See also: Preferences overview

The options in this dialog control the way Pegasus Mail generates the messages you send. Many of the 
options are quite advanced in nature, so if you do not fully understand the purpose of an option, we 
strongly recommend you leave it as it is.

Default reply address    If you want to specify an address which Pegasus Mail will automatically copy to 
the reply-to field of every outgoing mail message, enter it here. There is usually no need to use this 
option - you might use it if you routinely prefer to receive your mail on another system for instance, but in 
normal use you do not have to enter anything here.

Permanent BCC (blind carbon-copy)    From time to time, you may wish to have all the mail you send 
automatically sent to a specific address, perhaps a supervisor's address, or to another account you use 
more regularly. You can do this by entering the address or a list of addresses separated by commas in 
this field. The addresses you add do not count towards the maximum length of your BCC field, and you 
can add other BCC addresses on a message by message basis.

Richtext (formatted) message handling

Pegasus Mail's editor supports a wide range of formatting styles, very much like a word processor. 
Unfortunately, not all e-mail packages understand formatted text, and the standards that exist for 
interpreting and representing formatted text are not yet widely supported or well-established. As a result, 
you should exercise some care when sending messages containing any kind of formatting - bold, italic, 
font changes, and so on. The controls in this section of the Message Editor Preferences dialog allow you 
to customize the way Pegasus Mail generates rich text messages.

Generate multipart/alternative versions of richtext messages    Multipart/Alternative is a special feature of 
the Internet MIME message standard that allows different versions of the same text to be packaged 
together in one message. Mail readers that understand the format can then choose the version they are 
most able to display. When this control is checked, Pegasus Mail will generate messages containing two 
versions of any rich text mail you send - the rich text version, and a plain text version suitable for any mail 
program that cannot handle the rich text format. The cost of generating multipart/alternative messages is 
that your messages will typically be twice as large as normal, because they will contain the same data 
presented in two different ways. It is worth pointing out that the multipart/alternative format has proven 
very unpopular on mailing lists, and as a result you should avoid using rich text formatting altogether for 
such messages.

For mail sent to local addresses, use MS-RTF formatting    Microsoft's Rich Text Format (RTF) is an 
extremely powerful way of handling complex formatting in documents. Pegasus Mail's editor can generate
and read RTF very well, and will usually default to this format when you need to send mail containing 
pictures or other formatted data to other users on your local system. When this control is checked, 
Pegasus Mail ignores the setting of the Always remove formatting control when sending messages to 
other local users on your system, generating fully-formatted RTF. If the control is unchecked, Pegasus 
Mail will not generate RTF and will obey the Always remove formatting setting even for local addresses.

Advanced message construction settings

Send enclosures instead of attachments    When you send mail with attachments to Internet addresses, 
Pegasus Mail usually sends the text and all its attachments in a single mail message. In some cases, 
typically for people using slow links, it may be convenient to be able to have the text and attachments 
delivered in separate messages; if you would prefer that Pegasus Mail behaved this way and generated a
separate mail message for each section, uncheck this control.

Allow 8-bit MIME encodings    If you check this control, Pegasus Mail will generate MIME messages using 



the MIME "8BIT" transfer encoding whenever you include 8-bit data in your mail. 8-bit data is illegal in 
Internet mail, but is used in some countries. This is both a very technical, and potentially very dangerous 
option and should only be used if you know what you are doing. We recommend you do not check this 
control except on the advice of a properly qualified person.

Don't add "attachment information" sections to Multipart messages    Normally, when you send a message
with attachments, Pegasus Mail automatically attaches a small textual section describing each 
attachment. The textual section includes the file's original name, size, date and type, and is useful to help 
the recipient identify and place the attachment. In some cases, for instance, when sending to fax 
gateways, you may prefer to suppress this information section. If you wish to suppress the section, check 
this control.

Suppress BCC field listings in outgoing mail    BCC (Blind Carbon Copy) is a useful, but poorly-
standardised feature. There are at least three ways a BCC field could be written into a message: it could 
be omitted altogether; it could contain only each individual recipient's address; or it could contain the 
addresses of all people receiving the BCC. By default, Pegasus Mail lists all the BCC recipients in the 
BCC field of mail it sends: if you would prefer that no addresses were shown in the field, then check this 
control. When this option is turned on, the BCC field will simply contain the text "(Suppressed)", without 
any addresses.



Settings used when encrypting messages

See also: Preferences overview

Pegasus Mail has a built-in encryption module that you can use to scramble your mail messages, to keep 
them from prying eyes. It also supports plug-in encryption modules for systems such as Phil 
Zimmerman’s PGP (Pretty Good Privacy). You can alter some of the settings Pegasus Mail will use when 
you choose to encrypt your messages using the group of controls in the Encryption settings preferences 
dialog..

Default encryption method    If you have installed a third-party encryption module on your system, it will 
appear in this list: by selecting it here, you can tell Pegasus Mail that this is the encryption module you 
would like to use by default. Note that this does not mean that all your mail will be encrypted – simply that 
if you choose to encrypt a message, the encryptor you have chosen will be preselected in the encryption 
dialog, which can save some time if you encrypt messages often.

Default password    Some encryption modules, for instance John Navas’s PGP-JN implementation, may 
require a passphrase in order to perform certain operations (PGP-JN, for example, needs the passphrase
to access your PGP keyring when signing or encrypting messages). If your encryptor needs a 
passphrase, you can if you wish enter it here, which will save you from having to type it in every time you 
want to encrypt or sign a message. If you enter your passphrase here, it will be stored in your INI file in an
encrypted form.

WARNING!!    Setting your passphrase in this control is a security risk – you should not do it if your 
machine may be accessed by unauthorised users. This facility is provided for the convenience of users 
with low security requirements or whose systems are located in secure areas.

Ask at startup    If you do not want to enter your passphrase by default but also don’t want to have to type 
it repeatedly, then you can check this control and Pegasus Mail will ask you to enter your passphrase at 
startup. This is a reasonable compromise between security and convenience, but is still not 100% secure.

Auto-attach a digital signature if the encryptor supports it    A digital signature is a special form of 
encryption that authenticates a mail message as being from you and as being unaltered, while still 
allowing the recipient to read the message normally. Digital signatures are based on complex 
mathematics and offer very reliable proof of the authenticity of a mail message. If you have installed an 
encryption module, such as PGP-JN, that supports digital signing, you can check this control to have 
Pegasus Mail automatically generate a signature for every message you send by default. Note that in 
most cases if you check this control, you will also need to provide your passphrase by one means or 
another. Checking this control will also increase the size of each message you send and may introduce a 
delay in the sending process.



Message reader settings

See also: Preferences overview

The Message reader settings page of the options and preferences dialog allows you to control the way 
Pegasus Mail displays messages in the standalone message reader.

Show quoted text in    It is a common Internet convention to include part of the mail message to which you
are replying in your reply, marked with the character “> “ to show that it is being quoted. When you are 
reading messages, Pegasus Mail can display parts of the message marked this way in a different colour, 
which can make it much easier to follow the flow of the conversation. Select the colour you would like 
Pegasus Mail’s reader to use for quoted text from the drop-down list.

Italics    If you check this control, Pegasus Mail will also show quoted text using an italic typeface. This can
further increase the ease of reading replies.

Right margin for wrapping and reformatting    This setting controls the column at which Pegasus Mail 
should begin wrapping or reformatting lines in mail messages when either the Wrap long lines or 
Reformat long lines display mode is selected (either from the Reader menu, or by pressing <F5> or 
<Ctrl+F5>).

Always save the last window size and position used  Pegasus Mail normally uses a default size for 
message reader windows - you can adjust that default size by setting a reader window to the size you 
would like then choosing Save window size from the Reader menu. All subsequent message reader 
windows will open at that size. If you would prefer that Pegasus Mail always used the size of the last 
message reader window you opened instead, check this control.

Where a choice exists, display the fancy version    A lot of mail sent using formatting also includes a 
version of the message in plain text format. The plain text format can usually be displayed with complete 
reliability, where the rich text version may in some cases be unpleasantly formatted, especially when it 
contains HTML data. Checking this control tells Pegasus Mail to present the formatted version of the 
message, while leaving it unchecked tells it to display the plain text version in preference. In situations 
where only a fancy version of a message is available, Pegasus Mail will display it even if this control is 
unchecked.

When the current message is moved or deleted    These controls determine how the message reader will 
react when you move or delete the message you are reading.



Reading mail

See also: Message reader preference settings
Message reader tutorial
Keyboard shortcuts

To read a message in a folder, either double-click on it or select it and press the Open button. If you are 
running Pegasus Mail in its folder preview mode, you can still open a message in its own reader window - 
and in fact, you will often want to do so.

The message reader window has a toolbar with most of the options available in the folder window 
appears. There is also a Print button, which has the same effect as choosing Print from the File menu, 
and a pair of buttons marked Next and Prev. The Next button replaces the message in the reader window
with the next message from the folder, while the Prev button replaces the message with the one before it 
in the folder. If you hold down the Shift key while you press Next or Prev, the message you are leaving will
be marked in the folder selector before the new one is loaded. If you hold down the Ctrl key when you 
click Next, Prev, Move, or Delete, the next or previous unread message will be loaded instead of simply 
the next message.

The Copy command on the Edit menu will copy any selection you have made in the message. There is 
also a Copy command on the right-click menu for the reader.

Right-clicking a message will bring up a list of options specific to that message. Most of these options are 
duplicated on the Reader menu, but one, Copy to DList, is unique: this command will take whatever text 
you have selected and add it directly to a distribution list. This command is very useful for adding 
addresses to regularly-used mailing lists, and in conjunction with the new mail filtering rule that checks list
membership.

Options specific to the message reader appear in the Reader menu.



Message reader keyboard shortcuts

See also: The Message reader
Message reader tutorial

The following keyboard shortcuts are available while using the message reader:

R Start a reply to the message
F Forward the message to another address
C Copy the message to a folder
M Move the message to a folder
D or <Del> Delete the message
P or <Ctrl+P> Print the message
X Open the next mail message or digest contained within the 

message in its own window
V Switch between fancy and plain views (if available)
<Ctrl+F> Find text within the message
Z Switch between normal and expanded header view
<Ctrl+S> Save the message text to a file on disk
<F5> Reformat long lines in the message (setting is "sticky")
<Ctrl+F5> Wrap long lines in the message (setting is "sticky")
<F12> Switch to a monospaced view of the message (does not work in 

HTML or text/enriched messages)
<F11> Select a folder display colour for the message
<F8> Switch to the "Message" view
<F7> Switch to the "Attachments" view
<F9> Switch to the "Annotations" view
<Ctrl+H> Toggle between the "Raw" and "Message" views
1 or <Ctrl+1> Quick-move or quick-copy to quickfolder #1
2 or <Ctrl+2> Quick-move or quick-copy to quickfolder #2
3 or <Ctrl+3> Quick-move or quick-copy to quickfolder #3
4 or <Ctrl+4> Quick-move or quick-copy to quickfolder #4
5 or <Ctrl+5> Quick-move or quick-copy to quickfolder #5
6 or <Ctrl+6> Quick-move or quick-copy to quickfolder #6



The Reader menu

While reading mail, the Reader menu appears on the main Pegasus Mail menu bar. The menu offers 
options specific to the message reader: Note that you can alter certain aspects of the message reader’s 
behaviour using the Message reader settings page of the Options dialog on the Tools menu.

Wrap long lines, Reformat long lines    Periodically, you will probably receive mail from other mail systems 
where the lines are extremely long, and hence can't easily be read. These two options allow you to deal 
with malformatted mail of this kind - which of the two you will use depends on the message. Wrap long 
lines simply chops the line at the nearest space to the right margin until the line is shorter than the right 
margin. This option is simplistic, but will work well if the sender's mail program sends whole paragraphs 
as a single line. Reformat long lines applies a much more complex reformatting approach that tries to 
estimate how the message was intended to appear: it will usually do a better job of most messages than 
simple wrapping, but may scramble tables or figures that depend on long lines. After a time, you will work 
out which of these settings suits the particular types of mail you receive. Whichever you turn on will 
remain turned on for subsequent messages until you turn it off or select the alternative method.

Save window size:    When you choose this option, Pegasus Mail will save the current size of the message
reader window to your preferences. All future message reader windows you open will open at this size. 
You cannot save the location of a message reader window because doing so would result in messages 
overlapping onscreen and therefore being difficult to select. If you would like Pegasus Mail always to save
the last size you used for a message reader window, use the Format options menu entry (see above).

Toggle monospaced view    Most fonts in Windows are proportionally-spaced -- that is, an 'I' character 
takes up less space on a line than an 'm' character. If you receive a message containing a table or other 
information laid out in a columnar manner and your normal reader font is proportionally spaced, the 
columns in the table will not line up correctly. Selecting this command temporarily switches the message 
reader into a monospaced font, where all characters are the same width. This will allow you to see the 
tabulation correctly. Selecting this command again will switch you back to your regular view of the 
message. You can also toggle this mode by pressing the F12 key on your keyboard.

Quick move/copy:    allows you to move or copy this message into one of your Quick-Access Folders

Extract message to file:    If you want to make a copy of this message in a DOS text file, perhaps for 
inclusion in another program, then select this option. You will be prompted for a filename - when you click 
OK, Pegasus Mail will extract the contents of the message to the file. You can also perform this action by 
clicking the Save to disk button on the button panel.

Font...: Use this option to change the font you use to view messages. This change is global, and affects 
all messages already open and subsequently opened in Pegasus Mail. You can also click the Font button 
on the button panel to set the message reader's font.



Headers are the special set of lines at the start of a mail message which contain addressing and other 
machine-readable information about the message. Headers are rigidly formatted and vary widely from 
system to system; many headers in a message are only of interest to the mail transport system and are 
meaningless to a human reader, while others, such as the Subject and From fields carry information 
which the reader needs to know. Pegasus Mail usually tries to present you with only those headers which 
may be meaningful to you.



The MHS Directory Service

If your system has an MHS SMF-71 message transport such as Novell's NetWare Global MHS, then the 
directory service provided by that system (called the Extract File) is available to you from within Pegasus 
Mail. To open the MHS Directory Service, choose the entry on the Addresses Menu.

The MHS directory service list behaves like a read-only address book: you can double-click on an entry to
start a new message using the entry as an address, you can drag addresses from the list window to any 
address field, or you can click on the Paste button to paste the selected addresses into the last address 
field you were using.

You can also speed search through the list by typing the first few characters of the name you are looking 
for.

For technical reasons, you should close the extract file window as soon as you can after using it, since 
NetWare MHS may not be able to update the list while you have the file open.



Built-in TCP/IP network mail services

Pegasus Mail has built-in support for mail services accessed using TCP/IP (Internet) network protocols 
called POP3 (Post Office Protocol) and SMTP (Simple Mail Transfer Protocol). In order to access these 
services, you must have a TCP/IP network transport interface with a special Windows DLL called 
WINSOCK.DLL installed on your system.

POP3 services allow you to retrieve new mail held for you on another machine (usually a unix machine or 
a NetWare file server).

SMTP services allow you to send mail to the Internet; Pegasus Mail implements SMTP mail using a relay 
service - that is, it asks a complete SMTP implementation (usually running on a unix machine) to send the
mail on its behalf.

Configuring Pegasus Mail's TCP/IP mail services
Troubleshooting
Accessing multiple remote mailboxes - MultiPOP



Configuring Pegasus Mail for WinSock-based mail services

In order to use Pegasus Mail's built-in support for TCP/IP mail, you must have a properly-installed 
Windows Sockets implementation installed on your system, and its WINSOCK.DLL file must be on the 
path, in the \WINDOWS directory, or in the \WINDOWS\SYSTEM directory. You can force Pegasus Mail to
load a particular WINSOCK.DLL file using commandline options.

By default, when Pegasus Mail detects that you have a valid WINSOCK.DLL on your system, it will 
enable the built-in TCP/IP services by setting the WinSock loading option in your Advanced Settings 
preferences to On demand. This means that Pegasus Mail will only load WINSOCK.DLL when it actually 
needs to access its services. When you are using a SLIP or PPP link to connect to the Internet, most 
WINSOCK.DLL versions will dial as soon as they are loaded, so the On demand setting allows you to 
minimize your connect time when checking for mail. If you are connected to a fast local area network, 
however, you should probably consider setting the Winsock loading flag to Always, for performance 
reasons.

If you have a valid WinSock implementation installed on your system, six extra options will appear on your
File menu. The first option, Network Configuration, allows you to configure the way Pegasus Mail's built-in
TCP/IP mail services work for you.

Entering the essential information
Setting the TCP/IP timeout field
Using the built-in TCP/IP mail services
Accessing multiple remote mailboxes - MultiPOP

Advanced configuration options

Overview of configuring for receiving mail via POP3
Overview of configuring for sending mail via SMTP



Accessing multiple remote mailboxes with MultiPOP

From time to time you may need to access more than one remote POP3 mailbox from a single copy of 
Pegasus Mail - this usually happens when you have accounts with more than one Internet Service 
Provider, or when you are looking after someone else's mailbox for them in their absence.

Pegasus Mail is shipped with an Extension called MultiPOP that allows you to access as many POP3 
mailboxes as you wish and offers more scheduling flexibility than the standard Pegasus Mail built-in 
POP3 services. If you did a standard install of Pegasus Mail then you should find MultiPOP on Pegasus 
Mail's Extensions menu. MultiPOP has its own online help.



Pegasus Mail Extensions:    An extension is a program that can be loaded into Pegasus Mail to enhance
it in some way, either by adding new functionality or by changing the way an existing feature operates. In 
other programs, these are also called Plug-ins and Snap-ins. Pegasus Mail is shipped with a number of 
extensions written by Pegasus Mail's author, but extensions can also be written and supplied by other 
developers.

Pegasus Mail provides an extremely rich range of functions and options for extension developers and the 
entire interface is publicly documented-- if you are interested in developing extensions for Pegasus Mail, 
we suggest you obtain the file WPMFORMS.ZIP from the site where you obtained Pegasus Mail - this 
contains all the information you need to begin work.



Entering the essential information

Before Pegasus Mail can send or receive mail on your behalf using its built-in Internet mail routines, there
is a certain amount of information you must give it, which should be entered in the dialog you see when 
you choose Network Configuration from the File menu. This information should have been provided to 
you by your Internet Service Provider or Computing Centre -- Pegasus Mail cannot use any kind of default
values for any of the fields in this screen, unlike the options in the Advanced Configuration Options 
screen, which all have reasonable default values.

The information you must provide before Pegasus Mail can operate is as follows:

Your e-mail address is    Enter your electronic mail address here.

POP3 host  The name of the machine from which Pegasus Mail should retrieve your new mail. The format
of the address you provide here depends on your WinSock implementation: many will allow you to enter a
normal internet name (for example, parnassus.pmail.gen.nz), but some may require that you enter the 
address in dotted notation (for example, 192.156.225.2). Consult your system manager or WinSock 
manual if you are unsure which form to use.

Username    The name of the account on the machine under which mail is being held for you. Pegasus 
Mail logs into the host using this account name and retrieves any mail waiting there. Pegasus Mail only 
wants your username in this field, not your address - if what you have entered here contains an '@' 
symbol, then it is probably incorrect.

Password    The password for the account on the host. The password is not displayed on the screen and 
is stored in an encrypted format in your configuration file.

SMTP host    Enter here the name of a machine which can process outgoing mail on your behalf. This is 
usually the same machine you entered as your POP3 mail host, and the address is subject to the same 
restrictions and rules described there. Pegasus Mail asks the relay machine to send outgoing mail on 
your behalf, so the machine you name must be running an SMTP server; your system manager or service
provider will be able to tell you which machine or address to use for this field.

Dialling  Clicking this button (available only in the Win32 version of Pegasus Mail) allows you control the 
way dialling will occur if you use a dialup connection to the Internet. For more information on dialling, click
here.



Advanced Configuration for WinSock Mail

When you click the Advanced Configuration Options button in the Network Configuration dialog, you will 
be presented with a screen where you can tailor the more specialised or technical options controlling the 
way Pegasus Mail's built-in Internet Mailer retrieves and sends your mail.

Many of the options in this screen are quite technical and they may be confusing or obscure to people 
who are not experienced with them. Unfortunately, while we would like to reduce the jargon content of this
screen, the fact remains that Internet electronic mail is inherently very rich in capabilities, and much of the
apparent complexity of this screen cannot really be avoided. If you are unfamiliar with the intricacies of 
Internet Mail, we recommend that you do not adjust any of the values in this screen except perhaps the 
TCP/IP timeout value without first consulting someone more experienced who can advise you.

General settings and timeout values
Settings for outgoing (SMTP) mail
Settings for incoming (POP3) mail



General settings

TCP/IP timeout settings - click here for more information.

Send mail before retrieving mail    Pegasus Mail normally checks for new mail using the POP3 protocol 
before sending your mail using the SMTP protocol; doing it this way allows you to read your new mail 
more quickly. If you would prefer that Pegasus Mail sent any mail in your outgoing message queue before
retrieving your new mail, check this control.

When checking for mail, check for all identities    If this option is checked, then when you check for new 
POP3 mail, Pegasus Mail will go through all the identities you have currently defined and will perform a 
new mail check for each of them. Individual identities can be excluded from this multiple check operation 
by checking the Exclude this identity from multi-identity checks box. Identities where the same username 
and host are specified will only be checked once -- Pegasus Mail is smart enough not to perform 
redundant checks. Note that this setting itself is identity-specific - it can be set or unset depending on an 
identity-by-identity basis; so, for some of your identities you can have the program set to check all your 
identities while for others, only the current identity is checked. You can temporarily override the setting of 
this flag by holding down the Ctrl key as you select Check host for new mail from the File menu, or as you
click on the toolbar button for the same action. So, if you have turned on Check mail for all identities, 
holding down Ctrl when you do a check for new mail will check only the current identity. Similarly, if this 
control is not turned on, then holding down Ctrl when you do a check for new mail will force a check for all
your identities.

Exclude this identity from multi-identity checks    When this box is checked, then the current identity will be
excluded from any POP3 mail check that operates on all your identities (see the preceding entry). If When
checking for mail, check for all identities is not checked, this control has no effect.



Options for outgoing (SMTP) mail:

Connect to SMTP server on port    Specifies the TCP/IP port Pegasus Mail should connect to when 
sending mail. The default value for this field is 25, and you should usually only change it if you are using a
proxy server or firewall, or on the instructions of your network administrator.

Use user-supplied "from" field in SMTP envelope. An Internet Mail message consists of two sections - the 
message and the envelope. The envelope is a kind of "wrapper" of delivery information that is passed 
from SMTP host to SMTP host, and includes information about the sender and recipients of the message 
in transit. You will usually never see the envelope, as it is discarded once the message is actually 
delivered. The only remnant of the envelope in your message is a special field amongst the message 
headers called Return-path, which contains the authenticated address of the original sender of the 
message. The Return-path information is usually only used by SMTP servers to handle errors, but 
unfortunately there are some mail systems on the Internet that ignore your "From" field address and 
instead send replies to whatever value is stored in the Return-path header. By default, Pegasus Mail 
forms the return-path header from your POP3 username and server information, since it knows this 
address is valid. In some cases, though, your POP3 address information may not be valid in the outside 
world - it might only be valid when you contact your Internet Service Provider directly. In cases like this, 
the small group of aberrant mail systems on the Internet may end up trying to reply to you using an 
address that is not valid. Checking this control tells Pegasus Mail to form your Return-path headers using 
the information you have supplied rather than the authenticated POP3 server information. Doing this will 
on one hand probably fix the problems users on the aberrant systems are having sending replies to you, 
but on the other hand may create local delivery problems. In short, if you have someone report that they 
cannot reply to your address even though you have a valid address in the "Your e-mail address" section 
of the Network Configuration Dialog, try checking this control.

Send mail at once without placing in queue    If you check this, Pegasus Mail will send your mail 
messages to the relay host as soon as you click the Send button in the message editor. If you leave the 
box unchecked, Pegasus Mail will queue your messages, and will only send them to the relay host when 
you explicitly choose Send all queued mail from the File menu. If you are using a slow TCP/IP link, you 
should probably leave this box unchecked.

Use in preference to LAN mailer for Internet mail    This option is only meaningful when you are running 
Pegasus Mail on a NetWare system which is also served by either the Mercury SMTP transport or the 
Charon Internet mail gateway. Checking this control tells Pegasus Mail to use its own built-in mail delivery
routines instead of passing your outgoing mail to Mercury or Charon for processing. If you leave this box 
unchecked, then Pegasus Mail will always use Mercury or Charon in preference to its own SMTP delivery 
routines if either is available on the NetWare system to which you are connected. The setting of this 
control is ignored when you run Pegasus Mail in a non-NetWare environment.

Use for all outgoing mail, regardless of address:    Usually when you enter an address such as "DAVID", 
which has no domain portion, Pegasus Mail regards it as a local address and attempts to deliver it to the 
user based on the assumption that he can be found on the machine you are using. If you are the only 
person who uses your computer, however, then there will be no other users on your system and this 
assumption will not be valid. Checking this control tells Pegasus Mail to pass all mail to the remote host 
for processing and not to presume that any addresses are local to your machine. You should only check 
this control if you are the only person who uses your machine.

Send any mail in the queue during idle checks:    If you check this control, Pegasus Mail will send any 
messages waiting in your mail queue when it does an idle check to see if you have new POP3 mail. The 
frequency of these checks is determined by the setting of the Poll new mail after x secs idle field of the 
POP3 configuration section of the Network configuration dialog



Options for incoming (POP3) mail

Connect to POP3 server on TCP port    The TCP/IP port on which the server listens for your connections. 
The default for this field is 110, which is the port defined by the POP3 standard. On rare occasions, your 
POP3 server may listen for connections on a different port number, in which case you would enter that 
port number here. You should only change this value if advised to do so by your service provider, network
administrator, or by Pegasus Mail technical support.

Do not download mail larger than x KB If you are connected to the mail host by a slow TCP/IP link (such 
as a SLIP link) then downloading large messages can be very time consuming. If you enter a value in this
field, Pegasus Mail will not attempt to retrieve any mail larger than the size you specify (in kilobytes) - it 
will be left untouched on the host. A value of 0 in this field means no limit - Pegasus Mail will download all 
mail.

Check for new POP3 mail every x secs    This option controls whether or not Pegasus Mail should poll 
your POP3 host for new mail automatically, and if so, how often. Enter here a number of seconds 
between poll cycles (Pegasus Mail is accurate to the nearest three seconds), If you check the Idle control 
next to this, then Pegasus Mail will wait until it has been idle (no keystrokes or mouse presses) for this 
length of time before it will automatically check for new mail. If the Idle control is unchecked, then checks 
will occur at regular intervals, regardless of activity. A value of zero means that Pegasus Mail should 
never poll the POP3 host automatically – you will have to initiate the check yourself by choosing "check 
host for new mail" from the File menu.

Count new messages when polling but don't download    If this control is checked and you have set an idle
poll cycle (see the last entry) then Pegasus Mail will simply check the number of new mail messages on 
each idle check and report that number on the status bar. If this control is unchecked, Pegasus Mail will 
automatically download any new mail it finds on the host on each idle check. On slow links, checking this 
control can result in a lower performance demand on your machine.

Allow checks when Pegasus Mail is minimized  By default, Pegasus Mail does not check the remote host 
for new mail periodically when it is minimized on your desktop, in order to reduce loading on your system 
and to eliminate the "jerkiness" the extra activity produces. With many versions of WINSOCK.DLL, 
however, the loading incurred by background checking is quite light, so if you would like Pegasus Mail to 
check while in the background then click this control.

Delete mail from host once successfully retrieved    If you check this box, Pegasus Mail will delete the 
host's copy of each mail message it successfully downloads, which will prevent it from being presented to 
you again the next time you retrieve mail. Leaving this box unchecked tells Pegasus Mail to leave the mail
on the host even if successfully downloaded. Mail left on the server will be retrieved every time you 
download mail.

Check whenever the new mail is opened    If you check this box, Pegasus Mail will check the host for new 
mail every time you open the new mail folder or click the New Mail button in the button panel. If you leave 
this button unchecked, then Pegasus Mail will only check for new mail when you explicitly choose Check 
host for new mail from the File menu.

Download only unread mail    The usual practice when retrieving mail from a POP3 host is to delete it from
the host when it is successfully downloaded. If you do not delete it, you would normally expect to see it 
again the next time you download mail from the host. Pegasus Mail incorporates a powerful and 
complicated facility which allows you to leave mail on the POP3 host without deleting it, but only 
download mail you haven't already seen. Because the POP3 protocol does not actually provide this 
facility, there are some limitations on this command, the most specific being that if you run Pegasus Mail 
on more than one machine, each one will have a separate list of what you have already seen; so, if you 
download mail using one machine then access your account later from a different machine, you will 
probably get the mail you downloaded the first time again, where downloading the mail on the same 
machine you originally used would only show mail which had arrived since the last time you accessed 



your account. Check this control to instruct Pegasus Mail to attempt to download only mail you have not 
read. The effect of this control is probably meaningless if you do not also uncheck the "Delete retrieved 
mail on host" control. Using this feature can significantly increase the time it takes for Pegasus Mail to 
retrieve your new mail.

APOP shared secret    Pegasus Mail supports a POP3 command called APOP, which allows you to 
connect to a POP3 server without transmitting your password over the network in plain text. In order to 
use the APOP command, your POP3 server also needs to support the command, and you need to have a
special word or phrase known both to you and to the POP3 server: this special word or phrase is called a 
"shared secret". If your ISP or network administrator tells you that your POP3 server supports the APOP 
command, then you can enter your APOP shared secret here and Pegasus Mail will use it to connect to 
the server. Note: your APOP shared secret is almost never the same as your regular password: if you are 
unsure what to enter in this field, either leave it blank, or else ask your ISP or network administrator for 
assistance.



TCP/IP timeout settings

TCP/IP timeout value settings control how long Pegasus Mail should wait for responses on your network 
before assuming that a problem has occurred. On fast networks such as Ethernet, you should set this to a
relatively small value, such as 15 seconds. On slow links such as SLIP or PPP, however, considerably 
longer values may be appropriate - for example, 120 seconds or even more. If you find that Pegasus Mail 
is frequently reporting network errors, try increasing this value to a larger setting.

Because of the way Pegasus Mail's TCP/IP module works, you can run into problems if you exit from 
Pegasus Mail while a TCP/IP operation is in progress. Because of this, you should experiment with the 
timeout value, until you find the lowest value that gives you reliable connectivity. Avoid using a timeout 
value which is higher than it needs to be. Our recommendations are as follows

On a fast local area network:    15 seconds
Using a reliable PPP link, or 28.8K modems    30 seconds
Using a SLIP link or 14K4 modems    60 seconds
If your link occasionally loses packets    add 60 seconds



Configuring Pegasus Mail to receive mail via POP3

This section gives a general overview of all the settings available in the Network Configuration dialog and 
Advanced Configuration Options dialog that control the way Pegasus Mail retrieves mail for you.

POP3 is the protocol Pegasus Mail uses to download your new mail from remote mailbox via TCP/IP. You 
control the way Pegasus Mail interacts with your remote mailbox using the options on the right-hand side 
of the Network configuration dialog.

POP3 host  The name of the machine from which Pegasus Mail should retrieve your new mail. The format
of the address you provide here depends on your WinSock implementation: many will allow you to enter a
normal internet name (for example, parnassus.pmail.gen.nz), but some may require that you enter the 
address in dotted notation (for example, 192.156.225.2). Consult your system manager or WinSock 
manual if you are unsure which form to use.

Connect to POP3 server on TCP port    The TCP/IP port on which the server listens for your connections. 
The default for this field is 110, which is the port defined by the POP3 standard. On rare occasions, your 
POP3 server may listen for connections on a different port number, in which case you would enter that 
port number here. You should only change this value if advised to do so by your service provider, network
administrator, or by Pegasus Mail technical support.

Username    The name of the account on the machine under which mail is being held for you. Pegasus 
Mail logs into the host using this account name and retrieves any mail waiting there. Pegasus Mail only 
wants your username in this field, not your address - if what you have entered here contains an '@' 
symbol, then it is probably incorrect.

Password    The password for the account on the host. The password is not displayed on the screen and 
is stored in an encrypted format in your configuration file.

Do not download mail larger than x KB If you are connected to the mail host by a slow TCP/IP link (such 
as a SLIP link) then downloading large messages can be very time consuming. If you enter a value in this
field, Pegasus Mail will not attempt to retrieve any mail larger than the size you specify (in kilobytes) - it 
will be left untouched on the host. A value of 0 in this field means no limit - Pegasus Mail will download all 
mail.

Check for new POP3 mail every x secs    This option controls whether or not Pegasus Mail should poll 
your POP3 host for new mail automatically, and if so, how often. Enter here a number of seconds 
between poll cycles (Pegasus Mail is accurate to the nearest three seconds), If you check the Idle control 
next to this, then Pegasus Mail will wait until it has been idle (no keystrokes or mouse presses) for this 
length of time before it will automatically check for new mail. If the Idle control is unchecked, then checks 
will occur at regular intervals, regardless of activity. A value of zero means that Pegasus Mail should 
never poll the POP3 host automatically – you will have to initiate the check yourself by choosing "check 
host for new mail" from the File menu.

Count new messages when polling but don't download    If this control is checked and you have set an idle
poll cycle (see the last entry) then Pegasus Mail will simply check the number of new mail messages on 
each idle check and report that number on the status bar. If this control is unchecked, Pegasus Mail will 
automatically download any new mail it finds on the host on each idle check. On slow links, checking this 
control can result in a lower performance demand on your machine.

Allow checks when Pegasus Mail is minimized  By default, Pegasus Mail does not check the remote host 
for new mail periodically when it is minimized on your desktop, in order to reduce loading on your system 
and to eliminate the "jerkiness" the extra activity produces. With many versions of WINSOCK.DLL, 
however, the loading incurred by background checking is quite light, so if you would like Pegasus Mail to 
check while in the background then click this control.



Delete mail from host once successfully retrieved    If you check this box, Pegasus Mail will delete the 
host's copy of each mail message it successfully downloads, which will prevent it from being presented to 
you again the next time you retrieve mail. Leaving this box unchecked tells Pegasus Mail to leave the mail
on the host even if successfully downloaded. Mail left on the server will be retrieved every time you 
download mail.

Check whenever the new mail is opened    If you check this box, Pegasus Mail will check the host for new 
mail every time you open the new mail folder or click the New Mail button in the button panel. If you leave 
this button unchecked, then Pegasus Mail will only check for new mail when you explicitly choose Check 
host for new mail from the File menu.

Download only unread mail    The usual practice when retrieving mail from a POP3 host is to delete it from
the host when it is successfully downloaded. If you do not delete it, you would normally expect to see it 
again the next time you download mail from the host. Pegasus Mail incorporates a powerful and 
complicated facility which allows you to leave mail on the POP3 host without deleting it, but only 
download mail you haven't already seen. Because the POP3 protocol does not actually provide this 
facility, there are some limitations on this command, the most specific being that if you run Pegasus Mail 
on more than one machine, each one will have a separate list of what you have already seen; so, if you 
download mail using one machine then access your account later from a different machine, you will 
probably get the mail you downloaded the first time again, where downloading the mail on the same 
machine you originally used would only show mail which had arrived since the last time you accessed 
your account. Check this control to instruct Pegasus Mail to attempt to download only mail you have not 
read. The effect of this control is probably meaningless if you do not also uncheck the "Delete retrieved 
mail on host" control. Using this feature can significantly increase the time it takes for Pegasus Mail to 
retrieve your new mail.



Configuring Pegasus Mail to send mail via SMTP

This section gives a general overview of all the settings available in the Network Configuration dialog and 
Advanced Configuration Options dialog that control the way Pegasus Mail sends mail for you.

SMTP is the protocol Pegasus Mail uses to send mail via TCP/IP. You control the way Pegasus Mail uses 
the SMTP protocol using the options on the left hand side of the Network configuration dialog.

SMTP host    Enter here the name of a machine which can process outgoing mail on your behalf. This is 
usually the same machine you entered as your POP3 mail host, and the address is subject to the same 
restrictions and rules described there. Pegasus Mail asks the relay machine to send outgoing mail on 
your behalf, so the machine you name must be running an SMTP server; your system manager or service
provider will be able to tell you which machine or address to use for this field.

From field  Pegasus Mail allows you to specify your own from field in outgoing messages. This facility is 
provided only to allow you to conform with local addressing schemes or requirements and should not be 
used capriciously. In order to prevent message forgery using this feature, Pegasus Mail will only send 
mail if you have entered a valid username and password in the POP3 section of the configuration dialog, 
and will check the validity of these details when sending. The valid POP3 address is written into a field in 
the message for security reasons.

Use this "from" field to form the SMTP envelope. An Internet Mail message consists of two sections - the 
message and the envelope. The envelope is a kind of "wrapper" of delivery information that is passed 
from SMTP host to SMTP host, and includes information about the sender and recipients of the message 
in transit. You will usually never see the envelope, as it is discarded once the message is actually 
delivered. The only remnant of the envelope in your message is a special field amongst the message 
headers called Return-path, which contains the authenticated address of the original sender of the 
message. The Return-path information is usually only used by SMTP servers to handle errors, but 
unfortunately there are some mail systems on the Internet that ignore your "From" field address and 
instead send replies to whatever value is stored in the Return-path header. By default, Pegasus Mail 
forms the return-path header from your POP3 username and server information, since it knows this 
address is valid. In some cases, though, your POP3 address information may not be valid in the outside 
world - it might only be valid when you contact your Internet Service Provider directly. In cases like this, 
the small group of aberrant mail systems on the Internet may end up trying to reply to you using an 
address that is not valid. Checking this control tells Pegasus Mail to form your Return-path headers using 
the information you have supplied rather than the authenticated POP3 server information. Doing this will 
on one hand probably fix the problems users on the aberrant systems are having sending replies to you, 
but on the other hand may create local delivery problems. In short, if you have someone report that they 
cannot reply to your address even though you have a valid address in the "from field" section of this 
dialog, try checking this control.

Send mail at once without placing in queue    If you check this, Pegasus Mail will send your mail 
messages to the relay host as soon as you click the Send button in the message editor. If you leave the 
box unchecked, Pegasus Mail will queue your messages, and will only send them to the relay host when 
you explicitly choose Send all queued mail from the File menu. If you are using a slow TCP/IP link, you 
should probably leave this box unchecked.

Use in preference to LAN mailer for Internet mail    This option is only meaningful when you are running 
Pegasus Mail on a NetWare system which is also served by either the Mercury SMTP transport or the 
Charon Internet mail gateway. Checking this control tells Pegasus Mail to use its own built-in mail delivery
routines instead of passing your outgoing mail to Mercury or Charon for processing. If you leave this box 
unchecked, then Pegasus Mail will always use Mercury or Charon in preference to its own SMTP delivery 
routines if either is available on the NetWare system to which you are connected. The setting of this 
control is ignored when you run Pegasus Mail in a non-NetWare environment.

Use for all outgoing mail, regardless of address:    Usually when you enter an address such as "DAVID", 



which has no domain portion, Pegasus Mail regards it as a local address and attempts to deliver it to the 
user based on the assumption that he can be found on the machine you are using. If you are the only 
person who uses your computer, however, then there will be no other users on your system and this 
assumption will not be valid. Checking this control tells Pegasus Mail to pass all mail to the remote host 
for processing and not to presume that any addresses are local to your machine. You should only check 
this control if you are the only person who uses your machine.

Send any mail in the queue during idle checks:    If you check this control, Pegasus Mail will send any 
messages waiting in your mail queue when it does an idle check to see if you have new POP3 mail. The 
frequency of these checks is determined by the setting of the Check for new POP3 mail every x secs idle 
field of the POP3 configuration section of the Advanced options network configuration dialog



Using Pegasus Mail's built-in TCP/IP mail services

Once you have configured Pegasus Mail correctly, you can use the options on the File menu and the 
three special buttons on the button panel to access and send your mail.

 , or Send all queued mail on the File menu: Tells Pegasus Mail to process all mail currently in your 
outgoing mail queue and send it to your relay host using the SMTP protocol. If you have checked the 
control labelled Send queue during idle checks in your Network configuration dialog then any mail in your 
queue will also be sent any time Pegasus Mail checks to see if your remote POP3 account is holding new
mail for you.

 , or Check host for new mail on the File menu: Tells Pegasus Mail to connect to your POP3 remote 
mailbox and download any mail waiting there. Unless you have the Message count only on idle poll 
control checked in the Network configuration dialog, new mail will also be downloaded any time Pegasus 
Mail does a check during idle time.

 , or Check and send mail on the File menu: Has the same effect as selecting both the options 
described above in a single connection.

Review queued mail on the File menu: Allows you to examine and change mail in your mail queue waiting
to be sent. You can edit queued mail any time up to the point when Pegasus Mail actually attempts to 
send it: at that time, Pegasus Mail converts the queued message into its final form and from then on, you 
can only delete that message from the queue.

Enter offline mode and Leave offline mode on the File menu: When you enter offline mode, Pegasus Mail 
will cease all POP3 and SMTP activity including idle checks, and will no longer establish any connection 
to your hosts. While in offline mode, you can create, edit and read mail as normal, just without any 
network activity. Offline mode is useful if you are away from your network connection (for instance, 
travelling on a plane) but still want to work with your mail. Once you select Leave offline mode from the 
File menu, normal network activity will resume. You can force Pegasus Mail to start in offline mode by 
adding the commandline switch -O (that's an "oh", not a zero) to the Program Manager Icon you use to 
run the program. If you travel a lot, you may want to consider creating a separate icon for running 
Pegasus Mail in offline mode.



WinSock, or the Windows Sockets Interface is a standard way of providing network services under 
Microsoft windows. WinSock is usually used to provide access to the Internet TCP/IP network protocols 
although it can in theory provide other services as well. The advantage of WinSock is that applications 
can use Network services without knowing anything about the vendor-specific details of the transport 
modules installed on your system. This means that Pegasus Mail can use any WinSock implementation 
no matter which vendor supplies it nor how it is actually implemented at the hardware level.

WinSock support is always provided by means of a DLL called WINSOCK.DLL which will be installed in 
either your Windows directory or somewhere on the path. If you are using a 32-bit version of Pegasus 
Mail under Windows NT, 95 or 98, the WinSock support is stored in a file called WSOCK32.DLL.



POP3

POP3 (Post Office Protocol, version 3) is an Internet standard which defines a mechanism for accessing 
a mailbox located on a remote host machine. In order to use POP3 services, you require a user identity, 
or account on the host machine; when people send mail to you, they send it to your account on the host, 
which receives it and stores it in a mailbox for you. The next step is to run a program which supports the 
POP3 protocol (such as Pegasus Mail): the program logs into the remote host on your behalf and copies 
any unread mail on the host to your local machine for reading. The copy of the mail remaining on the 
remote host can then be deleted (although most POP3 mailers make deletion an option).

POP3 is a necessary protocol because your PC will usually not be running all the time and hence will not 
always be available to receive mail directly from the Internet. A larger machine, such as a Unix system, 
typically will be on all the time, and so is better suited to receiving your mail for you. POP3 only defines 
the retrieval of new mail - mail is sent using the SMTP protocol.

POP3 is described in detail in several RFCs (Internet Standards Documents); the document on which 
Pegasus Mail's POP3 implementation is based is RFC1725.



SMTP

SMTP (Simple Mail Transfer Protocol) is the standard mechanism by which mail is delivered on the 
Internet and on TCP/IP networks. A very old protocol, its qualities are its robustness and ease of 
implementation. On the negative side of the ledger, SMTP is an extremely primitive protocol with no well-
defined support for non-text attachments or international character sets. Because SMTP was originally 
designed for large multitasking systems which run continuously, it has certain design characteristics which
make the reception of mail on PCs a difficult proposition. Because of this, most PC-based mailers which 
use the TCP/IP network protocols use SMTP to send mail, but use another protocol called POP3 to 
receive mail. Pegasus Mail uses this approach.

With over 75 million connectable addresses, SMTP is currently the most widely-used electronic mail 
protocol in the world and is likely to remain a potent force for several years. The SMTP protocol is 
documented in the Internet standards document RFC-821.



Setup for standalone operation

Welcome to Pegasus Mail! Before you begin using the program, you will have to provide Pegasus Mail 
with a small amount of information about your system and its configuration. This is needed so that 
Pegasus Mail knows where to store your mail folders, address books and other mail-related files, and so 
that it knows who you are.

The screen in front of you has three fields you should fill in. The first, Home mail path, is the DOS path to 
the directory in which your home mail folder should be located. The default value, C:\PMAIL\~8, tells 
Pegasus Mail to use the directory C:\PMAIL: the special string ~8 stands for the first eight characters of
your username, and is replaced by Pegasus Mail before it uses the path. So, if you entered Peter as 
your username, Pegasus Mail would set your home mailbox location to C:\PMAIL\PETER. Using the 
special substitution this way means that more than one person may use the mail system on the same 
machine and ensures that their mail is kept separate. If you prefer not to use drive C: for your mail, or if 
for any other reason you need to change the path, you may do so provided the path you enter is legal, 
although we recommend you use the default value unless you have good reasons to change it. The path 
you supply need not exist - Pegasus Mail will create it as necessary.

Your user name:    Enter in this field the name by which Pegasus Mail will recognize you. As described 
above, you can tell Pegasus Mail to use the first eight characters of this name as a way of identifying your
home mailbox. Please ensure that your username contains only letters and numbers - it must not contain 
spaces or special characters, because Pegasus Mail will use it as a DOS filename when naming your 
mailbox directory.

Save your username in WIN.INI:    Usually, when you start Pegasus Mail, it will open a small dialog asking
for your username. If you are the only person using this system, you can bypass this step by telling 
Pegasus Mail to store your username in the Windows setup file, WIN.INI. Once you have done this, the 
system will always run using the name you supply, so do not check this control if there are other people 
using this system for mail as well. You can also specify the username Pegasus Mail should use by means
of a DOS environment variable called PMUSER.



Noticeboards

Pegasus Mail's noticeboard system is like your own mail folders, the principal difference being that people
other than you can see them and read the messages they contain.

A noticeboard may contain both notices, which you can read by pressing <Return> (the same way as in a 
regular mail folder), and can also contain other noticeboards. If you double-click on a noticeboard entry, 
Pegasus Mail will open that noticeboard and show its contents in the list. If you have opened a 
noticeboard, then there will always be a special entry at the top of the list marked .., which will take you 
back to the parent noticeboard.

Noticeboards have two names - a short name, which is used by Pegasus Mail to keep track of where you 
are, and a long name which contains a description of the purpose of the noticeboard. Short names are 
joined together with period characters to create paths, showing where a noticeboard fits into the hierarchy
of noticeboards - so, the topic comp.sys.mail refers to a topic called mail which can be found in another 
topic called sys, which in turn is found in the topic comp.

If you are permitted to post notices in the current noticeboard, then the text Post will appear next to the 
topic's entry in the list: in a read-only topic you may only read the message, not add or delete them. If you
have administrator rights in the current board, the word Administrator will appear next to the topic's entry. 
As an administrator, you can delete messages in the noticeboard, and create new noticeboards within it. 
Administrators are also automatically allowed to post and read messages in the topic.

Posting notices
Following up
Administration



Posting notices

If the noticeboard administrator has permitted you to do so, you can post a new notice on the board by 
clicking the New post button. You can only post into the currently-displayed noticeboard - it is not currently
possible to 'cross-post' to other boards.

Posting a notice is a simplified version of posting a mail message - you only have to enter a subject and 
then type in your notice. Pegasus Mail automatically supplies the name of the noticeboard in which the 
notice is to be placed. 

While you compose your notice, you can add attachments to it in exactly the same way as you would to a 
mail message, by clicking the Attachments button or by pressing <F7>.

To finish your notice and post it to the noticeboard, click Send or press <Ctrl+Enter>. Your notice will 
appear on the noticeboard immediately.

You can also post notices from a regular mail message editor by entering the letters NB: followed by the 
name of the noticeboard as an address - so, to send a message to a noticeboard called alt.animals.cows, 
you would send it to NB:alt.animals.cows.



Following up

Following up is the process of posting a public reply to a notice which is already in the board. Think of a 
followup as being your contribution to an ongoing conversation.

Followups are always posted into the same board as the notice to which they refer. You cannot change 
the subject field of a followup - Pegasus Mail automatically sets it to the subject of the original message 
prefixed with the characters Re:. The reason you can't alter the subject is to ensure that all notices on a 
particular topic will be grouped together when people use the Sort by subject sorting option.

If you want to post an entirely new notice (one with a new subject field), but want to copy some text from 
an existing notice, read the original notice, mark and copy the text you want from the notice, then post a 
new message, and use the Paste or ^V command command to insert the text you copied into your new 
posting.



Noticeboard Administration

If you have administrator privileges in the current noticeboard, the New topic and Current topic properties 
options will be available to you on the Noticeboards menu. Both these options present the same 
noticeboard administration dialog. Note that these options are available or not depending on your rights in
the current noticeboard, not on the selected item in the list.

Short name: Enter the short name for the topic here: the short name may not contain spaces or periods. 
So, if you are currently in a noticeboard called comp.mail and you want to create a new topic called 
comp.mail.pegasus, you would enter pegasus in this field.

Long name: Enter the descriptive name for the topic here. The descriptive name can contain any 
characters.

Administrator(s): Enter the names of those users who are permitted to create topics in and generally 
manage the new topic.

Posters: Enter the names of those users who may post messages in the new topic. If you leave this field 
blank, all users will be allowed to post messages in the new topic.

Browsers: Enter the names of those users who may browse messages in the new topic. If you leave this 
field blank, all users will be allowed to browse the new topic.

In the Administrator(s), Posters and Browsers fields, you may enter as many names as you wish, 
separated by commas. If you are using Pegasus Mail in Novell NetWare NDS mode, enter the user's full 
name starting at the root of the NDS tree. If you are operating in a Network mode where groups are 
supported, you may use group names here by prefixing them with a hash character (#).

Notices expire after x days:    If you running on a system that has a noticeboard expiration utility available, 
such as NBEXPIRE for Novell NetWare servers, you can specify that notices should be automatically 
purged after a certain number of days. Enter 0 in this field if messages should not be automatically 
purged. NBEXPIRE can be obtained from any of the official download points for Pegasus Mail.

Noticeboards can also be administered by directly manipulating their file structures using a text editor: 
click here for more information.

Advanced note: You can force Pegasus Mail's Noticeboard Setup Wizard to appear by holding down the 
<Ctrl> key as you click on the Noticeboard button. This is a handy way of accessing multiple noticeboard 
systems from the same PC.



Manual Noticeboard Administration

This section covers how noticeboards work at a lower level, and details how to create and maintain them 
by manipulating their NB.ID files.

Creating a noticeboard:  Follow these steps to create a noticeboard 

1: Start a DOS shell, and create a subdirectory in the noticeboard where the new noticeboard is to 
appear. Any name will do for the directory.

2: In the new directory, use a text editor to create a file called NB.ID. NB.ID can contain the following 
keywords:

Long name: The full name of the board
Short name: The abbreviated name of the board
Administrator: ID of a user who administers the board
Post: ID of a user who can post to this board.
Browse: ID of a user who can read notices in the board.

Post, Browse and Administrator each take only a single user ID, but may appear multiple times in the file. 
On NetWare systems you can specify NetWare groups in these fields by prefixing the name of the group 
with a # character.

Rights: When you create a noticeboard in Pegasus Mail, you are really working within two different sets of
rights; there are the rights that Pegasus Mail applies to a noticeboard to determine whether or not a 
person can see it and its messages, and there is also the actual operating system rights which apply to 
the directory structure on the disk. If the operating system and Pegasus Mail do not agree on the rights 
assignments, things won't work.

As an example, just because you have told Pegasus Mail that user "JBLOGGS" can post messages in a 
particular noticeboard, it does not follow that he will be able to do so if he does not actually have the 
operating systems rights to create files in the noticeboard directory.

As a result, for each class of user for a noticeboard (Administrator, Browser and Poster) you will typically 
have to run some kind of command on your LAN which allows the user the actual physical access he 
needs to operate as indicated within a noticeboard.

A topic administrator must have at least the rights required on your system to be able to create and 
remove files and directories in the board directory.

A topic browser must have at least the rights needed to be able to see and open files in the directory.

A topic poster must have the rights of a browser and whatever else is needed to create and write files in 
the directory.

If you are running under NetWare 3.x or earlier, then you will have to use the NetWare "GRANT" 
command to assign appropriate rights for each type of poster.



Mail filtering rules

Pegasus Mail allows you to perform automated processing of mail when messages matching particular 
conditions are met. You might use this, for example, to move all "confirmation of reading" replies from the 
current folder to another folder -- in this case, the condition for which you would test would be the first 4 
characters of the "Subject" field being "RCPT". Pegasus Mail can provide this automated processing in 
the following situations --

Automatic filtering when the new mail folder is opened or closed
Filtering your copies to self
Using rules to filter the contents of any folder

You can trigger your rules (that is, define the set of conditions which must be true before the rule will be 
applied to a message) based on a number of criteria. You can select any of the following types of rule 
trigger from the drop-down list at the top of the rule editor window:

Matching on text in standard message headers
Matching on regular expressions
Matching messages by date and age
Matching based on list membership

Using this drop-down list, you can also create rules that always trigger, rules that are simply comments 
and have no effect on rule processing, and rules that are labels (see Advanced formatting, below, for 
more information on why you might want to use a label).

A wide range of actions can be triggered by a rule. Rule processing continues until all rules have been 
applied, or until the message is moved to a folder or deleted as the result of a rule.You can define multiple
rules with the same trigger conditions to have multiple actions applied to the same message -- Pegasus 
Mail will apply them in the order in which they appear in the list. Make sure that any rules containing 
"Move" or "Delete" actions are the last you define for a particular trigger text, since rule processing on a 
message stops after these actions.

Actions that can be triggered by a rule

Advanced filtering - flow control and logical operations



Automated filtering of new mail

You can define a set of rules that are automatically applied to the new mail folder when you open it, and 
to any new mail that arrives in the new mail folder while it is open, and another set of rules that are 
applied automatically when you close the new mail folder. These options are especially useful if you are 
subscribed to mailing lists and want to reduce the clutter in your new mail folder by sorting your list mail 
out to folders, where you can peruse it at your leisure.

To define new mail filtering rules choose Edit new mail filtering rules from the Mail filtering rules option on 
the Tools menu. The rule sets applied when the folder is opened and closed respectively can be edited 
separately.

If there are mail messages that are acted upon by a rule but are not deleted or moved from the new mail 
folder, those messages will be marked as having been read to prevent them from being repeatedly filtered
when you open the new mail folder. Mail that has been read but left in your new mail folder is never 
affected by new mail filtering rules unless you mark it as unread.



Filtering your copies to self

You can create a set of rules that are applied to any copies of mail you send using the Copy self option in 
the message editor. This allows you, for example, to move your personal copies into folders based on the 
person to whom they are addressed or the subject matter. You can define any rule action in your copy self
filtering rules, but the most common actions will usually be to move the message or to set its colour.

To define rules that should apply to your copies to self, choose Edit copy-self filtering rules from the Mail 
filtering rules option on the Tools menu.

If no copyself filtering rule results in the message being deleted or moved, Pegasus Mail will automatically
file the copy to self into the Copyself folder you have designated in your General Preferences settings.

Note: It's quite important that the name you give your copy-self folder in your General Preferences should 
be unique - you should not have another folder with the same name anywhere in your folder hierarchy.



Filtering mail in any folder

Pegasus Mail lets you define sets of rules that you can apply to any folder at any time. These general rule
sets can be either invoked manually, by selecting Apply general rule set to folder from the Tools menu 
while a folder window is frontmost, or automatically when the folder is either opened or closed. To have a 
rule set applied automatically, right-click the folder in the Folder Manager window and select either Attach 
folder-open filter set or Attach folder-close filter set.

Unlike new mail filtering, general rule sets will filter both read and unread mail alike (new mail filtering will 
only filter unread mail). You can create as many different rule sets as you wish and may invoke them on 
any folder, including the new mail folder.

To define a general rule set, choose Create/Edit general rule set from the Mail filtering rules option on the 
Tools menu. This will open the ruleset selector dialog, in which you can create, delete and rename rule 
sets.

To apply a rule set you have created to a folder, choose Apply general rule set to folder from the Mail 
filtering rules option on the Tools menu.



Matching on text in predefined message headers

In the majority of cases, you will simply want to detect messages which contain particular addresses, or 
which have particular text in the subject field. Pegasus Mail provides an easy way of triggering rules 
based on conditions like this.

In the Rule Editor, make sure that the radio button labelled "In these headers" is checked; this will enable 
the header controls next to it. Simply check the fields in which you would like the test to be made, then 
enter the text you would like to match in the "Trigger text" field. You can check as many of the six controls 
as you wish, although some are probably mutually exclusive (such as "From:" and "Subject:"). You should
usually check at least one control, although it is permissible to check none (this is a useful way of 
disabling a rule without deleting it).

Exact matching:    Pegasus Mail usually triggers the rule if any of the fields you check contains the trigger 
text anywhere; if you want Pegasus Mail to trigger only on an exact match, check the control labelled 
Message field must match this text exactly. Doing this means that the rule will only trigger if the header 
and the match are the same length and contain the same characters. The match is always case-
insensitive -- this cannot be changed even for an exact match.

Examples:

If "Subject:" is checked and the trigger text is "SUBSCRIBE" then the rule will trigger if the subject is any 
of the following:

Subscribe
I want to subscribe to your list
Notice to all subscribers

If "Subject:" is checked and Message field must match this text exactly is checked, then the rule will 
trigger only for the first of the examples shown above ("Subscribe")



Using regular expressions as rule triggers

Using regular expressions to trigger rules is more complicated than matching on predefined headers but 
is considerably more powerful, since it allows you to match on any message header, or even on the 
contents of the message body.

To use a regular expression trigger, make sure the radio button labelled "As an expression" is checked in 
the Rule Editor - this will enable the scope controls next to it. You can restrict the extent of the search 
using the scope controls - **NOTE** you should be careful when using either of the scopes which permit 
searching the message body, since this can dramatically increase the time it takes Pegasus Mail to open 
the new mail folder (sometimes by a factor of as much as 10 times or more). You need only have one 
action whose scope is the message body in your entire rule set to cause this increase in processing time, 
although subsequent rules in the message body scope do not introduce appreciable further delay.

Next, enter the regular expression you wish to use in the "trigger text" field. Pegasus Mail recognizes the 
following metacharacters in expressions:

* Match any number of any characters
? Match any single character
+ Match one or more occurrence of the last character
[ ] Encloses a group of characters to match. Ranges can

be specified in the group using '-'.

All metacharacters can be used as many times as necessary. Regular expression searches are always 
case-insensitive. To search for literal occurrences of any of the characters *, ?, + or [, you must enclose 
them in group markers (so to search for a literal asterisk, enter [*]). Regular expressions do not cross line 
boundaries - you can only perform expression matching within individual lines in the message. If the first 
character of your expression is not '*', then matching must begin at the start of the line - so if you want to 
use a regular expression to find lines containing text at any position, you must use a leading '*' character 
(this is the reverse of matching on predefined headers, where the match is always open unless exact 
matching is specified).

Note: Unlike predefined header text matching, regular expression matches do not match substrings - they
match entire lines. Because of this, if you want to detect a sequence of characters occurring anywhere in 
a line of text, you must surround the text with a pair of asterisks (*). This is the regular expression way of 
saying that any text can precede and follow the search text. Example: if you want to match on any line 
containing the string offer using an expression, you would need to enter the match text *offer*. Similarly, if
you wanted to match any line starting with the word Subject and containing the word offer anywhere else 
on the line, you would need to enter the match text Subject*offer*. If you omitted the second asterisk, you 
would be telling Pegasus Mail that the line would have to end with the word offer.

Examples:

MIME-VERSION:*[12]*
or MIME-Version: +[12]*

Matches "MIME-Version:    1.0"
but not "MIME-Version: 3.0"
(The '+' matches multiple successive spaces)

*pmail.gen.nz*
Matches any line containing "pmail.gen.nz"

Priority:*urgent
Triggers a rule for urgent mail



Filtering on the date or age of a message

Filtering on message age

To trigger a rule based on the age of the message, simply enter either a date, or a number of days. The 
rule will trigger if the message's Date: field specifies a date older than the date you enter. This type of rule
can be useful for purging mail from folders once it reaches a particular age.

Filtering on the message date

To trigger a rule on the date of a message, enter either a pair of dates, or a range of numbers of days. It 
does not matter whether you enter the earliest or latest date first - Pegasus Mail sorts them into the 
correct sequence internally. The rule will be triggered if the Date: field of the message specifies a date 
that falls within the range you have specified. This type of rule can be useful for selecting messages 
received within a particular time period.



Filtering messages based on list membership

With this type of filtering rule, the rule will trigger if the sender's e-mail address can be located in a 
Pegasus Mail distribution list. When you create the rule, simply select the distribution list Pegasus Mail 
should search, and it will do the rest.

This type of rule has two major applications:

1: Creating "kill" files to catch "spam" (Unsolicited Commercial E-mail) from known addresses. When you 
receive an unsolicited spam message, you can add the sender's address to a list of known evildoers, then
delete all future messages from that address using a single rule of this type.

2: Verifying that a person is a list member: if you offer services that are triggered by filtering rules (for 
instance, if you return product information or encryption keys in response to automated messages), then 
you may wish to verify that the person sending the request is actually a member of a list of authorised 
people before providing the service. You can use a rule of this type to determine whether or not the 
person is authorised based on their membership of a list.

Features used in conjunction with this option

Pegasus Mail includes a number of powerful features designed to work in conjunction with this type of 
filtering rule: the first is the Add sender to list option on the right-click menus in both the message reader 
and folder browser windows. This command allows you to add the sender of a message to any 
distribution list with a single command. The second feature is the Copy selection to DList option on the 
right-click menu in the message reader: this command allows you to select any text (presumably an 
address) from the body of a mail message and add it straight to a distribution list.

Advanced option

You can create an entry in your target distribution list that matches any address from a single domain by 
editing the list manually and adding a line exactly like this:

\MATCH *@domain.com

into the list. The "\" character must appear hard against the left margin of the file.

Example: to suppress all mail from any address within the domain "bigdeals.com", you would add 
the following line to your distribution list:

\MATCH *@bigdeals.com



Actions that can be triggered by rules

When a rule's trigger text matches text in the message, its action is performed. Actions are selected from 
the list in the Rule Editor - selecting an action will often result in you being prompted for more information,
such as selecting a destination folder, or entering a file name.

Rules are processed until a rule is triggered whose action results in the message being either deleted or 
moved to another folder. Because of this, you should always take care to ensure that rules containing 
Move or Delete actions are the last ones you define for a particular trigger text.

You can also force rule processing to stop for a specific message by using the Exit this rule set action.



Advanced filtering - flow control and logical operations

This section covers specialised uses of mail filtering and is intended mainly for advanced users. Please 
ensure you have read all the other sections on mail filtering before attempting to use the information in 
this topic.

Flow control
Many times, you may find that there are certain groups of rules that you want to apply repeatedly in a rule 
set, or that you want to have more control over the order in which rules are processed. This concept is 
called flow control, and Pegasus Mail provides six rule actions to support it - skip, exit, labels, call/return 
and goto.

Using flow control

Logical operations
Often, you may only want to apply a rule to a message if all of a number of conditions are matched, or if 
any one or more of a number of conditions apply. This kind of operation is known as a logical operation (it 
is also known by the technical name Boolean operation). Pegasus Mail implements logical operations by 
a combination of rule order and flow control structures. Before reading about logical operations, we 
strongly suggest you read the section above on flow control.

Creating logical operations



Using flow control in your rule sets

Many times, you may find that there are certain groups of rules that you want to apply repeatedly in a rule 
set, or that you want to have more control over the order in which rules are processed. This concept is 
called flow control, and Pegasus Mail provides six rule actions to support it - skip, exit, labels, call/return 
and goto.

Skip    The simplest flow control operator is the Skip next rule action: when a rule triggers and this action 
is indicated, Pegasus Mail will skip over the next rule in the list without testing or applying it. You can use 
this as a way of handling exceptions to a general rule - for instance, imagine that you want to delete all 
messages where the subject contains the phrase free offer, except when that message comes from the 
address support@pmail.gen.nz - you would add the following two rules to your rule set:

If "From" field contains "support@pmail.gen.nz", then skip next rule
If "Subject" field contains "free offer", then delete message

Exit    When a rule triggers that has the action exit this rule set, all rule processing for the current 
message terminates at once - no more rules are examined or actioned. The primary use of this action is 
to separate subroutines, or groups of rules that you access via call label actions, from the main body of 
your rule set.

Labels    A label is simply a name you can add to any line in your rule set. Labels are used by return and 
goto actions (see below) to transfer processing to a different location in the rule set. Labels can appear 
anywhere in the rule set - when calling or going to a label, you can go either forwards or backwards. 
Labels are simply a textual name - you can use any text or letters you wish up to 45 characters in length. 
Labels are the only passive item in a rule set - on their own, they do absolutely nothing, and any match 
conditions they contain are ignored.

Calls and returns    If you have defined a label in your rule set, you can call it at any time by defining a 
rule with the Call label action. If the rule triggers, processing of the rule set will transfer to the first rule 
after the label you name and will continue until either there are no more rules (in which case rule 
processing terminates), or a rule triggers that has the Return from call action (in which case processing 
resumes at the rule following the one which initiated the call).

Gotos    A goto is like a call, in that it simply transfers processing to a label anywhere else in the rule set. 
The difference is that you cannot return from a goto - the transfer of processing is final. Gotos are 
primarily useful when implementing complex logical operations.

Example  
In this example, we will implement a list server where the user can subscribe to lists on your system by 
sending you a message containing the subject line subscribe <listname>: to do this, we look for the word 
subscribe in the subject line, and if we find it, we call a label that handles the list names. Note the use of 
expressions in this example to isolate complex cases.

If data matches expression "Subject: +Subscribe*" then call subscriptions
[… other rules can appear here…]
If data matches "*" then exit from this rule set

Label subscriptions
If data matches expression "*interest-list* then add sender to list "ilist"
If data matches expression "*beta-testers*" then add sender to list "beta"
[… other subscription cases could appear here…]
If data matches "*" then return from call

Some things to note about this example: firstly, notice the way the subject line is detected: the regular 
expression Subject: +Subscribe* detects a line that starts with the letters subject:, followed by one or 
more spaces (the + operator) then the letters subscribe. Note that the Return from call rule matches on a 



single * - this is the way you tell a rule to match on any text, and in this case ensures that the return will 
always be triggered. Finally, notice the use of an Exit from this rule set action to ensure that we don't drop 
into the subscription processing rules other than at the proper times.



Creating logical operations in your rule sets

Often, you may only want to apply a rule to a message if all of a number of conditions are matched, or if 
any one or more of a number of conditions apply. This kind of operation is known as a logical operation (it 
is also known by the technical name Boolean operation). Pegasus Mail implements logical operations by 
a combination of rule order and flow control structures. Before reading about logical operations, we 
strongly suggest you read the section on flow control.

***Tip*** When using logical operations in rule sets, it is very important to remember that rules are always 
applied to the message in the order in which they appear in the rule list editor, starting at the top of the list
and working through to the bottom.

Applying a rule when any of several conditions is met (logical OR)
The simplest logical operation you can create in a rule set is that where an action is applied if one or more
conditions is satisfied (i.e, condition1 OR condition2 OR condition3 and so on). You can create this kind of
operation simply by creating multiple rules matching on different conditions, all executing the same action.
For example, say you want to highlight a message in Magenta in your folder if the subject contains the 
word order, or if the subject contains the word invoice or if the To: field contains the address 
orders@foo.bar.com - you would add the following three rules to your rule set

If "Subject" field contains "order" then highlight message in magenta
If "Subject" field contains "invoice" then highlight message in magenta
If "To" field contains "orders@foo.bar.com" then highlight message in magenta

Notice that the action is the same in each case. In cases where repeated application of the rule action 
might not be desirable (for instance, copying messages to a folder, in which case you could get multiple 
copies of the message), more complex combinations of goto and call statements can be used to achieve 
the same effect - for example, like this:

If "Subject" field contains "order" then goto label "copy message"
If "Subject" field contains "invoice" then goto label "copy message"
If "To" field contains "orders@foo.bar.com" then goto label "copy message"
label "Next label"
[… other rules …]

Label "copy message"
If "Subject" contains "*" then copy message to "orders"
goto label "next label"

In this example, any of the conditions will transfer control to the rule that actually copies the message, 
which in turn immediately transfers control to the first rule after the group, so you will only ever get one 
copy of the message. Note the use of the single asterisk (*) in the copying rule: a single asterisk matches 
any text and in this case ensures that the rule will always trigger.

Applying a rule only if all specified conditions are met (logical AND)
Pegasus Mail offers two ways of applying a rule only if all of a set of conditons apply. The simpler form 
allows you to match exactly two conditions, using the Skip next rule action. To do this, you simply use the 
Skip next rule action on the first rule in the pair if the data does NOT match the first condition, then apply 
the action you want in the second rule only if the second rule DOES match the second condition. For 
instance, in the following example, we want to delete the message only if the subject field contains free 
offer and the from field contains cyberpromo.com.

If "Subject" field does not contain "free offer" then skip next rule
If "From" field contains "cyberpromo.com" then delete message

The more complex approach to matching multiple conditions depends on using a call statement to 
transfer to a group of rules where each rule returns if it does not contain the required text. This approach 



requires more setup, but allows you to match on an unlimited number of conditions. For instance, say we 
want to play a sound when we get a message from anyone at compuserve.com where the subject line 
contains the word Transylvania but not the word vampire, and the To: field contains the address 
foo@bar.com: to achieve this, we would create the following rules in our rule set -

If "From" field contains "compuserve.com" then call label next-test
[… other normal rules are here…]

Label next-test
If "Subject" field does not contain "Transylvania" then return from call
If "Subject" field contains "vampire" then return from call
If "To" field does not contain "foo@bar.com" then return from call
If "Subject" field contains "*" then play sound "tada.wav"
If "Subject" field contains "*" then return from call

Note the use of a single asterisk (*) in the last two rules to match any text: this ensures that the rule 
actions will always be applied. In order to get to the rule that plays the sound, all the rules before it must 
have been matched.



Regular expressions: a regular expression is a description of an expression which permits matching 
based on patterns rather than on exact correspondence. If you have ever used a DOS command like 
"DEL *.BAK" then you have already used a regular expression -- what this command is really saying is 
"Delete all files where the name contains anything and the extension is BAK".

When you compose a regular expression, you use a combination of literal characters which must be 
present (such as the "BAK" in the command above) and special metacharacters (also called wildcard 
characters) which can match varying numbers of characters, or characters in specific groups only. As an 
example, MS-DOS supports two metacharacters - *, which means "match any number of any characters" 
and ?, which means "match any single character in this position".



Options for replies

Pegasus Mail offers you considerable control over the way replies are generated.

The reply dialog has three sections, each controlling a different aspect of the reply. Settings in this dialog 
are "sticky" -- that is, they are remembered from session to session.

Original Message
This section contains controls which determine how much (if any) of the original message is included in 
your reply.

Include original message in reply    If checked, Pegasus Mail will include the text of the original message 
in your reply. Including the text to which you are replying provides a context for the recipient, and is an 
important part of the process of using electronic mail. Pegasus Mail can include a maximum of 31000 
characters from the original message into your reply.

'Comment out' the original text    If checked, Pegasus Mail will attach a visual indicator (usually "> ") to the 
start of every line included from the original message. Doing this creates a clear visual distinction 
between the original message and your text.

Copy original CC field into reply    If you want to send a carbon copy of your reply to the same people who 
received carbon copies of the original message, check this control. Pegasus Mail will copy the first 180 
characters of the original CC address into your reply.

Formatting
This group of controls dictates the visual presentation of your reply.

Reformat line breaks in original    If checked, Pegasus Mail will reformat the included message so that it 
fits within your message editor's default margins. Pegasus Mail attempts to preserve indenting and 
"commenting-out" of the original text, but you may find that tables and other textual elements which 
depend on tabulation may be misaligned when you use this option.

Omit message headers    Pegasus Mail usually includes the most important headers from the original 
message into your reply. If you check this control, it will omit all header information from the reply.

Use custom header line    If you check this control, Pegasus Mail will open another dialog and will prompt 
you for a custom header line, which allows you to create the first line of the reply automatically based on 
information from the original message. The default header line is "On ~D at ~T, ~F wrote:" -- the ~D, ~T 
and ~F characters are special placeholders which Pegasus Mail replaces with the Date, Time and 
Sender's personal name from the original message respectively. The other valid substitutions are ~S, 
which is replaced with the Subject field from the original message and ~A, which is replaced by the 
sender's full reply address. If you want to enter a line break into a custom header, add the substitution ~L 
at the point where you would like the break to occur.Any custom header line you define is remembered 
from session to session, even if you uncheck the control.

Addressing options
The controls in this section allow you to choose addresses from the original message to which replies 
should be sent. Pegasus Mail extracts all the addresses it can find from the headers of the message and 
shows each of them next to a control: checking the control includes that address in the "to:" field of your 
reply. If you leave all controls unchecked, Pegasus Mail has default addressing logic which will produce 
valid addressing in almost all cases. You will typically use these options when replying to mail from 
mailing lists, or if you want to start a new conversation with a secondary recipient of the original message.

Checking the control labelled Address reply to all recipients tells Pegasus Mail to attempt to send your 
reply to every person who received the original message. Because this may entail a large number of 



addresses and individual address fields in Pegasus Mail can only accept 180 characters, Pegasus Mail 
will automatically create a temporary distribution list when you choose this option and will place the name 
of that list as an address in the "To:" field of the reply. Note that because you were a recipient of the 
original message, checking this control means that you will get a copy of your reply mailed to you. The 
setting of this control is not sticky -- it is always reset on each reply.



The Folder Manager Window

See also: Right-click options for folders

When you select Mail folders from the File menu, or click the Folder icon on the toolbar, the Folder 
Manager window opens. This window lists all the folders and trays you have created and can be left open 
on your desktop while you run the program.

Extra options for the Folder manager can be found on the Folders menu

While the Folder Manager is open, you can drag messages from any folder window and drop them onto 
any folder entry it contains. You cannot drag messages onto a tray entry because trays can only contain 
folders and other trays.

When the Folder Manager window is frontmost, you can type the first few characters of a folder or tray's 
name to select it quickly. Pressing <Enter> when a tray is selected will open (or close) that tray, or will 
open a folder's browser window if selected.

Click the New button to create a new folder or tray.

Click the Rename button to change the name of a folder or tray. Note: for trays, you can only change the 
tray's long name using this command -- you cannot rename the DOS file in which the tray's information is 
stored.

Click the Delete button to delete a folder. You can only delete trays if they contain no entries.

Click the Open button to open a folder or tray. You can also double-click on the entry in the list, or 
highlight it and press <Enter> to open it.

Most folders, trays and mailboxes have special options associated with them: to access these special 
options, right-click the entry in the folder manager list.



Right-click options for folders

See also: Mail filtering rules, Identities 

Right-clicking a folder, tray or mailbox entry in the Folder Manager list will present a list of options specific 
to that item.

You can associate an identity with any mailbox or folder by selecting Set default identity for entry from the 
right-click menu. For more information on identities and associating them with folders, click here.

The options Attach folder-open rule set, Attach folder-close rule set will be available when you right-click 
on a folder of any type. These options allow you to associate a filtering rule set with the folder - Folder-
open rule sets are applied automatically when the folder is opened, while Folder-close rule sets are 
automatically applied when the folder is closed. Choosing Detach filter sets from entry will remove the 
association between the rule set and the folder without deleting or otherwise affecting either the rule set 
or the folder - the rule sets will simply no longer be applied automatically to the entry.

The following options are available for folders in the Pegasus Mail v2.x format:

Reindex folder    From time to time, a folder's index file may become corrupt, which can result in errors 
when you attempt to open it. If this happens, highlight the folder and select this command to force 
Pegasus Mail to rebuild the index file. Reindexing will work reliably if the actual messages in the folder are
intact, but may result in the loss of some status information (such as whether or not you have replied to a 
message, or forwarded it). A side-effect of rebuilding a folder is that some deleted messages may 
reappear the next time the folder is opened. You cannot reindex tray entries.

Check consistency    This option attempts to verify that a folder is intact. On rare occasions folder index 
files can become damaged, which can cause problems in long-term use. Pegasus Mail automatically 
invokes this option before recovering deleted message space from folders ("compressing"), but if you 
want to ensure that a folder is intact, you can perform a consistency check manually at any time.

Recover deleted space    When you delete a message from a folder, Pegasus Mail does not immediately 
reclaim the space it occupies; instead, it waits until you have deleted around 20000 characters from the 
folder then recovers all the space in a single pass. This deferred compression improves the performance 
of the program at the cost of some disk space. Select this option to force Pegasus Mail to recover the 
space from a folder immediately. Compression is always a safe option and does not result in the loss of 
anything other than deleted information. You cannot compress tray entries.

Close all open trays    Select this option and Pegasus Mail will “flatten” your folder hierarchy so that only 
the top level is visible in the Folder Manager window.



The Folders Menu

The Folders menu is available on the menu bar when the folder manager window is the current window. It
contains less-frequently used options for managing your folders.

Add mailbox to list:    This command allows you to add another mailbox to your folder view. You will be 
prompted to enter a directory or a username which Pegasus Mail should use to locate the mailbox. It will 
then proceed to add that mailbox as a root entry in the Folder Manager window, and will add any 
recognizable mail folders from that location into that root entry. Mailboxes added to the Folder Manager in
this way are just like your own mailbox - you can read messages, create folders, move messages around 
(including between mailboxes) and so on.

Examples of uses for this command include:
* Secretaries who need to access the boss's mailbox while he's away on business
* System administrators who need to troubleshoot a user's mailbox
* Accessing folders from another mail program, such as Eudora (Pegasus Mail can read the unix folder 
format used by Eudora), so you can migrate messages from one to the other.
* Accessing two mailboxes when you use a laptop and can be both attached to a LAN in NetWare mode, 
and regularly using your laptop in standalone mode on the road.

Close all open trays:    Reverts the Folder Manager window to its initial state, by closing any trays and 
mailboxes you may have opened. This command only alters the view of your hierarchy - it does not close 
any folders you have opened on your desktop.

Open all trays:    Expands the Folder Manager's view of your hierarchy so that every folder you have is 
visible.

Quick open:    allows you to configure your Quick-Access Folders.

Font:    Allows you to select the font which should be used to display entries in the Folder Manager's list 
view.



A tray is a specialised type of folder which can contain other folders or trays, but not messages. A tray is 
just like a subdirectory on your hard disk -- it can contain files and other subdirectories, but does not 
contain data of its own. You can use trays to create a hierarchy within your folder structure -- to keep 
folders on related topics together in one place.

There is no limit to the depth of a tray hierarchy, but you will generally find that three to four trays deep is 
a reasonable maximum for easy management.

Organizing your mail folders in a hierarchy can make your mail easier to find and can result in 
considerable performance improvements in the program when it has to list or open your folders.



MIME (Multi-purpose Internet Mail Extensions)
MIME is an Internet standard for the transmission of data of any type via electronic mail. It defines the 
way messages should be formatted and constructed and has provision for indicating the type and nature 
of the contents of a message, and for preserving international character set information. In most cases, a 
MIME message can be read correctly on any kind of system which has a MIME-compliant mail program.

MIME provides direct support for graphic images in GIF and JPEG format, Video images in MPEG format,
and Audio data as well. It also has a Digest format for sending multiple mail messages at once (Pegasus 
Mail displays MIME digests in a manner very similar to a folder).

Pegasus Mail will automatically handle incoming MIME messages without any intervention from you. The 
decision over whether it should generate outgoing messages in MIME format is yours -- to enable MIME 
features, click the control in the Special view of the message editor. Once checked, the setting will be 
remembered for all subsequent messages. The only reason you would not use MIME formatting for 
Internet mail would be if you knew your correspondent did not have access to a MIME-compliant system.

MIME is described in the Internet Standards Document RFC1521.



Troubleshooting

At some stage, things will probably go wrong -- there's no escape from Murphy's Law. This section lists 
the most common problems and solutions known to us at the time of release of this version of the 
program. See the next section, Technical support for information on how to obtain the most up-to-date 
lists of common problems and solutions.

READ THIS FIRST!!!
Pegasus Mail and the Novell NetWare environment
Pegasus Mail and Windows 95
Pegasus Mail and WINSOCK.DLL
"Cannot create container file" errors
International character set problems
Other problems



Murphy's Law:    "Anything that can go wrong, will go wrong".
There's also Parkinson's Law -- "Work expands to exceed available time".

Forget Einstein -- these are the laws that REALLY govern the universe.



First steps for troubleshooting

It has been our repeated experience that the vast majority of problems people have with Pegasus Mail fall
into three categories, none of them actually to do with the program itself:

1: Configuration problems    more than 80% of all problems reported to us result from simple 
misconfiguration of the system. Pegasus Mail doesn't require a great deal of configuration, but it is 
important that the configuration it does require be done correctly. Always read WGUIDE.HLP carefully, 
especially the "Important information" and Installing Pegasus Mail" sections.

2: Problems with other people's software    this is particularly true with WINSOCK.DLL, because the 
quality of available WINSOCK implementations varies widely. If your problem results in a GPF (Windows-
speak for a crash), check the report Windows generates carefully - it will say something like "PEGASUS 
MAIL caused a GPF in module XXXXXX"; the actual cuplrit is whatever is named in XXXXXX: if it is the 
name of a DLL, especially WINSOCK.DLL, then your problem almost certainly is not in Pegasus Mail but 
in a third-party product.

3: System problems    some very common problems can be caused by incorrectly installed network 
drivers, by marginal hardware (this is especially true of modems), or by running in environments with too 
little disk space or memory. In the network environment, incorrect or inadequate trustee and access rights
can also cause innumerable problems. Always check these external influences before assuming that 
Pegasus Mail itself is at fault.

Finally, if Pegasus Mail is producing an error message, please read it carefully! Very often, the solution to 
the problem will be shown in the message itself.



WGUIDE.HLP is the Pegasus Mail online guide. It is a Windows Help File supplied in the original 
Pegasus Mail archive you retrieved. If you ran Pegasus Mail's setup program to install it, WGUIDE will 
appear as an icon in the "Pegasus Mail for Windows" group created by setup. When you double-click it, it 
will display a menu of topics about installing and using Pegasus Mail.



Pegasus Mail and the Novell NetWare environment

How can I stop Pegasus Mail from running in "NetWare mode"?
You can force Pegasus Mail to run in standalone mode (ie, to ignore the connection to the NetWare 
server) by changing the command line you use to run the program to:

WINPM-32.EXE -A
This commandline switch also works for the DOS version of Pegasus Mail.

Pegasus Mail tells me it can't find my home mailbox, but it's there!
There are three possible causes for this problem:
[*] 1: You may be running Windows in Standard mode while connected to a NetWare server, and your PC 
is using the Novell NETX shell set. This combination will provoke a bug in the NetWare API libraries, 
especially if your machine is a 286. The only solution is to move to the VLM shell set or to step back to 
Pegasus Mail 1.02 (which uses an older API set).
[*] 2: If you are running in standalone mode (not connected to a NetWare server), your standalone 
configuration might be incorrect - the most likely cause is an invalid path in either the home mailbox or 
new mailbox fields in PCONFIG. Try deleting the file PMAIL.CFG in the directory where PEGASUS 
MAIL.EXE is located and re-entering the values the next time Pegasus Mail starts up.
[*] 3: You may be running under NetWare 4.0x in a directory services context which is not the Bindery 
Context. Pegasus Mail is a Bindery-based NetWare application and requires information from the 
NetWare Bindery, which is poorly emulated under NetWare 4.0x. The only solution is to have your 
usercode moved into the Bindery Context.

Pegasus Mail runs in standalone mode even though I'm connected to a NetWare server
Windows reports "Cannot find NETWARE.DLL" when starting Pegasus Mail
You probably have not installed NetWare support into your copy of Windows. Run the Windows setup 
program and see what Network it thinks you are using; if it says "None", choose "Novell NetWare" and 
insert the disks it asks for. You should also make sure you are using the most recent NetWare drivers 
from Novell. The "Cannot find NETWARE.DLL" message is an error in Windows - there is no 
"NETWARE.DLL" - it is looking for NETWARE.DRV.

Windows, The "Black Screen of Death" and broadcast messages
If your copy of Windows crashes with the "Black Screen of Death", or your system locks up or behaves 
erratically when you receive the broadcast "New mail" notification messages Pegasus Mail generates, 
then you almost certainly have a NetWare Shell problem. Make sure you are using the absolute most 
recent driver files from Novell (see the preceding entry for details on getting these) and take particular 
care to delete all old versions of these files (especially NWPOPUP.EXE and NETWARE.DRV) right across
your DOS path.



Pegasus Mail and Windows 95

I'm running Windows 95 and getting GPFs in NWCALLS.DLL
There is a bug in Windows 95's NetWare emulation such that it reports a server connection even when 
there is none actually available. You can fix this easily by forcing Pegasus Mail to start in standalone 
mode by adding the switch "-A" to its command line.

My Windows 95 users can't send mail via Mercury - it gets returned with a "missing $$ signature" 
diagnostic.
There appears to be a severe bug in the Windows 95 NetWare Queue Services emulator which means 
that the first four bytes of jobs written directly to queues by programs will be corrupt. The only workaround
I have been able to find for this is to switch Mercury and Pegasus Mail into Mercury's spooler submission 
mode instead of queue mode. This problem may also affect Windows NT v3.51 users, because that 
system appears to use the same Queue Services code with the same bug.

I'm trying to use the Microsoft WINSOCK.DLL supplied with Windows 95 but am having connection 
problems.
This, and variants of it, are usually attributable to having WINSOCK.DLL files other than the Microsoft 
version on your system. This is particularly likely to happen if you have upgraded to Windows 95 rather 
than doing a fresh install. Hunt through your system making sure that there is only one copy of 
WINSOCK.DLL present and that it is the Microsoft offering.



Pegasus Mail and WINSOCK.DLL

The quality of Windows Sockets implementations currently available for Windows seems to be extremely 
variable, so if you have problems with WINSOCK- based mail in Pegasus Mail, please check first that you
have the current version of your WINSOCK.DLL and any support software, and that it's correctly 
configured.Next, if you are getting connection problems, try expressing the address of the host to which 
you want to connect using dotted IP notation instead of an address (or vice-versa).

Many problems using WINSOCK across slow SLIP or PPP links arise from timeouts being set too short - 
set a much longer timeout value in your network configuration screen in these cases (I recommend up to 
120 seconds).

Pegasus Mail v2.0 and later uses "non-blocking sockets" to obtain the greatest level of control of TCP/IP 
communications. Some WinSock implementations do not handle non-blocking sockets well. If your 
WinSock implementation has problems connecting with Pegasus Mail, or if performance is erratic, try 
changing the command line you use to run Pegasus Mail to:

WINPM-32.EXE -Z 1024
This will force Pegasus Mail to use blocking sockets, at the price of lower performance and possibly 
occasional conflicts between POP3/SMTP and TCP/IP-aware Pegasus Mail extensions.

I don't get the Network Configuration or other WinSock-based entries on the File menu
[*] Pegasus Mail may be unable to find WINSOCK.DLL - make sure it is on the path, in \WINDOWS, or in \
WINDOWS\SYSTEM. On some systems, especially Windows NT, you may find you have to force 
Pegasus Mail to "Blind load" WINSOCK.DLL -- you do this by changing the command line you use to run 
Pegasus Mail to:

WINPM-32.EXE -Z 128
[*] You may have the Winsock loading field in your Advanced settings preferences dialog in Pegasus Mail 
set to Never. Set it to On demand or Always then exit and restart the program.

Some people are trying to reply to my POP3 server address, which isn't a valid address to the outside 
world, but I've set a proper From field value in the Advanced Configuration Options dialog - why is 
Pegasus Mail still using the wrong address for me?
There is unfortunately a small group of mail systems on the Internet that attempt to derive your reply 
address from a specialised and rarely-used field in the message called "return-path". The "return-path" 
field is formed according to special rules by Pegasus Mail, using an approach that attempts to provide the
greatest reliability in the widest number of systems, but inevitably there are going to be some cases 
where you need to work another way. If you encounter this problem, check the control labelled Use this 
from field to form the SMTP envelope in the Advanced Configuration Options dialog of the Network 
Configurastion dialog.

Pegasus Mail reports "Invalid password" when I connect to my POP3 server, but I've double-checked and 
the password is right.
[*] The password may be right, but your username may not be (for security reasons, most POP3 servers 
will accept any username and fail the password automatically if the username is invalid). The most 
common cause of this is putting a full address in the "username" field of the Network Configuration 
dialog's POP3 section. If you can see an '@' symbol in this field, then it's wrong - Pegasus Mail only 
wants your basic username, which is everything preceding the '@' in your address.

I'm trying to use the Microsoft WINSOCK.DLL supplied with Windows 95 but am having connection 
problems.
This, and variants of it, are usually attributable to having WINSOCK.DLL files other than the Microsoft 
version on your system. This is particularly likely to happen if you have upgraded to Windows 95 rather 
than doing a fresh install. Hunt through your system making sure that there is only one copy of 
WINSOCK.DLL present and that it is the Microsoft offering.

I'm trying to use the 32-bit Microsoft WINSOCK.DLL supplied with Windows 95 but it won't autodial when 



Pegasus Mail loads it..
This appears to be a problem in the 32-bit WINSOCK.DLL itself - as far as we have been able to 
determine, the 32-bit version will not autodial if loaded by a 16-bit application such as Pegasus Mail. At 
the time of release we are taking this issue up with Microsoft.

How can I prevent Pegasus Mail from autoloading WINSOCK.DLL?
Pegasus Mail has built-in support for a variety of e-mail protocols using the TCP/IP networking protocol. 
To provide this support, it looks for a file called WINSOCK.DLL when it starts up; WINSOCK.DLL is a file 
supplied by your TCP/IP vendor which provides a standard interface to TCP/IP network services for 
Windows programs. If you do not want Pegasus Mail to load this file (and hence not to provide access to 
its built-in mail TCP/IP mail services), do one of the following:
[*] Prior to running Windows, enter the command "SET WINPMAIL=1" from the DOS prompt. You cannot 
do this from a Windows DOS session - you must do it prior to running Windows
[*] Change the command line the Program Manager uses to run Pegasus Mail so that it includes the 
switch "-Z 1". You can use this switch with all other switches in the program.
[*] Go to the Advanced settings preferences dialog in Pegasus Mail and set the Winsock Loading field to 
Never.



"Container file" errors and what they mean

One of the most common errors you may see from Pegasus Mail is a message saying:

      Pegasus Mail has failed creating the container file for a message

This is also one of the harder error messages to diagnose, but in general it means that Pegasus Mail has 
attempted to create a file for delivery and the operating system has reported a failure on the operation. 
The most common causes for this problem are:

[*] (In NetWare mode) This message can indicate several things:
* You may be out of disk space on the file server volume where the recipient's mailbox is located (or the 
submission directory if you are sending mail via Mercury)
* You may have insufficient rights in the destination directory
* The destination directory may not exist (this can happen on NetWare 4.x servers running in Bindery 
Emulation mode when the recipient has never logged into the server, because NetWare 4.x only creates 
the user's SYS:MAIL mailbox when he or she logs in the first time).
* If sending mail between servers, this may indicate an error in the configuration of the inter-server 
delivery account created for Pegasus Mail's use, usually a password or connection restriction, or a lack of
rights in the destination server's SYS:MAIL directory.

[*] (In standalone mode) You may have addressed the message to a local user who does not exist. 
Because Pegasus Mail can manage multiple users on the same machine, if you enter an address like 
"david", or "betty" - namely, an address with no domain portion - Pegasus Mail will assume it refers to a 
user on your own machine and will try to deliver it locally. If you have no users other than yourself on your
machine, you may want to set the "Use for all outgoing mail" flag in the Network configuration dialog - this
tells Pegasus Mail that there are no local users and to send everything via the SMTP transport.



International character set problems

Pegasus Mail users in countries where English is not the primary language will often run into problems 
using accented characters in electronic mail. Problems with accented characters are not a sign of 
ignorance or carelessness on the part of Pegasus Mail's developer (who studied French for 11 years and 
German for 5) -- rather, they reflect a very general problem with computers in that there is very little 
standardisation on character sets and the way they are represented.

The first thing to do to improve the situation is to turn on Pegasus Mail's MIME support - MIME goes a 
long way towards dealing with International character set issues. Enable MIME support by checking the 
control in the Special view of the message editor.

You can customize the character sets Pegasus Mail uses for MIME messages by creating and compiling 
a file called WPM-LMTT.RSC, and placing it in the same directory as WINPM-32.EXE. A sample source 
file for this resource, called WPM-LMTT.R, is supplied in the RESOURCE\ subdirectory of the directory 
where you installed WINPM-32.EXE - examine it for details of the formatting required.

For non-MIME messages it is impossible to preserve 8-bit data accurately in any meaningful way -- when 
sending non-MIME mail, Pegasus Mail will always convert accented characters to non-accented ASCII 
equivalents; this process is required by the Internet mail standard, RFC822, and cannot be subverted. 
You can customise the conversion process Pegasus Mail applies to your accented characters by 
providing a WPM-CHAR.RSC file in the same directory as WINPM-32.EXE. As with WPM-LMTT.RSC, 
this file is compiled from source you provide, and a sample WPM-CHAR.R file is provided in the same 
location.



Other problems

The .WAV file I have chosen as a new mail alert sound doesn't work
By default, the new mail alert sound only works when Pegasus Mail is minimized on your desktop.
[*] If you would prefer the alert sound to play any time new mail arrives, add the switch "-Z 512" to the 
Pegasus Mail command line.

I have some users whose preferences don't get saved properly between
Pegasus Mail sessions
Pegasus Mail only saves your preferences when it believes they have changed during the session - 
sometimes it may fail to detect changes.
[*] You can force Pegasus Mail to save your preferences by holding down the Ctrl key while selecting 
"Exit" from the file menu.
[*] This can also happen when user has no rights to read or write files in the temporary directory specified 
in the TEMP or TMP environment variable, or in the "Temporary files directory" setting in the user's 
PMAIL.INI configuration file.

Why can't I see some of/all the mail folders I created using older versions of Pegasus Mail?
Pegasus Mail supports hierarchical foldering using "trays", or containers in which folders can be placed. 
When it first runs, Pegasus Mail creates a file called MAIN.PMT which is your main tray and contains all 
the folders it can find in your home mailbox: from this point, it uses the file to maintain your hierarchy. If 
you create a folder using an earlier version of Pegasus Mail after you have run this version, the new folder
will not be added to the hierarchy file and Pegasus Mail will not be able to see it.
[*] Solution: run Pegasus Mail, and press <^L> to select a folder; choose "Check tray list"from the Folders 
menu. This instructs Pegasus Mail to look for any folders which might be missing from your hierarchy and 
add them to it.

How can I stop Pegasus Mail from running in "NetWare mode"?
You can force Pegasus Mail to run in standalone mode (ie, to ignore the connection to the NetWare 
server) by changing the command line you use to run the program to "WINPM-32.EXE -A". This 
commandline switch also works for the DOS version of Pegasus Mail.

Why do all my folders and other mail files appear twice in Pegasus Mail?
If you can see two entries for each DList, Folder, Addressbook or other Pegasus Mail file when you try to 
select one, and one is in blue, then you have probably installed PEGASUS MAIL.EXE in the same 
directory as your home mailbox (as opposed to using the recommended installation); this causes 
Pegasus Mail to see every file as both personal and system-wide, and to list them twice.
[*] Solution: Move WINPM-32.EXE, WINPM-32.DAT, W32NW3/4.DLL (if you are
on a NetWare system) PMAIL.CFG (if you are running on a standalone system) and WINPM-32.HLP into 
another directory.

My new mail folder doesn't open at startup even though I have the option checked in my preferences.
Pegasus Mail originates from the LAN world and is still far and away most heavily used there; in that 
environment, most users prefer to have the new mail folder open automatically only if there is actually 
new mail to display. This option is less useful for standalone users so a fix is provided.
[*] Solution: Add the switch "-Z 256" to the Pegasus Mail command line (in the Program Manager Icon you
created for it). This will force the new mail folder to open irrespective of its contents.



Technical support, manuals

Your first port of call for technical support for Pegasus Mail is WGUIDE.HLP and this help file. The 
answers to most questions can probably be found in these two files, especially in the Troubleshooting 
section on the Pegasus Mail help menu.

If these resources don't turn up the answer for you, send a mail message to the Internet address 
support@pmail.gen.nz. This will retrieve an automatic reply listing all the available sources of help, 
including regularly-updated frequently-asked-question lists (FAQs), addresses for support mailing lists, 
and direct mail addresses for the program's author.

Finally, printed manuals are available for Pegasus Mail at very reasonable prices. We don't guarantee 
you'll find the answer to every problem in the manual, but it is a handy, complete reference to the 
program. Manual purchases are totally optional - there is no pressure or obligation for you to purchase 
manuals: Pegasus Mail is provided as a free service and our primary objective is not the accumulation of 
money. We want you to enjoy using the program and benefit from the capabilities it offers you, and if you 
do not feel you need a manual to increase your enjoyment then that is the best compliment we could ask 
for. Information on ordering manuals can be found in WGUIDE.HLP and a copies of the order forms are 
contained in the files SU-ORDER.FRM and ORDER.FRM in the directory where you installed Pegasus 
Mail.

If you have licensed a Pegasus Mail manual set, you can get direct technical support (from a real person) 
by sending your request to tech-support@pmail.gen.nz, making sure you quote your manual license 
number in the Subject line. Tech support from this account is dependent on our current workload.



Using Drag and Drop in Pegasus Mail

Pegasus Mail makes heavy use of Drag and Drop - picking something up by holding down the left mouse 
button, dragging it to where you want to use it, then dropping it by releasing the mouse button. You can 
perform the following actions via drag and drop:

You can drag addresses from any Addressbook, from the Local User List, from the MHS Directory 
Service, from the Distribution List Manager window or from the Logged-in user list to any address or text 
field in the program.

You can move messages from any folder window to any other folder window (even minimized on the 
desktop), or to a folder entry in the Folder Manager list. Holding down the Alt key while you drag the 
message will copy it instead of moving it.

You can rearrange the folders in your Folder Manager window by dragging them and dropping them in the
location where they should appear.

You can copy an addressbook entry from any addressbook to any other addressbook by dragging 
between them. Holding down Alt while you drag the entry will move the entry from one book to the other 
instead of copying it.

You can drag messages from any folder window to any addressbook (even minimized) and Pegasus Mail 
will create an addressbook entry based on the information in the message.

You can drag a message from any folder window to any message editor field and Pegasus Mail will paste 
the contents of that message into the message you are editing at the cursor position, prompting you for 
the portion of the message it should copy.

Finally, you can drag any file from the File Manager and drop it onto the minimized Pegasus Mail icon and
it will do one of two things: if the frontmost window within Pegasus Mail is a message editor window, 
Pegasus Mail will add the file as an attachment to that message; if the frontmost window is not a message
editor, Pegasus Mail will begin a new message with the file added as an attachment.



Quick Folders

Pegasus Mail lets you define up to six Quick Folders that you can access with a single keystroke from the
Folder Manager window and when browsing the contents of a folder.

To define your Quick Folder settings, choose Define quick folders from the Quick copy/move submenu of 
the Folder menu (if you are browsing a folder), or from the Quick open submenu of the Folders menu (if 
you are working in the Folder Manager's window). You will be presented with a dialog containing six 
entries that look like this:

Click the large button to select the folder which you want to associate with each quick folder entry. The 
folder's long name will appear next to the button once you have selected it. The Move and Copy radio 
buttons allow you to choose whether any messages you have selected while browsing a mail folder 
should be moved or copied into the quick folder when you activate it. You do not have to define all the 
Quick Folders in the dialog - you can define as few or as many as you wish, and you can define them in 
any order.

To use a Quick Folder definition, either select it from the submenu in the Folder or Folders menus, or hold
down the Ctrl key and press the number of the Quick Folder you want to access. If the Folder Manager 
window is frontmost, this will open the Quick Folder; if a mail folder is the frontmost window, any 
messages selected in it will be moved or copied to the quick folder, depending on you Quick Folder 
settings.

If you want to be able to perform moves or copies into quick folders while browsing a folder simply by 
pressing the number of the Quick Folder (i.e, without having to hold down the Ctrl key), check the control 
labelled Allow activation without pressing Ctrl when in folder windows at the bottom of the definition 
dialog.



Configuring Pegasus Mail

Pegasus Mail configures itself automatically for use in the Novell NetWare environment, but when running
in other environments requires a small amount of information the first time it runs. The information you 
give it will determine how it operates for you and depends on how you plan to use the system.

Single user configuration
One user on this computer and only one address.

Multi-user configuration
More than one user on this computer, or if
 you have more than one address.

Network configuration
For multiple users on non-NetWare networks.



Single user configuration

Click the single user button in the configuration dialog if there will only ever be one person with a single e-
mail address running Pegasus Mail on this computer. This is the simplest configuration option - if you 
select it, Pegasus Mail will simply ask you for the name of a directory on your computer where your mail-
related files should be stored.

The name of the directory you enter must be a full path (for example, "C:\PMAIL\MAIL"). If you use a 
partial path (such as "MAIL", "..\MAIL" or "C:MAIL") you may run into unpredictable problems later on. You
do not have to enter an existing directory path: Pegasus Mail will create all or any portion of the path you 
enter as required.

You should not use the directory where you have installed WINPM-32.EXE as the mailbox directory you 
enter here - if you do, you will see two occurrences of all your mail-related files, such as folders and 
distribution lists. This is because Pegasus Mail regards any files of these kinds which it finds in its 
installation directory as system wide files, and thus presents them to you twice - once as your own files 
and once as system-wide entries.



Multi-user configuration

Click the multi-user button if you want to allow more than one person to use Pegasus Mail on this 
computer, each having different mailboxes and preference files. In multi-user mode, Pegasus Mail will 
prompt for a username when it is run, or the -I command line option can be used to create an icon which 
will start the program with the proper user information. You can also use this option if you send and 
receive mail using more than one e-mail address, by creating a separate user account for each address.

When you select this option, Pegasus Mail will ask you for a path to the directory where it should create 
and look for user mailboxes. The path you enter must be a full path from the root of a drive and should not
end in a trailing '\' character. The path need not exist - Pegasus Mail will create it for you if required.



Network configuration

Click the network button if you want to use Pegasus Mail on a network for which it does not have explicit 
support, such as LANtastic or Windows for Workgroups. Running in network mode differs from multi-user 
mode only in that the path you enter for the new mailbox locations must exist on a shared volume 
available to all mail system users. Pegasus Mail will wait while you mount the volume you want to use and
then will proceed with a regular multi-user installation.

Considerations for network use

* The shared drive on which the mailboxes are located must be mounted before you run Pegasus Mail - 
Pegasus Mail will not mount it for you.

* All users must be able to access the shared volume using the same drive letter. If your network supports
the UNC path format (i.e, \\SERVER\VOLUME\PATH) then you can enter the path using this format 
instead of a path based on a drive-letter.

* On some networks where the file server is actually a user's workstation (for instance, Windows for 
Workgroups) you may find that the user running on the file server cannot see the shared volume using the
same drive letter as other users on the network - for example, the file server's C: drive may be visible to 
other users on the network as drive K:. If this is the case, you will have to create an alternate 
configuration file for that one user. To use an alternate configuration file, you must start Pegasus Mail with
the command line

WINPM-32.EXE -e <filename>

filename must have no path component and may have 11 characters or fewer. It will be created in the 
same directory as WINPM-32.EXE, so you must have write access to that directory when creating an 
alternate configuration. When creating an alternate configuration to cover a file server user, you should 
enter the path to the same mailbox location as your other users, just using the local path notation instead 
of the network path specification; otherwise, proceed with the configuration exactly as you did for your 
regular users.

If your network supports access control rights, then you can increase the security of the mail system by 
granting users all rights to their own mail directory but only sufficient rights to create files in all other users
mail directories.



Command-line options

Pegasus Mail is able to run in a very wide range of environments using a wide variety of message formats
and transports. This versatility means that the program has a very rich selection of configuration options 
(as you can see by looking through the various preferences screens in the program). Some of the more 
specialised configuration options, as well as options for sending mail automatically, are accessed by 
passing parameters to the program on its command line. The command line is a set of parameters which 
the Windows Program Manager can pass to Pegasus Mail at startup, and is part of the Properties of the 
icon you create for Pegasus Mail. To change the commandline for Pegasus Mail, select its icon in the 
Program Manager and press <Alt+Enter>, or else choose Properties from the File menu.

Pegasus Mail for Windows recognizes the following commandline options: where an option has a 
parameter, you must place a space on the commandline between the option and that parameter.

Message submission options (sending mail from the commandline)
-T <address>
Specify the primary addressee of the message
-F <filename>
Specify the file which should be sent as the body of the message
-B (no parameter)
If present, indicates that the file is binary and should be attached.
-C <address>
Specify Carbon Copy (CC:) recipients of the message
-S <"Subject">
Specify the message subject (must appear in quotes)
-J <filename>
Advanced job submission

Run control options
-A (no parameter)
Forces Pegasus Mail to run in standalone mode, ignoring any NetWare connection.
-R <filename>    Load and run a Pegasus Mail extension (plugin) as soon as the program has finished
starting up. This is a handy way of starting an extension automatically on a one-off basis.
-V <keyword=parameter>
Define an entry in Pegasus Mail’s environment table. This has the same effect as defining the variable in 
your AUTOEXEC.BAT file using the SET command, and is primarily useful for specifying things like the
noticeboard directory, or values that can be substituted into User-Defined Gateway commandlines.
-P <server>
Forces Pegasus Mail to use a NetWare Bindery connection to the specified server. You must already have 
a valid attachment to the server. Use this option if you regularly connect to more than one NetWare 3.x 
server.
-U <username>
"Become" another user for the duration of the session. In NetWare mode, you must belong to a group 
called BECOME to be able to use this flag, and must have proper rights to the target user's mailbox and 
new mail folder on the file server.
-I <username>
Specify your standalone identity on the commandline. This flag only operates in standalone mode (it is 
ignored in NetWare mode) and differs from -U in that you are not actually becoming another user - you 
are simply identifying yourself, so Pegasus Mail takes fewer security precautions against mail forgery.
-ID <Identity>



Specify an identity that Pegasus Mail should switch to automatically on startup.
-O (no parameter)
Enter offline mode. In offline mode, Pegasus Mail will ignore all commands or situations in which it 
might normally initiate a check for new mail using its built-in TCP/IP mail transport. This effectively 
allows you to use the program as if you were connected to your service provider without actually 
establishing a connection.
-E <filename>
Instructs Pegasus Mail to use an alternate standalone configuration file: by default, Pegasus Mail looks 
for a configuration file called PMAIL.CFG in the directory where it is installed to find its standalone 
configuration information. This option allows you tell it to use an alternative filename, although the 
filename you give must have no path attached to it and the file must still reside in the same directory as 
WINPM-32.EXE. This option is ignored in NetWare mode.
-Q <address>
If your WSOCK32.DLL has a defective gethostname() function, you may need to specify the address 
of your machine on the commandline using this option. Pegasus Mail must know the name or address of 
your own machine in order to be able to start a mail transaction when sending mail - usually it can get this
information    by asking your WSOCK32.DLL, but some WinSock implementations are faulty in this area.
<address> should be either your machine's Internet domain name if you have one (example: -Q 
calliope.pmail.gen.nz) or else a dotted IP address for your machine (example -Q 
192.156.225.64). If you are using a SLIP or PPP connection where your IP number is assigned 
dynamically and hence is not known in advance, then you may find that you can get things working either
by using the address -Q 0.0.0.0 or by using a fictitious name - something like -Q unknown. You 
should usually only use this option when you get an error from Pegasus Mail specifically advising you to 
do so. If you need to use this commandline option, you should immediately get in touch with the supplier 
of your WSOCK32.DLL and ask if they have a version where gethostname() works correctly. If they 
cannot supply an updated version that works properly, you should consider moving to a different 
WSOCK32.DLL.
-W <path>
Allows you to force Pegasus Mail to use a specific WINSOCK.DLL file instead of using the standard 
Windows search algorithm to find it. Handy if you have multiple WINSOCK implementations installed, 
or if you need to use one which cannot be found by the standard Windows search mechanism.
-X <language code>
Specify an internationalization module on the commandline. <language code> should be the two-letter 
code for the module you want to use - for example DE for the German module.
-Y <filename>
Specify an alternative name for the Pegasus Mail User Preferences file, PMAIL.INI. This switch tells 
Pegasus Mail that it should read and save all preferences information in the file you give, which must not 
have a path associated with it (it must be a simple filename). This is mostly useful if you run Pegasus 
Mail from two different machine with different screen resolutions, since it allows you to define settings 
specific to each machine.

-Z: The feature control flag

The -Z flag is used to enable a number of special case options within Pegasus Mail, and you will not 
normally need it in day to day use. The parameter to the -Z flag is created by adding together values from 
the following list:

1 Never load WINSOCK.DLL (disables the built-in POP3 and
SMTP mailing code).

2 Do not save the widths of columns in folders between sessions
4 Don't send NetWare Broadcast delivery notifications



16 Force the use of MIME encodings in noticeboards
32 Enter TCP/IP debugging mode
64 Use "From field" value to form the SMTP envelope address
128 "Blind load" WINSOCK.DLL - do not attempt to locate it first.
512 Play new mail alert sound any time new mail arrives

(the sound usually only plays when minimized)
1024 Use blocking sockets; may be needed for some

defective WINSOCK implementations.
2048 Allow multiple instances of the 32-bit version of Pegasus Mail

to run at the same time on different mailboxes (use with care).
4096 Use blocking WINSOCK Name Resolution calls; may be

needed by some defective WINSOCK implementations.
16384 Update the new mail folder with each new message as it

is downloaded using the POP3 protocol.
32768 Use DOS-compatible character conversions on 8-bit data

(note that this switch has a reversed meaning from its
meaning in previous versions of Pegasus Mail)

65536 Use simplified drive detection code. Use this switch under
OS/2 and Windows 3.x if you find that Pegasus Mail
crashes when you try to save attachments to disk or
add attachments to messages.

131072 Do not start the Internet Setup Wizard for first time
users even if a valid WINSOCK.DLL is detected.

Other values are reserved and should not be used.



Advanced Job Submission

The most powerful way of submitting mail automatically to Pegasus Mail is via the -J command line 
option. The parameter to this commandline option should be a file formatted using Pegasus Mail's 
reloadable queue format - the same as is generated by the built-in TCP/IP transport and when you save a 
message as a draft. An RQF file is a rigidly-formatted text file using the following structure.

Line 1: A title line. This is ignored when using the -J option, but must be present.

Line 2 .. Line x: A sequence of header lines. Header lines consist of two characters, followed by a colon, 
followed by a data item of arbitrary length. Absent fields default to 0 or an empty string. The following 
header lines are recognized by Pegasus Mail (numbers in brackets indicate maximum field length for 
strings, or permissible values for integer types):

TO: The message's "To:" field (256)
SU: The message's "Subject:" field (65)
RE: The message's "Reply-to:" field (65)
CC: The message's "Cc:" field (256)
BC: The message's "BCc:" field (256)
EN: Whether or not to encrypt the message (1/0)
CS: Whether to keep a copy-to-self (1/0)
RC: Whether to request confirmation of reading (1/0)
FL: Message flags (currently not used)
DC: Whether to request confirmation of delivery (1/0)
UR: Whether or not to set the urgent flag (1/0)
SS: Whether to omit the message signature (1/0)
NB: Whether the message is destined for a noticeboard (1/0)
EX: Tagname of selected encryption module (12)
TN: Tagname of Extension that generated the message (12)
8H: Pre-formatted special RFC822 header to add to message
MH: Pre-formatted special MHS header to add to message
FI: If present, transmission is in the file named (65)
KY: Encryption key (48)
!M: Message width (20 < x < 254)
!T: Tab width (0 < x < 20)
RT: The message contains rich-text data (2/1/0)
AT: An attachment. The format for this field is:

<filename><,><attachment_type><,><encoding><,><original_name>
Note that no parameter may be omitted, spaces are significant and no parameter may contain a 
comma. "Encoding" specifies the encoding method for the attachment - in almost all cases it 
should be set to 0 to allow Pegasus Mail to select the most appropriate method. "original_name" 
is the real name for the file (the assumption is that "filename" may be a temporary file created for 
mailing only). "Attachment_type" can be any string but should usually be selected from the list of
available types in Pegasus Mail.

Line x + 1:    Exactly one blank line indicating end of headers / start of message

Line x + 2: .. End of file: Message text if no FI: header was specified.



Hint:    For an example of the layout of one of these files, prepare a message within Pegasus Mail turning 
on every message option, then save it as a draft and examine the .PMO file that gets created in your home 
mailbox.



Managing users

When running in multi-user mode, or on a non-NetWare network, Pegasus Mail maintains user mailboxes 
in a single directory you choose the first time you run the program. You can create as many users as you 
wish for the system, each user having his or her own preferences files, mail folders, address books and 
so on. This versatility can also be useful for a single user who wishes to maintain multiple separate mail 
addresses.

The first time Pegasus Mail runs in multi-user mode, it will bring up the user management dialog to allow 
you to create an initial set of users for the system. At any future time, any user designated an 
administrator can also select Manage users from the Addresses menu to add, remove or edit the details 
of mail system users.

Mail system users have three characteristics:

* A username:    A mail system user's username consists of eight or fewer letters or numbers and acts as 
that user's local mail address - that is, the address other mail system users will enter into Pegasus Mail to
send mail to that user. The username is also the name of the mailbox directory Pegasus Mail will look for 
in your installation directory. All users must have a username, and every username on the system must 
be unique.

* A personal name:    A user's Personal name is a descriptive tag which appears in the local users list in 
Pegasus Mail. It is usually simply the user's first name and surname, but the exact format is up to you. 
Every user must have a personal name. The only restriction on a personal name is that it may not contain
a semicolon character (";").

Administrative privileges:    A user with administrative privileges may add and delete users within the mail 
system and may change any user's details. If you are running on a system which actually has a privilege 
structure of its own, then administrative users must also have the necessary system-level rights to create 
and remove directories in the base mailbox directory. At least one user in the system must have 
administrator privileges.



Message Encryption and Decryption

Encryption is the process of scrambling the contents of a mail message so that only the authorised 
recipient can read it. If you are sending sensitive or personal material, you can gain extra security by 
encrypting it. An offshoot of encryption technology is an authentication technique called a digital 
signature: digital signatures provide a means of proving incontrovertibly that you wrote a particular 
message at a particular time; some digital signature techniques are acceptable as evidence in courts of 
law around the world.

There is a very wide range of encryptors available, and in many countries, especially the United States of 
America and France, paranoid government agencies have done everything in their power to prevent 
encryption technology from becoming available to the general public, usually in the name of "national 
security". This has resulted in astonishing regulations such as the USA's "ITAR" export regulations, under 
which encryption technology is regarded as a munition and cannot be exported without the approval of 
the NSA.

Pegasus Mail incorporates an encryptor which is adequate for day to day use (it is a variant of the old 
unix "crypt" program using DES to "seed" the encryption key). It also permits third-party developers to add
their own encryption technology into the program in a seamless manner. Because of this, the specifics of 
the encryption options available to you may vary from system to system.

When you select the Encrypt option in the message editor, Pegasus Mail will open the encryptor dialog. 
The topmost control in this dialog allows you to select the encryption technique you want applied to the 
message -- unless you have added third-party encryptors to your copy of Pegasus Mail, there will only be 
one entry in this list, Pegasus Mail's built-in encryptor. The other options in the dialog may become 
enabled and disabled depending on the technique you select -- not all encryptors will support digital 
signatures, for instance.

The password is usually your secret key to the message and will not display as you type it in. With some 
encryptors, the password may actually open your encryptor's key ring -- this will depend on particular 
instances. Some encryptors may place certain restrictions on the characters you can use in passwords -- 
consult the specific reference for each encryptor module to find out if this applies to you.

Default password button:  If you have defined a default encryptor passphrase in the Message editor 
settings page of your preferences, then you can enter it into either the encryption or decryption dialog by 
clicking the button labelled “*” at the right of the password field.

Pegasus Mail's built-in encryptor has the following characteristics:

* Passwords can be from 5 to 8 characters in length
* Passwords may not contain international characters
* The encryptor cannot produce digital signatures
* The encryptor cannot encrypt binary data such as attachments
* Only other users of Pegasus Mail will be able to decrypt its messages

The recipient of a message encrypted using Pegasus Mail's built-in encryptor must know the password 
you have used to encrypt it.



The Joke Page

Congratulations! You found the joke page.

Software developers are curious, stunted individuals with massive egos and towering (and usually wildly 
inflated) opinions of their own worth and ability... Pegasus Mail's author realises that he's probably no 
different from any other software developer in this regard. Accordingly, he has indulged himself 
outrageously by burying this completely pointless page in the help file to see if anyone finds it.

Your reward for enduring this string of platitudes and pointless observations is a short selection of some 
of my favourite quotable quotes -- you might like to use some of these in your variable signature, or, you 
might not... <grin>. Warning in advance - some of these quotes are probably not very politically correct, 
so if you're a pious or self-righteous person, you should probably stop reading this screen right now and 
return to your mail.

Definitions

Philosopher (n):    a blind person in a dark room looking for a black hat that is not there.

Bachelor (n):    a thing of beauty and a boy forever.

Erotic (adj):    using a feather as a sex aid.
Kinky (adj):    using the whole duck.

Newspaper glitches

"Ghana is to change over to driving on the right.
The change will be made gradually."

“Iraqi head seeks arms”

“Two convicts evade noose - jury hung”

“Miners refuse to work after death.”

Quotes from famous people

“Wagner has beautiful moments, but awful quarter-hours.”
-- Rossini

"Each time a New Zealander leaves for Australia the IQ of both countries goes up."
-- Rob Muldoon

“A woman is only as old as the man she feels”
-- Mae West

Signs seen around the world



“Dreaded veal cutlet”
-- On the menu of a Chinese Restaurant.

"Stop: drive sideways."
-- Detour sign seen in Kyushi, Japan

“When the passenger of foot heave in sight, tootle the horn. Trumpet him melodiously at first, but if he 
still obstacles your passage, tootle him with vigour”

-- On the driver instructions in a Japanese rental car.

"Salad a firm's own make; limpid red beet soup with cheesy dumplings in the form of a finger; roasted 
duck let loose; beef rashers beaten up in the country people's fashion."

-- Seen on the menu of a Polish hotel

“Cream dognuts”
-- Seen on the menu of a Belgian hotel.

And finally

Remember, even if you win the rat race, you're still a rat...



Guidelines for Electronic Mail Etiquette

This section presents some simple guidelines for electronic mail etiquette and usage. It does not try to 
mandate any particular style or rules, but is rather an attempt to highlight important issues affecting the 
clarity of the electronic mail we send -- after all, electronic mail is about communication, so clarity should
be our goal. This section is based on a document distributed widely around the Internet over the last few 
years, and is in no particular order.

Addresses and personal names

A Personal name is an arbitrary string many mailers will allow you to define that is attached to your e-
mail address as a textual comment: in Pegasus Mail, you define your personal name in the General 
Preferences dialog.

* Always provide a personal name if your mail system allows it - a personal name attached to your 
address identifies you better than your address can on its own.

* Use a sensible personal name: "Guess who" or other such phrases are annoying as personal names and 
hinder the recipient's quick identification of you and your message.

* If your mail system lets you use personal names in the addresses to which you send mail, try to use 
them. This will often help a postmaster recognize the real recipient of the message if the address is 
invalid.

Example:
The address 344188@foo.chaos.com conveys less information
than if it were written as 344188@foo.chaos.com (Ford Prefect)

Subject lines

* Always include a subject line in your message. Almost all mailers present you with the subject line 
when you browse your mailbox, and it's often the only clue the recipient has about the contents when 
filing and searching for messages.

* Make the subject line meaningful. For example, sending a message to WordPerfect Technical Support 
with the subject WordPerfect is practically as unhelpful as having no subject at all.

* If you are replying to a message but are changing the subject of the conversation, change the subject 
too - or better still, start a new message altogether. The subject is usually the easiest way to follow the 
thread of a conversation, so changing the conversation without changing the subject can be confusing 
and can make filing difficult.

Message Length, Content and Format

* Try to match your message length to the tenor of the conversation: if you are only making a quick 
query, then keep it short and to the point.

* In general, keep to the subject as much as possible. If you need to branch off onto a totally new and 
different topic then it's often better to send a new message, which allows the recipient the option of 
filing it separately.



* Don't type your message in all-uppercase - it's extremely difficult to read (although a short stretch of 
uppercase may serve to emphasize a point heavily). Try to break your message into logical paragraphs 
and restrict your sentences to sensible lengths.

* Use correct grammar and spelling. Electronic mail is all about communication - poorly-worded and 
misspelled messages are hard to read and potentially confusing. Just because electronic mail is fast 
does not mean that it should be slipshod, yet the worst language-mashing I have ever seen has been 
done in e-mail messages. If your words are important enough to write, then surely they are also 
important enough to write properly.

* Avoid public "flames" - messages sent in anger. Messages sent in the heat of the moment generally 
only exacerbate the situation and are usually regretted later. Settle down and think about it for a while 
before starting a flame war. (Try going and making yourself a cup of coffee - it's amazing how much 
you can cool down even in that short a time, besides which a cup of good coffee is a great soother).

* If your mail program supports fancy formatting (bold, italic and so on) in the mail messages it 
generates, make sure that the recipient has a mail program that can display such messages. At the time 
of writing, most Internet mail programs do not support anything other than plain text in messages, 
although this will change over time.

* Be very careful about including credit card numbers in electronic mail messages. Electronic mail can 
be intercepted in transit and a valid credit card number is like money in the bank for someone 
unscrupulous enough to use it. 

Replies

* Avoid using "group reply" (reply-to-all) functions whenever possible: the vast majority of messages 
that receive group replies each day do not warrant them. Abuse of this function generates an enormous 
amount of unwanted and unnecessary mail: always consider carefully whether a group reply is really 
warranted before using it.

* Include enough of the original message to provide a context. Remember that Electronic Mail is not as 
immediate as a telephone conversation and the recipient may not recall the contents of the original 
message, especially if he or she receives many messages each day. Including the relevant section from 
the original message helps the recipient to place your reply in context.

* Include only the minimum you need from the original message. One of the most annoying things you 
can encounter in e-mail is to have your original 5-page message quoted back at you in its entirety, with
the words "Me too" added at the bottom. Quote back only the smallest amount you need to make your 
context clear.

* Use some kind of visual indication to distinguish between text quoted from the original message and 
your new text - this makes the reply much easier to follow. ">" is a traditional marker for quoted text, 
but you can use anything provided its purpose is clear and you use it consistently.

* Pay careful attention to where your reply is going to end up: it can be embarrassing for you if a 
personal message ends up on a mailing list, and it's generally annoying for the other list members.

* Ask yourself if your reply is really warranted - a message sent to a list server that only says "I agree" is
probably better sent privately to the person who originally sent the message.



SPAM (unsolicited commercial e-mail)

* If you are tempted to advertise your business or service by sending out e-mail to large lists of people, 
then we have one word for you: DON'T. This is called spamming, and it is the single most reviled 
practice on the Internet. Sending unsolicited commercial e-mail will have the opposite effect from 
anything you might intend, and because it is explicitly mentioned in most Internet Service Providers' 
terms and conditions as a prohibited practice, it may end up costing you your e-mail address. At the 
very least, you will get hundreds or thousands of deeply irate people screaming at you. We can't stress 
this one enough - DON'T SEND SPAM; it is nothing but trouble.

* If you receive a spam message (and who doesn't, these days?) don't assume that the person in the 
"From" field of the message is actually the person who sent it. It is a very common practice for 
spammers to forge the headers of their messages to deflect the blame for their evildoing onto someone 
else.

* This one is not etiquette, exactly, but it's so important we have to mention it here.Most spam mail will 
claim to have a "remove" option - an address to which you can send a message so that you never get 
spam from the sender again. Never, never EVER use such remove options - they simply confirm to the 
spammer that your address is valid and that you read your mail. Rather than reducing the amount of 
spam you get, using a "remove" option will almost certainly result in you getting even more spam.

* Spam is one of the most emotive, complex social issues facing the Internet. If you are interested in 
helping to kerb this abusive practice, you might like to consider joining one of the anti-spam action 
groups, such as CAUCE (the Coalition Against Unsolicited Commercial E-mail) - visit their web page 
at http://www.cauce.org.

Forwarding mail

* When forwarding a message, think carefully about whether the recipient will actually appreciate it. It's 
become common for people to forward jokes, funny pictures and other incidental items on an almost 
open-slather basis, without first checking whether or not the people to whom the items are being 
forwarded really want to receive them. Always ask before forwarding incidental mail to someone.

* If a message contains a request that you forward it to other people, then that's almost always a good 
reason not to do so. There is a number of well-known hoaxes and chain letters that have been going 
around the Internet for years - for instance, the letter with the heart-rending tale of the sick child who 
before he dies wants to set a record for the most e-mail greeting cards received... The message goes on 
to urge you to send a postcard to the child, then forward the e-mail to all your friends. Don't just 
blindly fall for hoaxes like this one - either ignore them, or if they seem especially worthy, ask around 
and find out whether or not they are kosher before proceeding.

Signatures

A Signature is a small block of text appended to the end of your messages, which usually contains your 
contact information. Many mailers can add a signature to your messages automatically. Signatures are a 
great idea but are subject to abuse; balance is the key to a good signature.

* Always use a signature if you can: make sure it identifies who you are and includes alternative means 
of contacting you (phone and fax are usual). In many systems, particularly where mail passes through 
gateways, your signature may be the only means by which the recipient can even tell who you are.



* Keep your signature short - four to seven lines is a handy guideline for maximum signature length. 
Unnecessarily long signatures waste bandwidth (especially when distributed to lists) and can be 
annoying.

* Some mailers allow you to add random strings to your signature: this is well and good and can add 
character if done carefully. You should consider the following basic rules though:

Keep it short. The length of your quote adds to the length of your signature. A 5,000 word excerpt 
from Kant's 'Critique of Pure Reason' used as a signature will not win you many friends.

Definitions of "offensive" vary widely: avoid quotes that might offend people on the grounds of 
religion, race, politics or sexuality.

Avoid topical or local quotes, since they may be meaningless to recipients in other towns, countries or 
cultures.

Variable signatures are usually best if they're amusing; polemical outbursts on politics or other such 
topics will turn most people off, but a one-liner that brings a smile can make someone's day.

Courtesy

Electronic mail is all about communication with other people, and as such some basic courtesy never goes
amiss.

* If you're asking for something, don't forget to say "please". Similarly, if someone does something for 
you, it never hurts to say "thank you". While this might sound trivial, or even insulting, it's astonishing
how many people who are perfectly polite in everyday life seem to forget their manners in their e-mail.

* Don't expect an immediate answer. The fact that you don't get an answer from someone in ten minutes 
does not mean that he or she is ignoring you, and is no cause for offense. Electronic mail is all about 
dealing with your communications when you are able to do so.

* Always remember that there is no such thing as a secure mail system. It is unwise to send very 
personal or sensitive information by e-mail unless you encrypt it using a reliable encryptor. Remember
the recipient - you are not the only person who could be embarrassed if a delicate message falls into 
the wrong hands.

* Include enough information: if you are sending in a question to which you expect a response, make 
sure you include enough information to make the response possible. For example, sending the message
My spreadsheet program doesn't work to Lotus Technical Support really doesn't give them very much 
to work with; similarly, sending the message What has happened to my order? to a vendor is also 
unhelpful. When requesting technical support, include a description of the problem and the version of 
the program you're using; when following up on an order, include the order number, your name and 
organization, and any other details that might assist in tracing your order - and so on.

"Smiley faces" (Emoticons)

Electronic mail has very nearly the immediacy of a conversation, but is totally devoid of "body language".
The Internet "counter-culture" has had an answer to this problem for years - "smiley faces", or groups of 
ASCII characters that are meant to look like a face turned on its side.



The most common smiley faces are probably these:

:-) or :) A smiling face seen side-on; generally used to indicate amusement, or that a comment is 
intended to be funny or ironic ("<g>" or "<grin>" is also sometimes used).

:-( or :( An unhappy face seen side on; generally used to express disappointment or sorrow.
;-) A winking smiley face; usually indicates that something should be taken "with a grain of 

salt".
;-> A mischievous smiley face; usually indicates that a comment is intended to be 

provocative or racy.

There are hundreds of others, some more recognizable than others.

Using the common smiley faces carefully can markedly improve the clarity of your message, since they 
convey nuances which approximate "body language". Like any embellishment, however, overuse of 
smiley faces destroys their value - use them sparingly.

The Bottom Line

Above all else, remember that electronic mail is about communication with other people. When you 
compose an e-mail message, read it over before sending it and ask yourself what your reaction would be 
if you received it. In the end, any time spent on making our e-mail clearer is time well-spent, so let's start 
taking the time.



Viewing attachments

See also: Preferences overview

When you receive mail with attachments, you may wish to view the contents of the attachment without 
leaving Pegasus Mail: you can do this provided Pegasus Mail can find an application on your system that 
is capable of displaying the type of file contained in the attachment. When looking for a suitable viewer, 
Pegasus Mail can use either the extension of the filename for the attachment, or if the attachment has 
attachment type information associated with it, it can use that.

*Note: Pegasus Mail is intrinsically capable of displaying plain text, HTML, enriched text, GIF, Animated 
GIF, JPEG, BMP, EMF, PNG, WMF and some other common graphic formats. For these data types, you 
do not have to define viewers.

There is no absolute way of identifying that a particular application can open any particular file, but 
Pegasus Mail uses the following method when attempting to find one:

* If you have defined an explicit viewer using the Attachment Viewers option on the Preferences menu, 
Pegasus Mail will use that viewer.

* If no viewer has been defined explicitly, it scans the [Extensions] section of your WIN.INI file looking for 
applications that have stored associations there.

If no suitable viewer can be found, the View button in the attachments dialog will be disabled. If a suitable 
viewer is available, Pegasus Mail will create a temporary file containing the data from the attachment and 
will run the viewer application, passing it that file to open. If you click the Save and Edit button instead of 
the View button, Pegasus Mail will create a permanent file instead of a temporary file. In no case can you 
ever actually alter the data of the attachment itself using a viewer.

Defining a viewer

To define your own viewers for different types of attachments, choose the Attachment Viewers option on 
the Preferences menu. Click Add to create a new entry, or double-click an existing entry to edit it. Next, 
decide whether Pegasus Mail should examine the file's extension when deciding whether or not to use 
this definition, or else examine the file's attachment-type information. It is reasonable, and in fact often 
even necessary to create two entries in the list, one to select by extension and the other to select by 
attachment type.

If you choose to select by extension, you should then type in the extension Pegasus Mail should look for 
when examining the file. If you choose to select by attachment type, you can either select an attachment 
type from the standard list of types Pegasus Mail knows about, or else you can type in any other type you 
know you receive. Note that you must type the attachment type in accurately and completely - Pegasus 
Mail only does exact matching on this information.

Once you have worked out the conditions that need to be matched for Pegasus Mail to use this definition, 
you can click the OK button to save the definition. If you get an error from Windows when you try to view 
an attachment, or if nothing happens when you click the View button, you may have to uncheck the 
control labelled "Let Windows choose an appropriate application" and enter the name of the application 
Pegasus Mail should run to view the document. Click the Browse button to use a list to choose your 
application.

Extension to use for temporary file:    Many applications will only load documents if the extension of the file
is one they know. If someone sends you a file of a particular type with a different extension, then the 
application will refuse to open it. To get around this, Pegasus Mail allows you to force the use of a 
particular extension in the filename of the temporary file it creates and passes to the viewer application. A 
good example of this might be with JPG graphic files: most Windows-based graphic viewers expect the 



extension for JPG files to be .JPG, but if you receive such a graphic from a unix system, where the 
conventions are different, it will usually have the extension .JPEG. To handle cases like this, you would 
enter .JPG into this field to force Pegasus Mail to create the file using the extension .JPG instead of the 
unix name.

Selecting special MIME types: MIME is a special Internet message format which can represent the type of
data in an attachment in special ways, many of which are not standard. Although it is very technical, you 
can tell Pegasus Mail to use a viewer for particular MIME document types by entering the MIME data type
in the Attachment type field. For example, if someone sends you GIF images using the MIME data type 
Image/GIF, you can define a viewer for attachments of that type by entering Image/GIF in the attachment 
type field. This option should not normally be necessary and is provided for the benefit of advanced users 
working with their own special data types.



Filenames

Under MS-DOS and Windows, a filename consists of three parts

* Its path, which is the full name of the directory containing the file
* Its name, which can contain up to eight letters or digits
* Its extension, which is an optional group of three letters or digits separated from the filename by a single
period (.).

A file's extension usually serves to identify the type of data the file contains - so for instance, a file called 
MYFILE.TXT would usually contain plain text, the .TXT extension indicating this. 

Under Windows 95, files can have much longer names, but they still can have an extension, and the 
extension still usually serves the same purpose.



Searching for data throughout your folders

Often you may know that you have received a message on a particular subject at some stage but have no
idea which folder you stored it in. If you want to search through some or all of your folders for particular 
messages, open the Folder Manager window and select Find from the Edit menu. A dialog will open 
offering you options for your search.

In the Search for messages containing field, type in the words for which you would like Pegasus Mail to 
search. When searching, it looks for each word you enter separately and gives a relevance score to each 
message based on how many of the words you enter it contains, how close they are together in the 
message and on how exact the match is. When searching, it will match the words you enter both as 
whole words and as partial words -- so, if you enter agree as a word to search for, Pegasus Mail will 
match messages containing agree, disagree and agreement, but will score the message containing agree
more highly because it is a more exact match. Choosing the words you want to search for carefully 
increases the likelihood of Pegasus Mail finding the exact message you are looking for. You can enter up 
to twenty words.

Search in allows you to control which folders Pegasus Mail should search, and how long it should spend 
doing it. Searching folders can be a very slow process, so Pegasus Mail allows you to limit the search to a
certain length of time. You can also halt the search at any time once you have started it by clicking Stop in
the progress dialog. You can limit the search to folders whose long names contain particular words or 
strings by clicking the Folders whose names contain control and typing in the characters Pegasus Mail 
should match. This can be very handy if you have organized your folders using consistent or specific 
naming conventions. When searching by folder names, the search ignores trays - all your folders are 
candidates for searching even if they are in trays that are not currently open in the list.

Searching within a tray:    if the currently-selected item in the folder list is a tray, you can select Selected 
folder or tray only, and Pegasus Mail will limit the search to the folders and trays contained within that 
tray.

If you check the control labelled Search in message headers only, Pegasus Mail will limit its search to the 
special message headers for each message and will not search through the message body. This can 
result in a much faster search.

When you have filled out the fields in the dialog, click OK and Pegasus Mail will begin the search. As it 
finds candidate messages, it will display them in a results window, sorted by relevance, the most 
promising messages at the top of the list. You can see an indication of the relative relevance of a 
message by examining the bar at the left-hand side of each entry in the list -- the longer the bar, the more 
relevant Pegasus Mail believes the message to be. You can stop the search at any time by pressing Stop 
in the progress dialog, and you can switch to other applications while the search is in progress. If you 
interrupt a search, the results window will remain open with the messages found up to that point.

You can sort the messages in the result window by relevance, sender, subject or date; the default sort 
order is always by relevance. You can open any message in the result window by double-clicking it, or by 
highlighting it and pressing Open. The folder containing the message will also be opened with the 
message highlighted.



Clickable links

See also: Preferences overview

Pegasus Mail can detect URLs (Uniform Resource Locators), or hypertext links for the World Wide Web 
in your messages. When it finds a valid HTTP:, FTP: or MAILTO: URL in a mail message, it highlights it 
by displaying it in underlined green text. It also attempts to locate ordinary e-mail addresses and highlight 
them in the same manner.

If you double-click a MAILTO: URL or a highlighted e-mail address, Pegasus Mail will simply start a new 
message using that. For other URL types, if you have a Web Browser, such as Netscape or Microsoft 
Internet Explorer on your system, you can have Pegasus Mail load the browser for you and open the link 
by double-clicking on it in the message reader.

The first time you do this, Pegasus Mail will open a window asking you to locate your web browser. In 
most cases, you can simply check the control labelled Find browser automatically. This tells Pegasus Mail
to use standard system resources to locate the proper browser to load and run. When this control is 
checked, Pegasus Mail will activate your web browser if it is already running, and will instruct it to replace 
the page it is currently displaying with the one you double-clicked.

By default, Pegasus Mail passes the URL to the Windows operating system and asks it to open an 
appropriate application. For this to work, you must have a properly-installed copy of URL.DLL on your 
system. If URLs do not launch properly using the default method, you can click the control labelled Use 
URLPROXY.EXE: this tells Pegasus Mail to use a special URL launcher of its own that can reliably 
interact with Microsoft Internet Explorer and Netscape Navigator.

Some web browsers may not install themselves in a way that will allow the Find browser automatically 
option to run properly. When this is the case, nothing will appear to happen when you double-click a URL 
in a message. To fix this situation, enter the path to your web browser in the edit control and make sure 
the Find browser automatically button is not checked.

Note: Microsoft Internet Explorer uses a strange, illegal URL format for specifying local files. If you are 
using Microsoft Internet Explorer as your web browser, you must check the control labelled Use the non-
standard URLs expected by MS Internet Explorer in this dialog.



Selectively downloading your mail messages

The process of retrieving your mail from your Internet Service Provider can be costly, especially if you 
have to make a toll call to do so. Pegasus Mail allows you to preview the contents of your POP3 mailbox 
before downloading it, by downloading only the message headers and showing them to you. Once the 
mail headers have been downloaded, Pegasus Mail terminates the connection immediately and allows 
you to browse the headers from the messages at your leisure. You can indicate that you want to retrieve 
some of the messages from your mailbox and possibly delete others, then when you are ready, you can 
tell Pegasus Mail to reconnect and perform the actions you have specified.

To start a selective download from your POP3 mailbox, choose Selective Mail Download from the File 
menu. Pegasus Mail will start a connection to your POP3 host and will retrieve the headers of the 
messages it contains. If you have told Pegasus Mail to download only unread mail using the option in 
your Advanced configuration options settings, then the selective download will only retrieve the headers 
of messages you have not already seen. While it is downloading the message headers, you may continue
to work on other things, or switch to other applications; the only thing you may not do while this operation 
is in progress is attempt to start a regular mail download or to send mail in your mail queue - Pegasus 
Mail will report an error if you attempt to do this. Once the header download is complete, Pegasus Mail 
will open a window displaying the sender, subject, date and size of each message in the mailbox.

For each entry in the list, you may Retrieve the message, Delete the message, do both, or leave it 
untouched. Messages marked for retrieval will show a green dot in the “R” column at the right of the list, 
and messages marked for deletion will show a red dot in the “D” column.

To indicate that you want to retrieve a mail message from your mailbox to your local system, highlight the 
message and click the Mark for retrieval button. A green dot will appear next to the message, but nothing 
more will happen at this stage.

To indicate that you want to delete a mail message from your mailbox, highlight the message and click the
Mark for deletion button. A red dot will appear next to the message and it will display in red, but nothing 
more will happen at this stage.

To indicate that you want to retrieve a message from your mailbox then delete it, either click both buttons, 
or more conveniently, click the Mark for both button.

You can mark more than one message by holding down Shift or Ctrl as you click in the list. The Mark for 
Retrieval, Mark for Deletion and Mark for both buttons will tag all selected messages.

Once you have marked the messages you wish to retrieve and delete, click the button labelled Make it so 
(apologies to Star Trek). This tells Pegasus Mail to open another connection to your POP3 host and take 
all the actions you have specified. If any messages are downloaded successfully as a result of the 
connection, they will appear in your new mail folder, which will open or resynchronize itself automatically 
to display them.

Important notes:

• Messages marked for both retrieval and deletion will only be deleted if they are actually retrieved 
successfully.

• Messages not marked for deletion will not be deleted from the remote mailbox, even if you have 
turned on Delete mail from host once successfully retrieved in your Advanced configuration 
options settings.



Terms and conditions of use

Pegasus Mail is free software and may be used by any number of users on any number of systems without fee or 
obligation, subject only to the terms and conditions laid out below.

Pegasus Mail is NOT in the public domain - the author, David Harris, retains ownership and copyright, and 
exclusively reserves all rights to the software. In countries where assertion of the right to be identified as the author 
is required for copyright purposes, David Harris asserts his right to be recognized as the author and owner of the 
Pegasus Mail System and all its associated components.

Modification of the program or its resources or associated data files without the author's explicit written permission 
is strictly forbidden. Unauthorised modifications of any component of the Pegasus Mail System constitute a breach 
of intellectual property laws in most countries and will be pursued vigorously to the full extent of the law.

Pegasus Mail may be used by anyone and may be freely distributed via any medium, either commercial or non-
commercial, provided the following conditions are met:

1: Distribution    The Pegasus Mail Software must be distributed complete and unaltered in the original ZIP 
archive file or self-extracting archive, with all messages intact. System administrators and ISPs wishing to 
repackage the Pegasus Mail archive for supply to their users may do so provided some basic guidelines are 
followed - please send e-mail to tech-support@pmail.gen.nz for more information on this. In the event that 
the Pegasus Mail software is being distributed as part of another package or software bundle, or in 
association with software or services for which a charge is being levied, the author's permission must be 
obtained before distribution occurs. We will authorise by fax or by an e-mail message signed with our 
public key signature at our discretion. Bona fide Internet Service Providers are exempted from the 
requirement to obtain formal permission (see section 5, below).

2: Charging for distribution    No charge may be directly levied for Pegasus Mail itself. Fair copying and 
support charges may be applied but you must not represent that you are actually selling the software itself. 
The intent of this statement is to allow book publishers to distribute the system freely with books, and to 
permit Software Libraries and BBS systems to distribute Pegasus Mail in their catalogues provided only 
reasonable handling and duplication fees are charged.

3: Prohibited supply    The supply or promotion of Pegasus Mail for the purpose of sending bulk, unsolicited 
e-mail is incompatible with the basic aims of the program, which revolve around the free provision of a 
service that enhances the quality of communication between people. Pegasus Mail may not be included in 
any package designed for this purpose, whether free or otherwise, nor may vendors of such packages use 
the "Pegasus Mail" trademark or other related material in the promotion of their package. Similarly, we do 
not consider bulk, unsolicited e-mail to be an appropriate use of Pegasus Mail and reserve the right to 
decline technical support, or the sales of manuals to people using it for this purpose.

3a: Prohibited use:    Pegasus Mail may not be used for the purpose of sending Bulk Unsolicited Commercial 
Electronic Mail. For the purposes of this section, this shall be construed to mean electronic mail sent to a 
total of more than 50 recipients for the purpose of advertising a commercial product or service, where the 
recipient has not explicitly expressed interest in receiving such advertisements.

4: Ownership    Ownership of the Pegasus Mail Software remains vested in the author, David Harris. You may 
not represent ownership or copyright in the system in the course of distribution, and you must not represent 
any specific connection with, or authorisation or license from the author.

5: Distribution by ISPs    Bona-fide Internet Service Providers are explicitly granted permission to bundle the 
Pegasus Mail Software with their standard subscriber access package if they wish, even if a charge is levied
for that access package, provided the conditions laid out in section (1) above are met. If you supply Pegasus
Mail as a separate item (as opposed to being part of an access bundle), you may only charge a reasonable 
duplication or handling fee and must otherwise abide by all other terms and conditions defined herein.



6: No liability    although all possible care has been taken to ensure that the Pegasus Mail Software is as 
reliable as possible, the diversity of environments in which it might be used means that we can accept no 
responsibility for loss or damage, whether real or consequential, arising from its use. By using the software 
you explicitly agree to hold the author blameless for any such losses or damages.

7: All rights reserved    we reserve the right to change the terms and conditions of use and distribution of 
Pegasus Mail without specific notice, although we will make reasonable efforts to advise of any such 
change through normal channels (user groups, mailing lists and so on). The current terms and conditions of 
use of Pegasus Mail can be obtained at any time by sending a message to tech-support@pmail.gen.nz 
requesting them.

All the legalese aside, it is my strong desire that Pegasus Mail be as widely used as is possible in the hope that by 
furthering communication between people, we may in some small way come to understand and accept each other 
better.



Notepads

Pegasus Mail incorporates a notepad facility that provides an easy way to keep notes or lists or reminders
from within the program itself. To open the Notepad window, choose Notepads from the Tools menu.

You can create as many different notepads as you wish by clicking the New button. You can select or view
the contents of any notepad you have created by double-clicking it in the list of notepads at the left-hand 
side of the window. Anything you type in a notepad is automatically saved when the notepad window is 
closed, or when you switch to a different notepad. Notepads can contain a maximum of 30,000 characters
each.

To read the contents of a text file into a notepad, click the Import button and choose the file you want to 
add to the notepad. The file must be a plain text file, not a word processor file. You can save the contents 
of the currently-open notepad by clicking the Export button and entering a filename. Be aware that if you 
enter the name of a file that already exists, it will be deleted and replaced by the contents of the notepad.

Click the Date/time button to enter the current date and time at the cursor position in the currently-open 
notepad. This is a handy way of adding timestamps to your notes.

You can print the currently-open notepad by clicking the Print button.

Notepads are a handy way of storing text temporarily or for storing blocks of text that you use regularly in 
your mail. You can paste text into notepads from messages or any other source, and you can cut, copy 
and paste text from notepads into your messages or other applications.



The History of Pegasus Mail

By the standards of the ever-changing Internet, Pegasus Mail has a long history: it sent its first message in
December 1989, and has been made available as a free service to the Internet since February 1990. The 
Windows version of Pegasus Mail first appeared in 1993. In the time since its initial release, Pegasus Mail
has sent billions of messages for millions of people. It dates from the time when the Internet was a 
community rather than just a highway -- when people helped each other without worrying too much about
who was going to pay for it.

My name is David Harris -- I'm the person who develops both Pegasus Mail and Mercury, its companion 
server product. There is no anonymous corporation behind the program, and the same pair of hands that 
wrote the first version in 1989 is still writing it in 2001. People regularly ask me why I originally wrote 
Pegasus Mail, and why I still make it available for free: if you've got a moment, I'll try to give you a little 
background.

In 1989, the University where I worked (in Dunedin, New Zealand) installed its first Novell NetWare 
network. It wasn't until after we installed it that we found that it didn't include an e-mail system, but we'd 
already used up our budget and the commercial mail packages that were available were very expensive. 
To fill the gap, I wrote a simple e-mail program in my own time and made it available on the network: I 
was quite surprised to find that people liked it.

Early in 1990, after tidying it up a little, I made it available on the Internet at a friend's FTP site in 
Hawaii, expecting that four or five other sites might find a use for it... In the first week of availability, it 
was downloaded more than 100 times, which also surprised me. I found that I was receiving mail from 
people thanking me for giving them something they couldn't have afforded any other way -- 
communication. I grew to understand that communication had to be regarded as a right, not as a privilege:
it seemed to me in 1989, as it still seems to me now, that freedom of speech is useless if nobody can hear 
you. Giving away Pegasus Mail seemed to be a means by which I could try to make communication more
accessible to a much wider range of people who needed it.

From that time, I began a curious double existence, working at the University by day, and working on 
Pegasus Mail at night, refining and tuning it to add the things people were asking for. With each release of
the program, usage grew, until by 1993, the demands it was placing on my time were so great that I had to
make a choice between my safe University job and going out full-time to support Pegasus Mail. Leaving 
the University gave me what I needed most -- time -- but took away what I needed to survive -- my salary.
This put me in an awkward situation: the ideals that had motivated me to make the program available in 
the first place were still just as valid as ever, but I also had to eat. I hit upon the idea of making the 
manuals available for sale as an option to support the development of the program. This allowed the 
software to remain free, and the addition of extensive online help ensured that the program remained 
useful even without the manuals: so, the larder was stocked without compromising the ideals. To this day, 
my only source of income remains the sale of manuals for Pegasus Mail.

Since 1990, the world has changed: the Internet has become more or less a commodity, and people's 
expectations of software have altered enormously. I've worked hard to try to keep up with the 
expectations of my user base and to keep offering a program that fits all their needs. I enjoy making 
Pegasus Mail available on these terms, knowing that it helps people: your support is a key component of 
making this all happen, whether it's by purchasing manuals, or by showing the program to people who 
might benefit from using it, or simply by enjoying the fruits of my labour. With your support and backing,
I look forward to being able to offer Pegasus Mail in the future for as long as the ideals it represents are 
still relevant.



Cheers!

-- David Harris --
Author, Pegasus Mail
Dunedin, July 2002.
David.Harris@pmail.gen.nz



Identities

See also: Attaching identities to Folders

An "Identity" is a collection of program settings within Pegasus Mail. The first time you run the program, a 
"Default" identity is created for you -- when you change your preferences, you are saving those changes 
within that Default identity. Pegasus Mail allows you to create other identities, each with its own settings, 
and to use them in a number of ways. You can define as many identities as you wish and select them 
using the "Identities" dropdown control on the Pegasus Mail toolbar. To give you an example of how 
identities may be useful, imagine that you act as your organization's webmaster or postmaster: you may 
occasionally get messages in your mailbox that need to be handled in that capacity instead of in your 
normal user capacity. Rather than going into your preferences and manually changing your personal 
name and signatures to reflect the official position, you could simply define an identity where these 
changes are already made, then switch to that identity with a single click. Similarly, if you handle multiple 
POP3 e-mail accounts, you can use identities to hold the settings for each account.

To create a new Identity:

Select Tools | Identities... from the menu to bring up the Identities dialog. You should have at least one 
Identity defined there already, usually called <Default>.    From this dialog, you can create and delete 
identities, as well as change to one of your available identities using the Become button.

To add a new Identity, click the Add... button. Enter a descriptive name for this new identity in the upper 
field and in the lower drop-down box, select the identity you wish to base this new identity on from your 
current list of identities. This allows you to have a starting point of reference when creating new identities 
and is quite helpful if you are creating many identities that are mostly similar to each other. Click the OK 
button to create the new identity.

Once created, the identity can be selected by highlighting it within the dialog in the Tools | Identity menu 
and clicking the Become button. As a shortcut and visual clue, there is also an identity drop-down box on 
Pegasus Mail's main toolbar (note that the toolbar is configurable, so the identity drop-down box might not
be available to you). The identity drop-down box on the toolbar always displays the currently-selected 
global identity.

Once you have created and selected the identity you can go to the Tools | Options... menu to customize 
its settings. When creating a new message, Pegasus Mail will use the settings as specified by the 
currently-selected identity (called the global identity) showing on Pegasus Mail's main toolbar. Changes 
made to the default signature, font, and other settings for a new message will be recorded for the global 
identity.

Your identity is now ready for use. Use the different identities by selecting them from the main toolbar or 
from the Tools | Identities dialog, by pressing the-become button. 

When replying or forwarding mail, you can select a non-global identity from the Reply Options and 
Forward dialogs and that identity will be used to generate only that reply or forwarded message. The 
global identity will continue to be used for new messages and so forth.

NOTE: Once you open the message editor window for a new message, a reply to a message or on a    
forwarded message, any global identity change is ignored for that message. So first change the identity 
(or select it from the "Reply Options" or "Forward Message To" dialog) and then create the message.



Automatic replies

If Pegasus Mail's companion Server product, Mercury, is installed on your system, you can create replies 
that will be sent out automatically any time you receive a message. These automatic replies are actually 
handled by the Mercury server process and thus will go out even if your own machine is turned off.

An automatic reply is simply a short message returned to the sender of incoming mail - common uses for 
automatic replies are to indicate that you're on holiday or out of the office, or to indicate that a message 
has been received and will be read in due course.

To edit your automatic reply, choose Automatic reply... from the Tools menu. Enter the text you want to 
send automatically in the editable area and check or uncheck the control labelled Enable automatic 
replies to determine whether or not the reply should be sent. When automatic replies are disabled, your 
message is stored in a different location and can be edited in the same way as when automatic replies 
are turned on.

Mercury will only send an automatic reply to any given address once in any 48-hour period: this prevents 
mail storms and stops people sending mail regularly from being deluged with autoreply notices. You can 
also create a file called AREPLY.KFS in your new mail directory containing a list of addresses that should 
never receive automatic replies, one per line.



Dialling

Pegasus Mail conforms to the Windows Sockets specification, which is a standard for accessing Internet-
related communications protocols. Unfortunately, the Windows Sockets specification does not cover the 
issue of how connections should be controlled in dialup environments - it has, instead, been left up to 
individual implementors to do this. Unfortunately, the most commonly-used Windows Sockets 
implementation - the Microsoft version shipped with Windows 95 and NT - is also one of the poorest at 
handling dialup connections.

To work around the deficiencies of Microsoft's code, Pegasus Mail provides a number of methods you can
use to control dialling and hanging up on your Internet connections. These methods are configured using 
the Dialling option on the Network configuration page of your preferences. Which method is most suitable 
for you will depend on your environment and on how you connect to the Internet. These dialling options 
are only available in the 32-bit version of Pegasus Mail.

1: No explicit dialling    If you have a working solution, such as Dunce, installed on your system, then your 
Internet connections may already work correctly: if this is the case, check this control and Pegasus Mail 
will not attempt to do anything special to handle dialling or hanging up on your system. This is also the 
proper control to check if you are connected to a local area network and do not need dialling support.

2: Run commands    If you have programs you can run to control your connections, you can use this 
option: there are separate fields for dialling and hanging up - you can use either or both if you wish. When
a command is defined in these fields, Pegasus Mail will run the command and will then wait for the 
command to finish before continuing to connect. Under Windows NT, the NT RASDIAL utility can be used 
for this purpose. Pegasus Mail also includes a neat utility by Claudio Fahey called RASDIAL95, which 
provides the same comprehensive access to the Microsoft telephony subsystem on Windows 95 and NT 
systems. RASDIAL95.ZIP is installed in the RESOURCE subdirectory of your Pegasus Mail installation 
directory. It contains simple instructions on its use.

3: Use IE4/Win98 dialling functions in WININET.DLL    If you have installed Microsoft Internet Explorer 
v4.0 or later on your system, or if you are using Windows 98, then you will have a Microsoft system 
component called WININET.DLL, which provides excellent dialup support. When WININET services are 
available, they are usually the best and cleanest way of handling your connections.

4: Don't dial, but hangup automatically using HANGUP32    HANGUP32 is a Pegasus Mail extension 
written by a very talented man called John Navas: it sits in the background while Pegasus Mail is running 
and watches when connections are made. When Pegasus Mail finishes with the connection, HANGUP32 
takes over, controlling the process of shutting down the connection. This is probably the most useful 
option for most people, because the Microsoft Windows Sockets module can usually dial quite reliably, 
but cannot hangup correctly. Selecting this option installs HANGUP32 the next time the program runs. 
Note that if you switch to another option from HANGUP32, you should exit and restart Pegasus Mail 
immediately to avoid clashes between the methods.



What's new in v4.0?

See also: Hints and tips for v4.0

V4.02, July 2002

V4.02 is primarily a bug fix release, aimed at smoothing out lingering rough edges in v4.01. Many, many 
small problems and behaviours have been fixed in this version, but there are a few commonly-requested 
feature additions too.

· New right-click options allow you to open any message in a web browser, and to display the 
pictures in "lazy HTML" messages (improperly-formatted HTML messages that contain remote 
links instead of properly-embedded graphics). Internal jumps within HTML messages now also 
work correctly.

· New controls have been added to the forwarding dialog allowing you to choose what level of 
message headers should be included in messages you edit before forwarding.

· System-wide addressbooks can now be modified by anyone with sufficient privilege to do so (in 
v4.01, system-wide address books could not be edited at all, only imported).

· You can now specify what colours Pegasus Mail should use to indicate folders that contain 
unread and recent unread mail.

· Based on extensive feedback, a number of small changes have been made to the preview mode 
view of your folders to make it more keyboard-friendly; in particular, the <Enter> key now opens 
messages, and <Ctrl+Space> can be used to page backwards in the preview. Also, pressing the 
back-quote key ( ` ) while in preview mode will switch from the preview window to the last window
you were using (handy for getting back to a reply if you have had to refer to another message in 
the preview window).

· You can now select any text in a message, right-click.and choose Open as hyperlink: Pegasus 
Mail will reassemble the text and pass it off to your web browser. This is especially handy for 
working with URLs that span multiple lines.

There are also over four hundred other small changes, fixes or additions - thank you to everyone who has
taken the time to report problems to us - we hope we have found and fixed your favourite pet peeves. 
From here, work begins on v4.1, which is a major feature addition release, and which we hope to release 
late in 2002.

V4.01, September 2001

With more than 2500 changes or fixes, 11,500 messages exchanged by the beta test team, and fifteen 
months of extensive development, Pegasus Mail v4.0 represents the culmination of a huge reworking of 
the entire Pegasus Mail system - practically no part of the program's user interface has not been modified
and brought up-to-date in some way. The aim of the redevelopment process was to improve the usability, 
style and appearance of the program without sacrificing any of its proven reliability or personality.

The list of things that have actually changed is enormous, but the most visible highlights are:

· Vastly improved handling of HTML: Pegasus Mail can now display practically all HTML content, 
and can compose HTML messages containing tables, graphics, hyperlinks and more.



· Preview Pane mode for folders. You can now view your mail folders in a three-pane mode, much 
like Microsoft Outlook. Switching between preview mode and Pegasus Mail's "Classic" multi-
window mode is done at the touch of a button.

· Powerful new message reader window. Pegasus Mail's message reader has been completely 
overhauled, especially in areas like Attachment handling and Annotations.

· Forwarding of mail has been totally overhauled, especially in the area of forwarding messages 
with attachments. 

· Printing has been totally rewritten: Pegasus Mail can now print messages of arbitrary complexity, 
and a number of problems with printing in earlier versions have been fixed.

· New mail filtering options: We invented mail filtering in 1991, and now Pegasus Mail's mail 
filtering has been improved even further, with the ability to filter on message attributes. The 
filtering rule editor has also been completely overhauled and has a much more logical, consistent 
interface.

· New "Select" and "Incremental search" options for folders make it vastly easier to find and select 
messages based on almost any criteria you can imagine.

· Automatic formatting: Pegasus Mail's editor can now correct common typos as you type, and can 
automatically create hanging indents and bulleted lists for you.

· Security has been tightened even further: although Pegasus Mail can now display HTML 
messages of almost any level of complexity, it remains immune to all the nasties that plague other
mail programs. New content viewer options also protect you from inadvertently running 
dangerous or malicious files sent to you as attachments.

· Signatures have been completely reworked: you can now have fancy signatures with pictures and
formatting in your HTML mail, and you can choose to have your signature included in the 
message at the time you compose it.

· Addressbooks have been redone with a brand new interface. There's also a new addressing 
centre, available while you compose your messages, which allows you to access your 
addressbooks, distribution lists and recently-used addresses all from within a single easy-to-use 
interface.

· The toolbars in the various windows can now be switched between Graphics-and-text, graphics-
only and text-only modes, and support scrolling so you can still get at all the buttons even if you 
use narrow window sizes.

· The huge range of configuration options offered by Pegasus Mail have been consolidated and 
presented in a completely new preferences dialog that is much easier to navigate and use.

· Right-clicking a hyperlink in the message reader or preview window now offers a number of useful
options for using the contents of that hyperlink.

... and this is really only the visible things; if you have previously used Pegasus Mail, you will probably be 
surprised how many new and useful things you find as you work your way into the program.

Pegasus Mail v4.0 is our platform for future development - it lays the foundations for a number of very 
important new features that will be introduced progressively during the latter part of 2001 and during 
2002, including a calendaring and scheduling module, an incredibly rich new addressbook format, secure 
(encrypted) folders, support for SSL and S/MIME and much more. Please watch our web site, 
http://www.pmail.com, for information on these additions as they become available.





Hints and tips for v4.0

Here are some hints and tips we thought might help you get up to speed with Pegasus Mail v4 more 
quickly:

Folder preview mode and scrolling toolbars      If you have previously used Pegasus Mail, your Folder 
Manager window (the window that lists all your folders and mailboxes) may not be wide enough to show 
the new Preview button that switches into the multi-pane preview mode. If this is the case, there will be a 
green arrow button at the right of the Folder Manager's toolbar - simply click this button to scroll the 
Preview button into view. Keep an eye open for this green arrow throughout the program - many windows 
now have extra buttons that can be scrolled into view in this way.

Fancy styling      Pegasus Mail v4 has excellent support for composing HTML messages that include all 
types of fancy formatting - graphics, bold and italic typefaces, tables and more - experiment with the 
buttons on the message editor toolbar to see the options that are available. If you do not use formatting in
your messages, Pegasus Mail will send plain text messages, just the way it always has. You can always 
tell if Pegasus Mail is going to send an HTML message because the Rich Text control in the message 
editor will check itself. Unchecking the control will force the program to send a plain text message, 
although any formatting in the message will continue to show until you send it.

Preferences, preferences, preferences      One of the most striking things about Pegasus Mail is how 
configurable it is - v4 being more so than any previous version. The preferences hierarchy in Pegasus 
Mail is much easier and clearer than in previous versions too - we strongly recommend that you select 
Options from the Tools menu and spend time familiarizing yourself with the various settings you can 
change.

Do the tutorials!      Some of the most commonly-used Pegasus Mail windows now have comprehensive 
tutorials associated with them. These tutorials will give you a head start towards getting the most out of 
the program. If you are offered a tutorial by the program at any point, we recommend that you do it. As an 
example, click here to see the tutorial on the new Pegasus Mail message reader window.

Ordering manuals and technical support      Starting with Pegasus Mail v4, we have changed the way we 
provide technical support and manuals in response to feedback from you, our users - please click the '$' 
button on the program's main toolbar for more information on the options that are now available. As 
always, manuals and support are optional - you don't have to purchase them, but doing so shows your 
support for the ongoing development of the system.



The message editor toolbar

The editor in Pegasus Mail has a toolbar containing commonly-used formatting options. The drop-down 
controls at the left of the toolbar allow you to choose specific fonts and sizes, while the buttons on the 
toolbar have the following functions:

Turn bold text on or off
Turn italic text on or off
Turn underlined text on or off

Turn right-aligned text on or off
Turn centred text on or off
Turn fully-justified text on or off

Indent the current paragraph one tab stop at the left.
Indent the current paragraph one tab stop at the right
Add a "hanging" indent to the current paragraph

Indenting and outdenting  The indent buttons can be pressed multiple times to indent a paragraph by 
one tab stop per click. To "outdent" a paragraph - that is, to undo an indenting change - hold down the 
Ctrl key as you click the button.

Text alignment  The text alignment buttons are "toggles" - that is, they change the text to whatever is the 
opposite of its current format... So, if you click the "Centre text" button when the current paragraph is 
already centred, it will revert to being regular left-flush text.

Rich text    Clicking the Bold, Underline or Italic buttons sets a flag in the message that will result in it 
being sent in a rich text format if your settings permit this. You should be aware that not all mailers can 
handle rich text at present - always check with your recipients before sending them messages containing 
formatting. Paragraph alignment and indenting will not necessarily force the message to be sent in a rich 
text format. Not all text formatting can currently be stored in draft messages. Pegasus Mail can be told 
never to send rich text mail using the options on the Sending Mail preferences page.



Downloading Pegasus Mail from the Internet

Pegasus Mail is free software, and can be downloaded from any of the following official download sites on
the Internet:

Via FTP
risc.ua.edu, in /pegasus (North American users)
ftp.usm.maine.edu in /pegasus (North American users)
pegasus.topnz.ac.nz in /pegasus (Asia and Pacific users)

Via Web Browsers
http://risc.ua.edu/pegasus
ftp://ftp.maine.edu/pegasus
ftp://pegasus.topnz.ac.nz/pegasus

Pegasus Mail is also available from many other sites on the Internet. The official sites are always 
guaranteed to have the most up-to-date versions of the program for download.

You can also visit our web pages for more information
http://www.pmail.gen.nz
http://www.pmail.com



IMAP Support in Pegasus Mail

See also: Defining an IMAP profile, IMAP troubleshooting

IMAP is an Internet protocol that allows you to access mail folders on a remote computer system. There 
are several versions of IMAP, but the most widely-used version these days is called IMAP version 4, or 
IMAP4. Pegasus Mail only supports IMAP4 servers and will not work with older servers.

To access a remote IMAP mailbox in Pegasus Mail, you use the IMAP Profiles option on the Tools menu 
to create a profile: a profile contains the name of the host computer where the mail folders reside, your 
login name and password for that machine, and a few other pieces of information.

Defining an IMAP profile

Once you have created a profile, it will be remembered from session to session and you can connect to it 
simply by selecting it in the IMAP Profiles dialog and clicking the Connect button. Pegasus Mail will open 
the Folder Manager window and will create a new root mailbox entry there, then it will login to the IMAP 
server you have defined and get a list of the folders available on that server. These folders will appear in 
the Folder Manager window list and can be manipulated and used just like any other folder within 
Pegasus Mail. This process of connecting to an IMAP server and presenting its mailbox view is called 
mounting the mailbox in technical terms.

You can create as many profiles as you wish, and you can have as many IMAP profiles mounted in your 
folder view at once as you wish. There is no reason why you cannot mount two IMAP mailboxes on 
completely different systems and drag and drop messages between their folders. Only one copy of a 
profile can be mounted at a time - you cannot create a second copy of an IMAP mailbox in your folder list 
if it is already mounted there.

To finish an IMAP session and terminate the connection to the IMAP server (or dismount the mailbox), 
right-click on the root entry for the mailbox you want to dismount and choose Remove this mailbox.



IMAP4

IMAP stands for "Internet Message Access Protocol", or "Interactive Mail Access Protocol", depending on 
which standards documents you read. It defines a set of methods that a client program can use to access 
mail folders on a remote computer system. It differs from the POP3 protocol in that it allows you to access
all your mail, instead of just your new mail; it also allows you to organize your folders into hierarchies and 
view them as if they were actually present on your computer. IMAP is inherently an online protocol - that 
is, you need to be connected all the time you are accessing your remote mailbox.

The IMAP protocol has a long and extremely muddy history: it has been through numerous incompatible 
revisions and political wrangles, and it is not until the last couple of years that it has become relatively 
standardised, as IMAP version 4, or IMAP4. An extremely dense, obscure and complex protocol, IMAP is 
very unevenly implemented from server to server, and using it is seldom completely trouble-free. 
Regrettably, for all its difficulty and weaknesses, it's still the only really viable protocol available for this 
kind of remote folder access.

Pegasus Mail implements the IMAP4rev1 protocol as defined in RFC2060.



Protocol

A protocol is simply the set of rules that determines how two systems interact. On the Internet, protocols 
control the way that a client program will interact with a server to perform a task. Protocols are the means 
by which complex tasks are handled in an orderly, step-by-step manner - in fact, we use them all the time 
in real life: when you pick up the phone and say "Hello", you are using a protocol for answering the 
phone. If you really want to confuse and upset someone, try picking up the phone and saying nothing: the
person at the other end will be bewildered by this, because you are not following the expected protocol 
(actually, don't try this too often - it's a good way to lose friends).

On the Internet, protocols are defined in standards documents that are rather oddly called "RFCs" - oddly,
because "RFC" means "Request For Comments"... You might expect that by the time something became 
a standard, you'd no longer be requesting comments about it. Still, that's the Internet for you - a strange 
place at the best of times.



Defining an IMAP Profile

See also: IMAP support in Pegasus Mail

An IMAP profile contains the information Pegasus Mail needs to establish a connection to your remote 
mailbox.

Profile name:    The name Pegasus Mail should display for this entry in the IMAP Profiles dialog box and 
in the Folder Manager window. You can call your profile entry anything you wish.

IMAP Server address:    The Internet name of the machine to which Pegasus Mail should connect in order 
to access your remote mailbox. The machine must be running a piece of software called an IMAP4rev1 
server - ask your ISP or network administrator to confirm that this piece of software is available on the 
machine before trying to connect to it. You can enter either a name (like myhost.mydomain.com) or an IP 
address (like 225.198.64.37) in this field.

Server port:    This is, if you like, the number of the socket on the remote machine where Pegasus Mail 
should "plug in" to access the server. In most cases, this should be left at its default value, 143, but on 
rare cases, your ISP or network administrator may tell you to use a different port number.

Timeout:    This controls how long Pegasus Mail should wait for responses on your network before 
assuming that a problem has occurred. For more information on timeouts, click here.

Login name:    The name Pegasus Mail should use to login to the server.

Password:    The password matching the login name you gave. When you type in your password, it will 
display as asterisks. Type the password in twice, once in each of the fields provided, so that Pegasus Mail
can check that you have typed it correctly.

* HINT: You can leave any of the username, the password or the server address blank, and Pegasus Mail 
will prompt you for them when you connect using the profile.

Mailbox reference:    This field is not usually required, but some servers may require assistance in locating
the directory where your mail folders are located. For example, on some unix IMAP servers, you may 
need to give the path to your mail directory, as ~myname/Mail, in this field. In general, you should only 
enter a value in this field if instructed to do so by your ISP or network administrator.

Periodically update the INBOX view    "INBOX" is the name most IMAP servers give to the folder where 
new and unread mail is placed on arrival. If you want Pegasus Mail to check this INBOX folder 
periodically to see if new mail has arrived for you, tick this control and enter a number of seconds 
between checks in the field labelled every xx seconds. Performing periodic checks requires a TCP/IP 
connection, so if you are using a dialup link to the Internet, you will need to experiment to see whether 
this option is useful to you. You should generally not set a periodic check period shorter than fifteen 
seconds.

This server supports folders within folders:    Some IMAP servers will allow you to create mail folders 
inside other mail folders along with the messages they contain, while some will not. Servers that do not 
allow folders within folders will create trays that can contain folders, just like Pegasus Mail's standard 
folder view. Checking this control helps Pegasus Mail to work out how it should go about creating folders 
for you on the server. At the time of writing, the following common IMAP servers do support folders within 
folders (i.e, this control should be ticked if you are using one of these servers): Netscape IMAP Server, 
Microsoft Exchange IMAP Server, Novell GroupWise IMAP Server, Cyrus IMAP Server. Most unix-based 
IMAP servers, especially the University of Washington UW-IMAPD reference server do not support 
folders within folders, and hence this control should be left unticked if you are accessing one of these 
servers.



Pegasus Mail displays a folder that can contain other folders as a hybrid item in its folder manager 
window - it looks like a regular mail folder icon (three stacked letters) but has the [+] toggle control that 
allows you to see the other folders it contains. Double-clicking one of these hybrid folders will open it and 
display its messages, as will highlighting it and clicking the open button. Use the [+] toggle or the left/right 
arrow keys to display any other folders that may be nested inside the item. You can also right-click the 
entry and select Expand or collapse entry to display the contents of the folder without actually opening it.

Always connect to this profile at startup:    If this control is checked, Pegasus Mail will mount this profile in 
your Folder Manager window automatically each time you run the program.

Only get folder status for INBOX when connecting    Usually when you connect to an IMAP server, 
Pegasus Mail will ask the server for status information about each of your folders. It does this in order to 
present you with the total number of messages and unread messages in each folder. Processing these 
status requests can be quite slow, especially across dialup links: if you are finding that it takes a long time
to connect to your IMAP mailbox, or if you only want to make a quick check for new mail, tick this control 
and Pegasus Mail will only ask for status on the server's INBOX (or new mail folder). This can result in a 
marked improvement in performance when connecting, at the price of not knowing how many messages 
are in any of your IMAP folders except your INBOX.



IMAP Troubleshooting

The IMAP protocol is large, complex and dense, and offers considerable scope for problems. Many IMAP 
servers have unusual or even sometimes incorrect implementations of the IMAP protocol standards. This 
section covers some of the more common problems you might encounter when using IMAP support.

* How do I send mail using IMAP?
You don't. IMAP is only a protocol for accessing folders and does not provide any facility for sending mail. 
To send mail, you need to use the SMTP protocol - so, simply fill out your e-mail address and the Settings
for sending mail in the Network Configuration preferences page. You do not need to fill in the Settings for 
receiving mail section if you only access your mail via IMAP, but there is equally nothing to prevent you 
from using both IMAP mailboxes and POP3 mailboxes simultaneously.

* I can't connect to the IMAP server I've specified.
- Make sure that you have entered the IMAP Server address correctly
- Make sure that there is actually some IMAP Server software running on that machine
- Make sure that the TCP/IP port is correct - the default is 143, but some systems may use other values. 
Consult the machine's administrator to find the proper port value.
- Make sure that the IMAP Server is an IMAP4rev1 server - this is important.
- Pegasus Mail uses only the simple LOGIN command to login to the server. In rare cases, you may 
encounter servers that will only accept encrypted or secure logins. In this case, you will need to see if the 
system administrator will enable normal logins.

* When I create a folder, I can't create other folders within it.
- Make sure that This server supports folders within folders is checked in the profile definition for the 
server you are accessing.

* When I open a folder, all the messages are from unknown with no subject
- You are probably using the Novell GroupWise 5.5 IMAP server, which responds incorrectly to some of 
the commands sent by Pegasus Mail. Contact Novell to see if there is a patch for their server to correct 
this problem.

* All other problems
- Diagnosing IMAP problems is complex, but Pegasus Mail provides a powerful tool to help you do it. Add 
-Z 32 to the Pegasus Mail commandline (note that there is a space between the Z and the 3). This puts 
Pegasus Mail into TCP/IP debugging mode the next time it is run. In this mode, it will create 
comprehensive transcripts of all the data exchanged between it and the server to which it is connecting. 
Generate the problem you are experiencing, then exit from Pegasus Mail. In your home mailbox directory,
you will find a number of files with the extension .WPM: these are text files that contain the transcripts of 
each session opened with a server. Locate the transcript file that was generated at the time the error 
occurred, and send it with your manual license number to tech-support@pmail.gen.nz.



Attaching Identities to Folders

See also: Identities; The Folder Manager Window

Pegasus Mail allows you to associate a particular identity with any of your    folders; then, when you 
forward or reply to a message from that folder, the settings from the associated identity will be used for 
the message instead of the current default identity.

To see why you might use this feature, consider the situation where you have filtering rules that move all 
mail from a particular mailing list into a folder. You may wish to ensure that particular settings (such as 
your signature, or the use of MIME features) are applied in a particular way when you reply to messages 
from that list. By associating an identity that has these settings with the folder into which the mail is 
filtered, you can ensure that the proper settings are always used, no matter what default identity is 
currently selected.

To associate an identity with a folder, right-click the folder in the Folder Manager Window, then select Set 
default identity for entry. You can also associate an identity with a mailbox entry in the Folder Manager 
Window: when you do this, the identity will be used for all folders in that mailbox, even ones created after 
you make the selection.



Message Templates

Imagine that you're the web master for your Internet site; you receive a huge amount of mail for much of 
which the answer is essentially the same... You laboriously reply to the message, remove the pieces you 
don't want, type in your canned response, then send the message. Wouldn't it be good if there was some 
way of automating all of this? Well, there is -- Message Templates.

A Message Template is simply a script that tells Pegasus Mail how to compose a mail message. The 
template script commands allow you to set any address or feature field, include the original message for 
replies (or a portion of the message), change or modify addresses, add attachments and generally give 
you complete control over the shape of your automatically-generated message. What's even better, you 
can define variables in templates: when you use the template, Pegasus Mail will prompt you for values for
the variables it contains; the script language can then take the values you enter, manipulate them, and 
insert them seamlessly into the generated message.

Using a message template, you can generate a complex mail message and send it with only a couple of 
keystrokes.

Types of templates, and how to create them
Using templates within Pegasus Mail
The template script language



Types of templates, and how to use them

Pegasus Mail supports two types of templates - those used to create new messages from scratch, and 
those used to create replies to messages. Template files are simply plain text files containing template 
script language commands, one per line.

Templates used to create new messages have the extension .PM5; the name portion can be anything you
wish.

Templates used to create replies to messages have the extension .PM6; once again, the name portion 
can be anything you wish.

For both types of template, the script language's TITLE command must be the first line in the file, so that 
Pegasus Mail can show the name in its selector window. Pegasus Mail will not burrow through a template 
file looking for a TITLE command if it is not on the first line.

Template files can be located in your home mailbox directory, or may be placed in the same directory as 
the Pegasus Mail executable program, in which case they become system-wide and are made available 
to all users running that copy of the program. There is no effective limit on the number of templates you 
can define.

For now, in order to create a template file you must use a text editor of some kind - for instance, the 
Windows NOTEPAD applet. If you use NOTEPAD, make sure that the Wordwrap option is turned off - 
each line in a template file must contain a single command and you cannot run lines together. Future 
versions of Pegasus Mail may include a user-interface for creating template files.



Using templates within Pegasus Mail

You can create a new message using a template by selecting Template... from the New Message 
submenu of the File menu. This will open a dialog listing all the templates available on your system. 
Select the template you want to use by highlighting it and clicking Open, or by double-clicking it. A window
will open prompting you for any variables the template uses; at this point, you can choose whether to 
open a new message editor window filled out with the message created by the template, or simply to send
the message without further ado.

You can use a template to create a reply to a message in one of two ways:

1: Right-click the message and choose "Reply using template..." from the popup menu
2: Highlight the message, then hold down <Shift> as you press the "Reply" button, or else hold down 
<Shift> and press the R key.



The message template script language

The script language used by Pegasus Mail templates is very simple. Each command in the file must 
appear on a single line of its own -- commands may not wrap lines, nor may more than one command 
appear on a single line. Lines starting with \, * ; or # are treated as comments and are ignored.

Command substitutions: practically any string parameter to a script command can contain command 
substitutions: these are special character sequences that are replaced by variables or other information 
when they are encountered. Click here for a list of the substitutions recognized by Pegasus Mail.

The following commands are valid in template scripts: click on any item for a complete description of its 
use and syntax.

title Set the title for a template script
helpfile Set the help file for a template script
picture Add a picture to the variable prompt dialog
text Add a line of informational text to the prompt dialog

string Create a string variable for the script
set Set a message field or variable value
insert Write a formatted line into the message body
include Include a file or the original message body
attach Attach a file to the message

extract Extract elements from an e-mail address
lookup Look up an item from a list using a key value



The following command substitutions are recognized in template scripts; note that some of these differ 
slightly from the substitutions used in user-defined gateways.

~vvariable_name~ The current value of a variable
~z A single newline (CR/LF)
~f The "from" field of the original message
~s The "subject" field of the original message
~r The preferred reply address for the message
~kfieldname~ Any field from the original message
~n The current user's basic username
~i The current user's Internet e-mail address
~8 The current user's username truncated to 8 chars
~p The current user's personal name preference
~d A random integer expressed as 4 hex digits
~y The current date and time in RFC822 format
~%name% The value of environment variable %name%
~lname~l The user's address looked up from a synonym file
~a The Pegasus Mail executable directory
~h The current user's home mailbox
~w The current user's new mailbox
~~ A single tilde (~).



title <string>
Set the title for the script file. string can be any string up to 50 characters in length, and can contain all 
command substitutions except for variables, which are not defined at the time this command is 
processed.



helpfile <filename> [section]
Set the help file which should be accessed when the user clicks the Help button in the variable prompt 
dialog. filename should be a full reference to any valid Windows Help file (*.HLP) on your system, and 
may contain all command substitions except for variables, which will have not been defined at the time 
this command is processed. section is an optional integer value that indicates the context help section 
within the help file that should be presented when the help button is pressed. If it is absent, section 0, the 
table of contents, is presented.



string <name> ["Default"] ["Prompt"] [len] [flags]
Define a variable for use within the script. A maximum of 20 variables may be defined for any script. name
is the name for the variable; it must not contain spaces, and is not case-sensitive (so var1 and VAR1 are 
considered the same). All the parameters following the name parameter are optional and can be omitted if
you wish. default is a string which should be used as a default value for the variable. If it contains 
spaces or special characters, it must be enclosed in quotes. If this parameter is omitted, the default value 
is an empty string. prompt is the string Pegasus Mail should place next to the editing field in the variable 
prompt dialog. If omitted or zero-length, Pegasus Mail will not prompt the user for a value for this variable.
len is an integer defining the maximum allowable length of this variable. If omitted, the default is "no limit".
flags defines the format and type of the variable: the following flag values are available - multiline 
(creates a multi-line variable); address (creates an e-mail address variable); filename (creates a 
filename variable); password (creates a password variable); list (creates a list - click here for more 
details) uppercase (specifies that the variable must be all uppercase characters). Only uppercase may
be used with other values.



Creating LIST variables

When you use the LIST flag in a STRING statement, you create a variable that has a list of possible 
values from which the user can select. LIST variables require that you provide a DEFAULT value for the 
variable, which contains the list of possible values the variable can have. The first character in the default 
value should be the character used to separate the list items from each other, and the remainder of the 
default value should be the items, separated by that character.

Example: you want to allow the user to select from the values "Red", "Green" and "Blue": your string 
statement would look like this:

string v1 ";Red;Green;Blue" "Select a colour" 0 list



set <field> = <"value">
or set variable <variable_name> = <"value">
The first form of this command sets a field within the mail message being generated to the specified 
value. field may be one of the following: 

to, cc, bcc, reply-to, subject (all take a string value)
urgent, confirm-reading, confirm-delivery, copyself, mime ("Y" or "N")
header (a fully-formed e-mail header including the keyword)
volatile (forces the message to be written to final form immediately)
encrypted ("encryptor_name", "password", "flags") click here for details

The second form of this command sets the value of any defined variable.

Both forms of this command support all command substitutions for the value parameter. To copy the 
value of one variable to another, use an expression containing the ~v command substitution, like this:

set variable v1 = "~vv2~"



insert <"string">
Write data into the body of the message being generated. string can contain any command 
substitution: if it does not contain a ~z substitution to force a line break, then the next insert command 
will write data onto the same line in the body. A single insert command may not insert more than 1024 
characters into the message body.



include <filename> [count] [flags]
or include message [count] [flags]
Include either a text file, or the body from the message to which a reply is being generated. The text from 
the file or message is included as-is into the message body - command substitutions are not performed 
on the included data. The filename parameter may contain any command substitutions. If count is 
present and non-zero, only that many lines of the included file or the body of the included message will be
read. flags can be any combination of the following values:

quoted "Comment-out" the included text using "> "
noheaders If the file is a message, omit its RFC822 headers
keyheaders If the file is a message, include only "significant" headers
nobody If the file is a message, omit the message body
message Only valid for files: the file is an RFC822 message



attach <filename> [type] [encoding] ["Desc"]
Attach a file to the generated message. Only filename is a mandatory parameter - the others can be 
omitted and are sensibly defaulted. Any valid command substitution can be used in the filename. If the 
filename contains spaces, it must be quoted. type is any string describing the type of the file - for 
instance, "RTF_FILE". It must not contain spaces and is not constrained to the list of possible values 
inside Pegasus Mail itself. encoding is an integer value that specifies how the file should be encoded for
transfer; the following values are defined - 0 (Pegasus Mail decides), 1 (No encoding - very dangerous), 2
(ASCII text), 3 (UUencoding), 4 (BinHex 4.0) and 5 (Basic MIME encoding). Unless you are sure of what 
you are doing, use 0 for this field. desc is a textual description of the file; it may contain any text, 
including spaces, and is truncated at 63 characters.



picture <flags> <filename>
Add a picture at the top of the variable prompt dialog. The picture specified by filename must be a 
Windows BMP file in 16 or 256 colours: owing to quirks in the way Windows handles 256 colour bitmaps, 
we strongly recommend that you use 16-colour bitmaps if your display runs in 256 colour mode or lower. 
For the Win16 version of Pegasus Mail, the bitmap must not be larger than 60,000 bytes. You may use 
any command substitution in the filename parameter. The bitmap is centred horizontally in the display and
the dialog will adjust size to fit the vertical dimensions of the image. Exactly one image may be added to 
the dialog.

flags will be used in future to offer extra formatting options. For now, it is unused and should be set to 
zero.

Note: if filename contains spaces or special characters, it must be enclosed in quotes.



text <flags> <"string">
Add a line of descriptive text to the dialog presented to prompt for script variables. The line of text is 
added above any variable editing fields, and below any picture defined using a picture command. You 
may specify up to 10 lines of descriptive text, and each line may contain any valid command substitution. 
The flags parameter will be used in future, but should currently be set to zero.

To introduce a blank line between groups of lines, use a text statement with an empty quoted string - 
like this: text "".



encrypted "encryptor", "password", flags
When encrypting a template message, use the encrypted parameter to the set command. encryptor
is the name of the module which should be used for encryption - to use the Pegasus Mail built in 
encryptor, use the name builtin. password is the password for the message - this can be up to 96 
characters in length. flags controls the type of encryption performed; to encrypt a message, set it to 1; 
to add a digital signature to the message, set it to 4; to perform both operations, set it to 5.



extract address <var1> <var2>
extract text <var1> <var2>
extract user <var1> <var2>
extract domain <var1> <var2>
Extract a component from an e-mail address. var1 refers to the variable containing the address to be 
manipulated. var2 is the variable where the result of the manipulation should be placed - it can be the 
same as var1.

extract address yields the minimum form of the e-mail address
extract text yields the personal name field from the address
extract user yields the simple user name portion of the address
extract domain yields the domain portion of the address



lookup "string" <var1> <var2> <var3>
Attempt to locate the string string in the list variable var1; if a match is found, note the position in the 
list where the item was matched, then copy the item at the same position in the list variable var2 into the 
variable var3. For more information on list variables, click here. It is an error for either var1 or var2 to 
be anything other than a list variable. If string cannot be found in var1, variable var3 is not changed.

Example: list variable v1 contains "Monday", "Tuesday" and "Wednesday"
list variable v2 contains "Open", "Closed" and "Open".

The command lookup "Tuesday" v1 v2 v3 will result in variable v3 containing the value 
"Closed".

A common form of this command will use the current value of var1 as the string parameter, using the 
command substitution ~vvar1~.



Setting a password for your mailbox

VERY IMPORTANT!!    Please read this section carefully: the author of Pegasus Mail cannot be held 
responsible for breaches of security on your network, so it is very important that you understand the level 
of protection that is actually available to you.

If you are running in an environment for which Pegasus Mail has a specific Network support module, you 
can normally use the password protection options of the network to protect your mailbox. In environments
of this kind, such as Novell NetWare, the level of password protection offered by Pegasus Mail is very 
strong.

In environments for which Pegasus Mail has no specific network support, you can still add a password to 
control access to your mailbox, but the protection it offers you may be more limited. Pegasus Mail has to 
store the information it needs in order to validate your password somewhere, which means that anyone 
with the ability to modify files in your mailbox directory may be able to bypass the password you have set.

In environments such as Windows NT, where the operating system provides security facilities to control 
who can access your mail directories, the password scheme used by Pegasus Mail can be quite reliable. 
In environments where the operating system provides less or no backing security, Pegasus Mail's 
password scheme can often be circumvented.

Specific cases:

* Windows NT Server 4.x:    The directory permissions on your mailbox should be set so that anyone can 
Add files to the directory (in order to deliver mail), but only you can view, change or remove the files that 
are there. With these permissions in place, Pegasus Mail's password scheme provides good security.

* Windows 95/98 Peer-to-peer Networking:    The operating system provides no effective security. 
Pegasus Mail's password scheme is vulnerable and can be bypassed. Do not rely on it to protect your 
mailbox from prying eyes.

* A single computer running Windows with multiple Pegasus Mail users:    The operating system provides 
no security at all. Pegasus Mail's password scheme can be easily bypassed and offers little security of 
any kind.

* Other cases:    If other users can add files to your mailbox directory but cannot change or remove the 
files that are already there, then Pegasus Mail's password scheme will provide you with good levels of 
security. If other users can change or delete files that already exist in your mailbox directory, then 
Pegasus Mail's password scheme will not provide you with effective security.



Reporting preferences

This preferences page controls the way Pegasus Mail reports information to you, most particularly about 
new mail as it arrives on your system.

New mail reporting
System messages and logging



New mail reporting

See also: System messages and logging

The options in this section control the methods Pegasus Mail uses to advise you that you have new mail. 
There are three separate options you can enable, each of which works independently of the others: one 
option or combination of options will probably suit you better than the others.

Notify of new mail using a floating telltale window    When you check this option, Pegasus Mail will report 
the arrival of new mail by popping up a small window above all other windows in your system. This small 
window, or "telltale", reports the number of new messages available in each source known to Pegasus 
Mail - this includes your new mail folder, the new mail folder of any other mailboxes you have mounted, 
your POP3 server, and IMAP folders you have mounted in your folder list.

Place an icon in the Windows System Tray (Win32 version only)    When this control is checked, Pegasus 
Mail will add its icon to the Windows system tray when you minimize it. You can reactivate Pegasus Mail 
at any time by double-clicking the system tray icon. This option has three sub-options:

Animate the icon when new mail arrives    The system tray icon will flap its wings when you have new mail
(we think this looks pretty neat). If the telltale window (see above) is disabled, right-clicking the system 
tray icon will open the telltale with a report about the new mail waiting for you.

Only display the icon when Pegasus Mail is minimized    When this control is checked, the system tray 
icon will only be added to the system tray when the program is minimized to the task bar. If you have 
many system tray icons, you may prefer this effect.

Hide the Pegasus Mail taskbar entry when minimized    When this control is checked, the regular Pegasus
Mail button on the Windows taskbar will be hidden when the program is minimized, leaving only the 
system tray icon to indicate that it is running. Enabling this option saves space on the task bar, but means
that you cannot use Alt+Tab to switch back to Pegasus Mail - you can only switch back by double-clicking 
the system tray icon.

Play a new mail alert sound  When you check this control, Pegasus Mail will play whatever sound you 
choose when new mail arrives. The sound can be any valid Windows .WAV file on your system. You can 
select the sound Pegasus Mail should use by clicking the Select sound button, and test the currently-
selected sound by clicking the Test button.

Only play the sound if Pegasus Mail is minimized    If you find the sound annoying when you are actually 
working within Pegasus Mail, check this control and the alert sound will only play when mail arrives while 
Pegasus Mail is minimized to the Windows task bar.



System messages and logging

See also: New mail reporting

Pegasus Mail keeps a running log of events that occur while it is running - you can inspect this log at any 
time by choosing System Messages... from the Window menu. This group of controls manages the 
behaviour of the System Messages window and the way event information is reported to you.

System message reporting level    This controls the verbosity of the information reported in the System 
Messages window. Level 0 disables reporting altogether, while level 5 is typically used to report low-level 
program status information. There is usually no reason to adjust this control from its default level 3 
setting. At level 3, Pegasus Mail reports useful things, such as the results of mail filtering operations and 
POP3 downloads.

Show System Message window after applying filtering rules    If you check this control, Pegasus Mail will 
automatically open the System Message window any time filtering rules are applied to a folder and affect 
at least one message. This is a useful way of seeing at a glance what actions the filtering system has 
taken with your messages.

Keep a log of messages sent (in SYSLOG.PM file)  When this control is checked, Pegasus Mail will 
create a log entry every time you send a mail message. The log entry contains detailed information about 
the recipient, subject and message settings used for the message, and is stored in a file called 
SYSLOG.PM in your home mailbox. SYSLOG.PM uses a tab-delimited format designed to be imported 
into database programs or spreadsheets for analysis. The file will be created automatically if it does not 
exist, and will continue to grow until you explicitly delete or edit it.



Selecting messages

"I want to select all the messages from David that are older than 15 days, don't have any colour set on 
them, and aren't marked as urgent"

How often have you found yourself in a situation where you want to perform a complex selection 
operation like this? If you've ever needed to do it, then you've *really* needed it - and this screen allows 
you to perform this kind of search. Using this option, you can select messages in a folder based on 
arbitrarily complex sets of rules. You can either simply select messages (useful if you want to move them 
or delete them), or more powerfully, you can take the selected messages and have them sort together at 
the top of the folder as a group: this facility allows you to gather together messages based on complex 
relationships and manipulate them as a group.

Although the screen probably looks rather intimidating, the process of setting up a complex selection is 
really very simple: you just create selectors, or rules that will either match or not match specific 
messages, then click the Select button. You can have as many selectors as you need, and you can link 
selectors together (so that more than one condition must be true before a match is made).

To create a selector, simply click on one of the buttons on the left-hand side of the window. You can select
messages based on their addressing, subject field, age, size, colour, or message attribute; or you can 
simply select messages containing any piece of text you choose. Each of the selector buttons opens a 
small editor window where you enter the condition that must be true for the match to occur. These editor 
windows are simple to use. When you click the OK button in the editor window, your selector will be 
added to the list of selectors at the right of the window.

Linking selectors    If you need to specify a match that depends on more than one selector being true (for 
instance: "Message is smaller than 20000 bytes" and "Message is older than 14 days") then click the And 
button after you add each selector. This will add an And line in the list of selectors showing that the 
selectors are joined together. If you do not use And lines to connect selectors, then any selector that 
matches a message will select that message.

Negating selectors    If you want to negate a selector (for instance, "Select messages that are not from 
david"), then highlight the selector in the list and click the Not button. Clicking the Not button again will 
reverse the condition.

Saving and loading selector lists    The selector list you create is remembered each time you open this 
window during a session, so you can re-use a selector set on different folders without having to re-enter it.
If you want to save a selection set so that you can use it again in future, simply click the Save button 
when you have finished assembling it, and give it a filename. You can re-load a selector set you have 
previously saved at any time by clicking the Open button and choosing the file.

Selection actions  The two radio buttons underneath the selector list allow you to choose what Pegasus 
Mail should do with messages that get selected by your selector set. Highlight all matching messages 
found in folder simply marks the messages, ready for any folder operation that works on multiple 
messages, such as Move, Copy or Delete. Sort matching messages to top of folder will re-sort the folder 
so that the selected messages are placed at the top of the folder above all other messages. The selected 
messages are sorted using the current sorting option for the folder.



Internet options

Pegasus Mail contains all you need to send and receive mail from the Internet, either from a LAN 
connection, or using a dial-up connection to an Internet Service Provider. In order to handle your Internet 
mail for you, Pegasus Mail typically needs some information about you, and the machines it needs to 
contact on your behalf. Pegasus Mail's Internet Mail support has a rich range of features, covered in the 
sections below.

Overview of Internet Mail operation
General Internet Mail settings
Receiving mail via the POP3 protocol
Sending mail via the SMTP protocol
Dialling control

How to retrieve and send mail using Pegasus Mail

Advanced topics:

Troubleshooting
Accessing multiple remote mailboxes - MultiPOP
Windows Sockets configuration issues



Overview of Internet Mail Operation

Internet mail is based on a concept called store and forward - that is, the message is received by a 
system on your behalf, and stored there until you are ready to receive it, at which time it is forwarded to 
you. Mail programs such as Pegasus Mail are responsible for approaching larger machines (called 
servers) and asking them to store a message (send it), or to forward a message (receive it). It is the 
process of storing and forwarding mail that allows you to turn your computer off, or disconnect your 
Internet session - without store and forward, if your machine was unavailable, there would be nowhere to 
deliver the mail.

The Internet is simply a whole lot of telephone cables: data gets transferred across these telephone 
cables between computers... Now, imagine what happens when a person in England makes a telephone 
call to a person in China: unless the two people have a language in common, they won't be able to 
understand each other... The same is true with computers: in order to understand each other, they need 
to talk the same language. On the Internet, these languages are called protocols - they are the rules that 
control how different systems communicate with each other.

Internet electronic mail is governed by a number of these protocols, but the two most commonly-used are 
POP3 and SMTP. POP3 stands for Post Office Protocol version 3, and is the language two computers 
use when one wants to retrieve a mail message from a mailbox located on the other. SMTP stands for 
Simple Mail Transfer Protocol, and is the language two computers use when one want send a mail 
message to the other. Practically all Internet mail programs, Pegasus Mail included, support these two 
protocols.



General Internet mail settings

Your e-mail address is    Enter your electronic mail address here. Your electronic mail address will usually 
be in the form username@host.domain - enter the whole address here.

TCP/IP timeout settings - This controls how long Pegasus Mail should wait for responses from remote 
computers before deciding that there has been a connection failure and giving up: click here for more 
information.

Easy setup, step by step    This option will start the Pegasus Mail Internet Setup Wizard, a series of 
windows that take you step by step through the process of entering the information Pegasus Mail needs 
in order to handle your Internet e-mail. If you are new to the Internet, we strongly suggest you use this 
option to setup Pegasus Mail. You can use the setup wizard to configure Pegasus Mail the first time you 
run it, or to change your existing information if you ever need to do so.

Return to the Internet Options help page



Receiving mail via the POP3 protocol

The entries in this screen control the way Pegasus Mail will download new mail for you via the Internet's 
POP3 protocol.

General settings for receiving mail via POP3

POP3 host  The name of the machine from which Pegasus Mail should retrieve your new mail. The format
of the address you provide here depends on your WinSock implementation: many will allow you to enter a
normal internet name (for example, parnassus.pmail.gen.nz), but some may require that you enter the 
address in dotted notation (for example, 192.156.225.2). Consult your system manager or WinSock 
manual if you are unsure which form to use.

Username    The name of the account on the machine under which mail is being held for you. Pegasus 
Mail logs into the host using this account name and retrieves any mail waiting there. Pegasus Mail only 
wants your username in this field, not your address - if what you have entered here contains an '@' 
symbol, then it is probably incorrect.

Password    The password for the account on the host. The password is not displayed on the screen and 
is stored in an encrypted format in your configuration file.

Advanced POP3 settings

Connect to POP3 server on TCP port    The TCP/IP port on which the server listens for your connections. 
The default for this field is 110, which is the port defined by the POP3 standard. On rare occasions, your 
POP3 server may listen for connections on a different port number, in which case you would enter that 
port number here. You should only change this value if advised to do so by your service provider, network
administrator, or by Pegasus Mail technical support.

Do not download mail larger than x KB If you are connected to the mail host by a slow TCP/IP link (such 
as a SLIP link) then downloading large messages can be very time consuming. If you enter a value in this
field, Pegasus Mail will not attempt to retrieve any mail larger than the size you specify (in kilobytes) - it 
will be left untouched on the host. A value of 0 in this field means no limit - Pegasus Mail will download all 
mail. 

Note: when a message is too large to be downloaded, Pegasus Mail will create an entry in the System 
Messages window advising you of this fact - this is the only indication you will get that messages were left
on the server. You can then choose to download the oversized messages using Pegasus Mail's Selective 
download feature, on the File menu.

Check for new POP3 mail every x secs    This option controls whether or not Pegasus Mail should poll 
your POP3 host for new mail automatically, and if so, how often. Enter here a number of seconds 
between poll cycles (Pegasus Mail is accurate to the nearest three seconds), If you check the Idle control 
next to this, then Pegasus Mail will wait until it has been idle (no keystrokes or mouse presses) for this 
length of time before it will automatically check for new mail. If the Idle control is unchecked, then checks 
will occur at regular intervals, regardless of activity. A value of zero means that Pegasus Mail should 
never poll the POP3 host automatically – you will have to initiate the check yourself by choosing "check 
host for new mail" from the File menu.

Count new messages when polling but don't download    If this control is checked and you have set an idle
poll cycle (see the last entry) then Pegasus Mail will simply check the number of new mail messages on 
each idle check and report that number on the status bar. If this control is unchecked, Pegasus Mail will 
automatically download any new mail it finds on the host on each idle check. On slow links, checking this 
control can result in a lower performance demand on your machine.

Delete mail from host once successfully retrieved    If you check this box, Pegasus Mail will delete the 



host's copy of each mail message it successfully downloads, which will prevent it from being presented to 
you again the next time you retrieve mail. Leaving this box unchecked tells Pegasus Mail to leave the mail
on the host even if successfully downloaded. Mail left on the server will be retrieved every time you 
download mail.

Check whenever the new mail is opened    If you check this box, Pegasus Mail will check the host for new 
mail every time you open the new mail folder or click the New Mail button in the button panel. If you leave 
this button unchecked, then Pegasus Mail will only check for new mail when you explicitly choose Check 
host for new mail from the File menu.

Download only unread mail    The usual practice when retrieving mail from a POP3 host is to delete it from
the host when it is successfully downloaded. If you do not delete it, you would normally expect to see it 
again the next time you download mail from the host. Pegasus Mail incorporates a powerful and 
complicated facility which allows you to leave mail on the POP3 host without deleting it, but only 
download mail you haven't already seen. Because the POP3 protocol does not actually provide this 
facility, there are some limitations on this command, the most specific being that if you run Pegasus Mail 
on more than one machine, each one will have a separate list of what you have already seen; so, if you 
download mail using one machine then access your account later from a different machine, you will 
probably get the mail you downloaded the first time again, where downloading the mail on the same 
machine you originally used would only show mail which had arrived since the last time you accessed 
your account. Check this control to instruct Pegasus Mail to attempt to download only mail you have not 
read. The effect of this control is probably meaningless if you do not also uncheck the "Delete retrieved 
mail on host" control. Using this feature can significantly increase the time it takes for Pegasus Mail to 
retrieve your new mail.

APOP shared secret    Pegasus Mail supports a POP3 command called APOP, which allows you to 
connect to a POP3 server without transmitting your password over the network in plain text. In order to 
use the APOP command, your POP3 server also needs to support the command, and you need to have a
special word or phrase known both to you and to the POP3 server: this special word or phrase is called a 
"shared secret". If your ISP or network administrator tells you that your POP3 server supports the APOP 
command, then you can enter your APOP shared secret here and Pegasus Mail will use it to connect to 
the server. Note: your APOP shared secret is almost never the same as your regular password: if you are 
unsure what to enter in this field, either leave it blank, or else ask your ISP or network administrator for 
assistance.

Checking multiple mailboxes see also Identities

When checking for mail, perform checks for all identities    If this option is checked, then when you check 
for new POP3 mail, Pegasus Mail will go through all the identities you have currently defined and will 
perform a new mail check for each of them. Individual identities can be excluded from this multiple check 
operation by checking the Exclude this identity from multi-identity checks box. Identities where the same 
username and host are specified will only be checked once -- Pegasus Mail is smart enough not to 
perform redundant checks. Note that this setting itself is identity-specific - it can be set or unset 
depending on an identity-by-identity basis; so, for some of your identities you can have the program set to
check all your identities while for others, only the current identity is checked. You can temporarily override 
the setting of this flag by holding down the Ctrl key as you select Check host for new mail from the File 
menu, or as you click on the toolbar button for the same action. So, if you have turned on Check mail for 
all identities, holding down Ctrl when you do a check for new mail will check only the current identity. 
Similarly, if this control is not turned on, then holding down Ctrl when you do a check for new mail will 
force a check for all your identities.

Exclude this identity from multi-identity checks    When this box is checked, then the current identity will be
excluded from any POP3 mail check that operates on all your identities (see the preceding entry). If When
checking for mail, check for all identities is not checked, this control has no effect.

Return to the Internet Options help page





Sending mail via the SMTP protocol

The entries in this screen control the way Pegasus Mail will send mail on your behalf using the Internet's 
SMTP protocol.

General settings for sending mail via SMTP

SMTP host    Enter here the name of a machine which can process outgoing mail on your behalf. This is 
usually the same machine you entered as your POP3 mail host, and the address is subject to the same 
restrictions and rules described there. Pegasus Mail asks this machine to send outgoing mail on your 
behalf, so the machine you name must be running an SMTP server; your system manager or service 
provider will be able to tell you which machine or address to use for this field.

Advanced SMTP settings

Connect to SMTP server on port    Specifies the TCP/IP port Pegasus Mail should connect to when 
sending mail. The default value for this field is 25, and you should usually only change it if you are using a
proxy server or firewall, or on the instructions of your network administrator.

Use the e-mail address I supplied for the SMTP envelope. [Warning: this section is rather technical and 
loaded with jargon - sorry about that... ]    An Internet Mail message consists of two sections - the 
message and the envelope. The envelope is a kind of "wrapper" of delivery information that is passed 
from SMTP host to SMTP host, and includes information about the sender and recipients of the message 
in transit. You will usually never see the envelope, as it is discarded once the message is actually 
delivered. The only remnant of the envelope in your message is a special field amongst the message 
headers called Return-path, which contains the authenticated address of the original sender of the 
message. The Return-path information is usually only used by SMTP servers to handle errors, but 
unfortunately there are some mail systems on the Internet that ignore your "From" field address and 
instead send replies to whatever value is stored in the Return-path header. By default, Pegasus Mail 
forms the return-path header from your POP3 username and server information, since it knows this 
address is valid. In some cases, though, your POP3 address information may not be valid in the outside 
world - it might only be valid when you contact your Internet Service Provider directly. In cases like this, 
the small group of aberrant mail systems on the Internet may end up trying to reply to you using an 
address that is not valid. Checking this control tells Pegasus Mail to form your Return-path headers using 
the information you have supplied rather than the authenticated POP3 server information. Doing this will 
on one hand probably fix the problems users on the aberrant systems are having sending replies to you, 
but on the other hand may create local delivery problems. In short, if you have someone report that they 
cannot reply to your address even though you have a valid address in the "Your e-mail address" section 
of the Network Configuration Dialog, try checking this control.

Send mail at once without placing in queue    If you check this, Pegasus Mail will send your mail 
messages to the relay host as soon as you click the Send button in the message editor. If you leave the 
box unchecked, Pegasus Mail will queue your messages, and will only send them to the relay host when 
you explicitly choose Send all queued mail from the File menu. If you are using a slow TCP/IP link, you 
should probably leave this box unchecked.

Use in preference to LAN mailer for Internet mail    This option is only meaningful when you are running 
Pegasus Mail on a NetWare system which is also served by either the Mercury SMTP transport or the 
Charon Internet mail gateway. Checking this control tells Pegasus Mail to use its own built-in mail delivery
routines instead of passing your outgoing mail to Mercury or Charon for processing. If you leave this box 
unchecked, then Pegasus Mail will always use Mercury or Charon in preference to its own SMTP delivery 
routines if either is available on the NetWare system to which you are connected. The setting of this 
control is ignored when you run Pegasus Mail in a non-NetWare environment.

Use for all outgoing mail, regardless of address:    Usually when you enter an address such as "DAVID", 
which has no domain portion, Pegasus Mail regards it as a local address and attempts to deliver it to the 



user based on the assumption that he can be found on the machine you are using. If you are the only 
person who uses your computer, however, then there will be no other users on your system and this 
assumption will not be valid. Checking this control tells Pegasus Mail to pass all mail to the remote host 
for processing and not to presume that any addresses are local to your machine. You should only check 
this control if you are the only person who uses your machine.

Send any mail in the queue during idle checks:    If you check this control, Pegasus Mail will send any 
messages waiting in your mail queue when it does an idle check to see if you have new POP3 mail. The 
frequency of these checks is determined by the setting of the Poll new mail after x secs idle field of the 
POP3 configuration section of the Network configuration dialog

Send mail before retrieving mail    Pegasus Mail normally checks for new mail using the POP3 protocol 
before sending your mail using the SMTP protocol; doing it this way allows you to read your new mail 
more quickly. If you would prefer that Pegasus Mail sent any mail in your outgoing message queue before
retrieving your new mail, check this control.

Authentication

The entries in this section enable various mechanisms for proving that you are who you say you are when
sending mail. Not all networks or Internet Service Providers will require you to use an authentication 
method, and there are three or four different methods that might be used. If you have trouble sending 
mail, consult your ISP and see if you need to enable one of these options. When you contact your ISP, it 
may help them to help you if you mention that your mailer supports several SMTP Authentication options.

Authenticate by doing a prior POP3 mail check    This is the simplest way of authenticating who you are. 
Some ISPs will log POP3 mail checks, and provided you have done such a check in the last x minutes, 
will permit you to send mail from the same address. When you enable this control, Pegasus Mail will login
to your POP3 server and immediately logout without actually retrieving mail, prior to opening the SMTP 
connection to send mail. It is harmless to enable this option, even if your ISP does not require it.

Login using my POP3 settings for username and password    If you check this control, Pegasus Mail will 
attempt to login to your SMTP server using your POP3 username and password. It will only do this if your 
SMTP server states that it will accept such a login (in technical terms, Pegasus Mail conforms to 
RFC2554, using the ESMTP AUTH command). Your Internet Service Provider will advise you if this option
is suitable for your use.

Login with username and password  If you check this control, Pegasus Mail will attempt to login to the 
SMTP server using the username and password you supply here. As with the option above, it will only do 
this if the server states that it will accept such a login. Your Internet Service Provider will advise you if this 
option is one you should use.

Return to the Internet Options help page



Windows Sockets configuration issues

In order to use Pegasus Mail's built-in support for TCP/IP mail, you must have a properly-installed 
Windows Sockets implementation installed on your system. Windows Sockets is a specification 
developed by a group of major vendors that standardizes the methods Windows applications use to 
access the Internet. Under 16-bit Windows (including Windows 95/98/NT, if you are running a 16-bit 
application), the Windows Sockets support code is found in a system file called WINSOCK.DLL. 32-bit 
applications running under Windows 95/98/NT use a system file called WSOCK.32.DLL, which is always 
located in the Windows SYSTEM directory. For the remainder of this section, we will refer to the system 
file as WINSOCK.DLL for the sake of clarity.

In order to use the Windows Sockets subsystem on your computer, Pegasus Mail needs to be able to find
your WINSOCK.DLL - it must be on the path, in the \WINDOWS directory, or in the \WINDOWS\SYSTEM 
directory. You can force Pegasus Mail to load a particular WINSOCK.DLL file using commandline options.

By default, when Pegasus Mail detects that you have a valid WINSOCK.DLL on your system, it will 
enable the built-in TCP/IP services by setting the WinSock loading option in your Advanced Settings 
preferences to On demand. This means that Pegasus Mail will only load WINSOCK.DLL when it actually 
needs to access its services. When you are using a SLIP or PPP link to connect to the Internet, most 
WINSOCK.DLL versions will dial as soon as they are loaded, so the On demand setting allows you to 
minimize your connect time when checking for mail. If you are connected to a fast local area network, 
however, you should probably consider setting the Winsock loading flag to Always, for performance 
reasons.

Regrettably, under Windows 95/98/NT, dialling is handled poorly by the operating system: in order to get 
around the weaknesses of the operating system, Pegasus Mail includes a number of options to handle 
dialling by itself - click here for more information on dialling.

If you have a valid Windows Sockets implementation installed on your system, six extra options will 
appear on your File menu. The first option, Network Configuration, allows you to configure the way 
Pegasus Mail's built-in TCP/IP mail services work for you. You can also access the network configuration 
dialog using the Internet Options entry on the Tools menu.

Return to the Internet Options help page



Message formatting preferences

See also: Preferences overview

Message editing features

Automatically check spelling before sending message    Pegasus Mail incorporates a spelling checker with
dictionaries for UK and US English. You can check your spelling in the message editor at any time by 
pressing Ctrl+K or clicking the Check spelling button on the editor toolbar. You can also have Pegasus 
Mail perform a spelling check automatically when you click the Send button - if you would like Pegasus 
Mail to do this, checkmark this control.

Automatically save messages in progress every X minutes    Pegasus Mail is a very reliable program, but 
even so, accidents can happen... If you enter a non-zero value in this field, the program will regularly save
your messages as you work on them. If the worst happens and your system crashes, you can recover the
most recent saved version of your message by choosing Open saved message from the File menu (or 
pressing Ctrl+O). Automatic saves are identified in the list of saved messages by the letters [ASV] at the 
start of the description. When you send your message normally, the automatic save is deleted.

Formatting and use of styling in messages

Pegasus Mail can generate extremely rich HTML messages containing formatting, pictures, tables and so
on. In normal operation, Pegasus Mail generates HTML only when you take an action that necessitates it 
- for instance, by marking some text in bold. You can always tell if Pegasus Mail is going to send HTML 
mail because the Rich text control in the message editor will check itself (you can uncheck the Rich text 
control to force the message to be sent as plain text). If you do not use any feature that requires the use 
of HTML, Pegasus Mail will send the message as plain text.

HTML mail is, however, somewhat controversial on the Internet - not everyone likes it, and not everyone 
uses a mail program that can understand it. Many long-time users also believe that HTML mail has no 
place in e-mail. The controls in this group allow you to control the way Pegasus Mail handles formatting 
for you.

Disable all text styling options (never send styled mail)    If you check this control, Pegasus Mail will 
become a traditional plain-text mail program for you. This has a number of side-effects: the editor toolbar 
will include a smaller range of buttons reflecting only the formatting options available in plain text 
messages; paste operations will always always paste plain text only; the right margin for your messages 
will change to an exact character-based measurement; and Pegasus Mail will never generate 
multipart/alternative or text/html messages (although it will still be able to read and display the ones you 
receive, of course).

Do not display the editor 'styles' toolbar    This control turns off the message editor's toolbar when 
checked. When the editor toolbar is turned off, the only way to check spelling in your mail is by pressing 
Ctrl+K.

Always paste plain text in preference to styled text    When this control is checked, paste operations will 
paste plain text into the message editor even if formatted versions of the text are also present on the 
clipboard. This setting is implicit if you check the Disable all text styling options control (see above).

Tabs and margins

As e-mail becomes more like word processing, with features like tables, styles, pictures and so on, so the 
end user expects that the e-mail program will behave more like a word processor. In traditional e-mail, 
margins and tab settings were always calculated in characters, but in modern systems with proportionally-
spaced typefaces, it makes more sense to use absolute measures for these settings. Accordingly, in 
normal operation, Pegasus Mail lets you specify the right margin and tab settings for your messages 



using either inches or millimetres. If you have checked Disable all text styling options (see above) then 
Pegasus Mail, will behave like an old-fashioned teletype mailer and will use characters as the 
measurements for these settings. Which of these operating modes best suits you is a matter of personal 
taste.

Message width    This setting controls how wide the column of text you type in your message should be. 
The default setting is 145mm or 5.71 inches, based on a typeface of Arial 10 point. This will result in a 
column of text approximately 76 characters wide, which should be readable by anyone. If you increase 
the size of your typeface, you may also need to increase the message width, since otherwise your lines 
will become shorter and shorter. Similarly, if you use a smaller typeface, you should make the message 
width narrower to keep the lines within a reasonable length. Experiment with these settings until you find 
a message width that you find comfortable and which produces messages your correspondents have no 
trouble reading. As a general rule of thumb, you should choose settings that result in the lines in your 
message being between 70 and 80 characters long.

Tab width    Controls the approximate distance between tabs in the message editor. The default value is 
12mm, or half an inch.

Units    Allows you to select whether measurements should be expressed in metric (millimetres) or 
imperial (inches). Pegasus Mail remembers this setting from session to session, so you only have to 
select it once.

Right margin for Ctrl+J reformatting command    Sometimes the text in your messages can become quite 
unruly, especially when you are quoting sections from an original message in a reply. Pegasus Mail 
incorporates a Reformat text command, available by pressing Ctrl+J in the editor. This command tidies up
the current paragraph, and can work with either normal text or quoted text. Because of the nature of this 
command, it always works using characters as a unit of measure, irrespective of your current margins. 
You can set the right margin used in the Ctrl+J command by entering it here.



Copy-to-self ('outbox') preferences

See also: Preferences overview
Messages and replies
Mail filtering rules

Pegasus Mail allows you to keep copies of the mail messages you send if you wish. In other programs, 
this is often called an "outbox", but in Pegasus Mail we refer to this idea as sending a copy to self. The 
'outbox' feature of other programs is usually relatively limited - typically, a copy of every message you 
send is placed into a folder called "outbox". In Pegasus Mail, however you have much more flexibility in 
deciding both whether or not a copy-to-self should be made, and if it is, where it should be stored.

To make a copy to self, check the Copy Self control in the Pegasus Mail message editor - this tells the 
program that you want to keep a copy of this message. The normal operation of this control is that it is 
"sticky" - so, once you have turned it on for one message, it will remain on for future messages until you 
turn it off. You can change this behaviour if you wish using the options on the Messages and replies 
preference page.

If a copy to self is made for a message, the options in this preference page come into play.

Default copy-to-self folder name    In the simplest case, Pegasus Mail will simply create a copy of your 
message in a folder whose name you type in this field; Pegasus Mail will create the folder if it does not 
already exist. If you wish, you can select a folder that already exists by clicking the Select folder button. 
When your current copy-to-self folder becomes too large, simply rename the folder - the next time a copy-
to-self is made, Pegasus Mail will automatically create a new one using the name you specify here.

Ask at send time whether or not to make a copy to self    You may prefer to have Pegasus Mail ask you for
each message whether or not a copy-to-self should be made - if so, check this control. When you click the
Send button, Pegasus Mail will ask you whether or not a copy should be kept: if you choose "yes", then 
the other options in this preferences page will apply. When this option is enabled, the Copy self control in 
the message editor window will be greyed out.

If making a copy to self, ask at send time which folder to put it in    When this control is checked, Pegasus 
Mail will ask you to select a folder into which the copy to self should be placed at the time you send the 
message. When this option is enabled, the Default copy-to-self folder name field is ignored.

Copy-to-self filtering    The most powerful option of all, this allows you to create a special set of filtering 
rules that act on your copies-to-self. Using these rules, you can choose which folder should receive the 
copy to self, send copies of the message to other users, even print the message at send time. For more 
information on creating mail filtering rules in Pegasus Mail, please click here.



Folders and folder preview mode preferences

See also: Preferences overview

Folder 'preview mode' settings

The settings in this group apply only when you have switched to Pegasus Mail's folder preview mode by 
clicking the Preview button in the folder manager window.

Display a 'details' ribbon in association with the preview area    When this control is checked, a small grey 
area will appear above the message preview pane, in which information about the sender, recipient and 
subject of the message will be displayed. The ribbon also has a set of status indicator controls that show 
you at a glance whether messages have been replied to, forwarded, and so on. If you change the setting 
of this control, the change will take effect the next time you open the folder manager window.

Apply filtering rules when previewing folders    If this control is checked, Pegasus Mail will apply any 
filtering rules associated with a folder whenever the folder is previewed in the folder manager window. If 
this control is not checked, then filtering rules will only be applied to a folder when it is opened in its own 
separate window by clicking the Open button.

Remember and apply each folder's sorting mode separately    If you check this control, Pegasus Mail will 
remember the way each folder is sorted and will restore that sorting mode when the folder is previewed. If
the control is not checked, the preview window will use the same sorting mode for all folders.

Ctrl+W activates the preview and selects the new mail folder    If this control is checked, pressing Ctrl+W 
or clicking the "Open new mail folder" toolbar button will open the folder manager window (or bring it to 
the front if it is already open) and select the new mail folder for previewing. If this control is not checked, 
then Ctrl+W will cause the new mail folder to open in its own window, as if you had selected it in the 
preview and clicked Open.

Mark previewed messages as having been read    When checked, this control causes mail that is 
displayed in the message preview area to be marked as having been read. If the control is not checked, 
messages will only be marked as read when you explicitly open them in their own window.

Deleted space recovery

When you delete a message, Pegasus Mail does not actually remove the message's data from the folder 
- instead, it simply marks the message as "deleted", and adds the size of the message data to an internal 
counter. Whenever the folder is closed, Pegasus Mail checks the internal counter to see if it exceeds a 
particular size, and if it does, it recovers the space occupied by all the deleted messages in the folder. If 
the folder is very large, or if you delete information from it frequently, this process of compression may 
become annoying or may take too long. Changing the value of this control allows you to tune the point at 
which Pegasus Mail will perform the deleted space recovery operation - setting a large number will make 
the operation happen less frequently, at the cost of having some of your disk space occupied by "dead" 
data. Setting this field to 0 turns off deleted space recovery - deleted data will never be removed from the 
folder, and it will therefore continue to get larger and larger over time.

The default value for this field is 24000 bytes: this value has been determined over a number of years to 
be a good compromise between performance and efficiency - we recommend that you do not change this 
value unless you have a clear specific reason for doing so.



Automatic formatting preferences

See also: Preferences overview

Pegasus Mail can perform a number of formatting operations on your text as you type it into the message 
editor. The settings controlling those operations are found in this page. Automatic formatting works 
correctly for both plain text and styled (HTML) mail.

Automatic formatting features

Pressing <Tab> at the start of a line indents the paragraph    When this option is turned on, each time you 
press <Tab> at the start of a line, the whole paragraph you type in will be indented one tab stop to the 
right.

Create a bullet item when <*><Tab> is typed at the start of a line    When this option is checked, Pegasus 
Mail will automatically create a bullet list entry when you type an asterisk (*) followed by a tab at the start 
of a line. This option only creates a single bullet item, not a bulleted list. You can also turn on bullets using
the button on the editor toolbar, but many people find this approach faster and easier.

Create hanging indents on a <Tab> near the start of a line    When this option is checked and you press 
the <Tab> key within five characters from the start of a line, Pegasus Mail will automatically format the 
paragraph with a hanging indent. This is useful for creating numbered lists - just type in the number, then 
press <Tab> and Pegasus Mail will automatically format that paragraph for you. As with bullet items, this 
option only applies to a single paragraph - Pegasus Mail does not support automatic numbering of 
paragraphs.

Autoreplacement

Do you find that your fingers seem to have crossed connections to your brain? Do you find that you 
perpetually type in "taht" when you mean "that", or "teh" when you mean "the"? If so, Pegasus Mail can 
help you by automatically correcting these glitches as you type them.

Enable autoreplacement of common typos and abbreviations    Check this control to turn on Pegasus 
Mail's autoreplacement feature. When the feature is turned on, Pegasus Mail will check each word you 
type against the autoreplacement list and will make any changes required automatically.

Autoreplacement list    The list displays the autoreplacements you have defined, showing what you expect
to type on the left-hand side, and what Pegasus Mail should replace it with on the right. So, if you want 
Pegasus Mail to correct "teh" to "the", you would click the "Add" button, and type the two words into the 
autoreplacement definition dialog that opens.

You can create as many autoreplacements as you wish: Pegasus Mail ships with a list of about five 
hundred of the most common typographic slips - you can use this list if you wish and you can supplement 
it with your own favourites.

Abbreviations    You can use autoreplacement for more than just correcting errors - you can also use it as 
a handy way of typing common words and phrases quickly. To do this, simply create an entry where the 
"when this is typed" item is an abbreviation, and the "replace it with this" entry is the full text. We 
recommend that you prefix your abbreviations with an underscore character ( _ ) so that there's no 
chance of them being confused with regular automatic corrections. This use of autoreplacement is very 
similar to another Pegasus Mail feature, the glossary, but is better-suited to short, common words and 
phrases.

Example: if you regularly type "Pegasus Mail", you might create an autoreplacement entry called "_pm" 
that expands to "Pegasus Mail" whenever you type it.



Note: an autoreplacement can only be a single word - Pegasus Mail cannot autoreplace phrases, 
although it can replace a word with a phrase.



Regular expression syntax

A regular expression is simply a way of defining a pattern of characters you would like to match. This kind 
of pattern matching is something the human mind does instinctively, but computers need to be given rules
describing how it should be done on a case by case basis.

In Pegasus Mail, a regular expression consists of text characters and metacharacters. A text character is 
simply a piece of invariant text that must appear in the data you are attempting to match, while a 
metacharacter is a special character that matches some arbitrary pattern. This is all a little too much like 
jargon, so let's take a simple example:

Say you want to define an expression that matches any string containing "sorry Dave"; in this case,
the text characters are "sorry Dave", and you need a special way of matching any text on either 
side of them. In this case, that "special way" is to use a metacharacter, "*", which Pegasus Mail 
interprets as meaning "match anything". So, to match any string containing "sorry Dave", we need 
to match anything preceding our text characters, then match the text characters "sorry Dave", then 
finally we need to match anything following our text characters. The regular expression we need to 
give Pegasus Mail to achieve this is "*sorry Dave*".

By combining metacharacters and text characters, it is possible to create patterns that can match almost 
any type of text. Pegasus Mail supports the following metacharacters in regular expressions:

* Match any number of any characters
? Match any single character
+ Match one or more occurrence of the last character
[ ] Encloses a group of characters to match. Ranges can

be specified in the group using '-'.

Let's look at one or two of these a little more closely:

* You'll probably use this metacharacter most often: it means "match anything" - which also 
includes "nothing". So, in our example above, Pegasus Mail will match the string "sorry Dave, I can't do 
that", even though there is nothing in front of the matching text characters.

? This matches any one character. Unlike *, it will always match at least one character - it won't 
match nothing. So, the expression "?? cat" will match the string "My cat", but it will not match the string "A 
cat", because there are too few characters before the text characters.

+ You'll normally use this to match a repeated occurrence of a character when you don't know in 
advance how many there might be. The most common use is to match space characters - so, the 
expression "A +cat" will match "A cat", "A          cat" or "A      cat".

[] Say you only want to match the digits 0-9: that's where the square brackets come in. The 
expression "[0-9]" tells Pegasus Mail to match any single character as long as it is 0, 1, 2, 3, 4, 5, 6, 7, 8 
or 9. Like the ? metacharacter, this matches exactly one character. You can use quite extensive ranges 
and combine them with single characters - for instance, the expression "[0-9a-exyz]" will match any digit, 
any letter from A to E, an X, a Y or a Z. You can combine range matching like this with the + 
metacharacter to match similar groups of characters: so, if you want to match any number, you could use 
the expression "[0-9]+", which would match "1", "123", "12304567" and so on.

It is important to remember that Pegasus Mail always attempts to match regular expressions on a line by 
line basis, starting at the beginning of the line. Imagine that we had written our example expression as 
"sorry Dave*" (no leading * metacharacter): Pegasus Mail understands this to mean match any 
expression as long as it starts with "sorry Dave" - it would no longer match a line where this string 
occurred further on in the line.



Regular expressions in Pegasus Mail are always case-insensitive - that is, lowercase and uppercase text 
is treated as the same. So, "SORRY DAVE" is treated exactly the same as "sOrRy DaVe".



Translating Pegasus Mail

This section offers a short description of how a translated version of Pegasus Mail is created, and how 
you might be able to help.

Pegasus Mail consists of many language resources, among them this extremely large helpfile, so the 
process of translation is naturally quite time-consuming. In most cases, not only the resources need to be 
translated but the dialogs and windows themselves have to be resized and reorganized in order to ”fit” 
the new texts, because non-English versions are usually either much longer or shorter than the original 
English versions. A complete translation of Pegasus Mail from scratch needs some hundreds of hours 
including testing cycles - it‘s hard work but it‘s very rewarding!

Given the amount of work involved, the process of translation is usually carried out by a team of people, 
each taking a smaller part of the whole process. A translation team usually consists of a team leader who 
coodinates the work of the individual translators and merges the results, and anywhere from two to six 
assistant translators who each take a part of the translation process. The team leader has to know 
Pegasus Mail in detail and must have an excellent grasp of the English language.

The translation is done step by step including an intensive beta testing period for a couple of weeks with a
closed beta test user group. When the beta test team decides that the translation is ready for release, the 
resources are made available for download through the official Pegasus Mail Internet sites. There will also
be announcements on mailing lists and in selected newspapers/magazines.

If you are truly interested in helping translate Pegasus Mail into your mother tongue, please contact the 
translation coordinator at:

        translation-coordinator@pmail.gen.nz



Setting addressbook properties

This window lets you adjust key aspects of the way addressbooks are used by Pegasus Mail, most 
particularly whether addresses or aliases should be used when starting new mail messages, and whether 
or not specific addressbooks should be used to convert aliases into regular e-mail addresses.

Spare me the jargon: what do you mean by "Aliases"?    In Pegasus Mail, an Alias is a kind of 
"abbreviation" for an e-mail address: whatever you place in the "Name" field of an addressbook entry can 
be used as if it were an e-mail address - Pegasus Mail will convert it to the proper address when it sends 
the message. So, if you have created an addressbook entry where the "Name" field is Bob Smith, and the
address is Bob.Smith@mybusiness.com, then you can actually type "Bob Smith" into any address field in 
the program as if it were a valid address. Alias resolution is the process of turning the alias into the e-mail 
address that actually gets placed in the message.

The controls in this dialog are divided into two groups - one set which only change the behaviour of the 
currently-selected addressbook, and another set which changes the behaviour of all your addressbooks.

Apply the e-mail address instead of the alias    If you check this control, then Pegasus Mail will insert the 
e-mail address from the selected addressbook entries when you use them to create a new mail message.
In the default state, with the control unchecked, Pegasus Mail will insert the "Name" field of the entry as 
an alias.

Do not resolve aliases in this addressbook    If you check this control, then Pegasus Mail will not check 
this addressbook when resolving aliases. You might want to do this for very large addressbooks, or 
addressbooks that you don't use much but keep only for reference purposes. Alias resolution increases 
the time it takes Pegasus Mail to send your messages, particularly if you have large addressbooks. 
Checking this control will automatically check the Apply the e-mail address instead of the alias control, 
because pasting the alias is only useful if the alias later gets resolved correctly when the mail is sent.

The group of controls affecting the behaviour of all your addressbooks have the same general 
functionality as the specific controls; checking either of them will disable the corresponding specific 
control.

Double-clicking an address starts a new message    Normally, when you double-click an addressbook 
entry in the addressbook window, Pegasus Mail takes this as meaning that you want to edit that entry. If 
you would prefer that a double-click be interpreted as meaning "Start a new message using this entry", 
check this control.



Editing your signatures

Pegasus Mail allows you to have up to nine different signatures for your messages; furthermore, each 
signature has at least four possible variations.

Why do I need multiple signatures?    Imagine for a moment that you fill two roles in your organization - 
one in your day-to-day role, and the other as the postmaster for your company. It's very likely that you 
might want your signature information to be different depending on the "hat you are wearing" at the time 
you send a mail message. Having multiple signatures allows you to choose the right one with a couple of 
simple keystrokes.

Why do I need "variations" on my signatures?    Pegasus Mail can send mail both locally, and to 
Internet addresses, so you may want to attach different information to messages sent locally from the 
messsages you send to the Internet (a different e-mail address, area codes in your phone number and so 
on). Furthermore, Pegasus Mail supports formatting in mail, and if you send a message with formatting, 
you might also want your signature to contain formatting as well. As a result, each of your "signatures" is 
actually a "signature set", consisting of at least four different variations:

1: A signature for plain text mail sent to a local address
2: A signature for formatted mail sent to a local address
3: A signature for plain text mail sent to an Internet address
4: A signature for formatted mail sent to an Internet address

You will typically need to add signature data for each variation in your signature.

To edit your signature:    First, select the signature you want to edit using the control labelled Signature 
set: this tells Pegasus Mail to select that group of variations for edting. Next, select each variant of your 
signature using the Variant control and enter the information you want your signature to contain. The 
formatted variants will use an editor that allows formatting, while the plain variants will not. You can copy 
text from one signature or variant using Ctrl+C and paste it into another using Ctrl+V.





Introduction to the Pegasus Mail Message Reader

This tutorial describes the basic functionality of the Pegasus Mail message reader.
Click on each of the numbers for a description of that item - we recommend that

you click on the numbers in order the first time you use this tutorial.

You can click the tabs in the graphic above to switch the focus of this tutorial
to the description of that page.

Remember, you can always get help in Pegasus Mail by pressing the F1 key.



The view selector tabs

Clicking these tabs will change the "view" Pegasus Mail gives you of
the message.

Message: Shows you the contents of the message body
Attachments: Shows you the structure of the message, including

any attachments it has. This tab will be greyed-out
if the message has only a single part.

Annotations: Allows you to add notes to the message
Raw view: Shows you the message in its raw form.

Within this tutorial's main page, you can click on these tabs to switch
the focus of the tutorial to that view.



The toolbar

The toolbar contains buttons that give you easy access to the most common tasks
you will perform with your mail. You can either click the buttons or else press the
capitalized letter in the button's text to activate the function.

The next and previous arrows at the left of the toolbar allow you to step through the
contents of a folder. Holding down the Ctrl key as you click these buttons moves to
the next or previous unread message in the folder. You can use the + (or =) key to
activate the next button, and the - key to activate the previous button.

The green arrow at the right of the toolbar indicates that more buttons are available -
click the green button to scroll the extra buttons into view. Buttons do not have to
be in view to be activated by a keypress.

You can change the layout of the toolbar by right-clicking anywhere within it: you
can select the text and graphics version (shown above), a graphics-only version,
or a text-only version. Pegasus Mail remembers this setting once you have changed
it.

Other options are also available by right-clicking in the message itself.



The header display area

This area displays the headers of the message, which tell you who sent the message,
when, to whom and other information. By default, the header area displays approximately
four lines of header - you can resize the header area if you wish: simply move the mouse
cursor over the lower border of the header area until it changes into a sizing cursor then
click and drag the header area to the size you want.

Alternatively, you can quickly switch between the standard header area and an expanded
view by pressing the "Z" key.

E-mail addresses and web links are underlined in the header area - you can double-click
them to start new mail messages or to activate the link in your web browser.

You can copy text from the headers by selecting it with the mouse and pressing Ctrl+C.



The message body

Mail messages may be plain text, formatted text, or a special type of message that
contains both plain and formatted versions (such messages are marked with a black
triangle in the folder window); Pegasus Mail will choose and display the most
appropriate section from the message in this area.

Mail Digests (messages that contain a collection of other mail messages) will display
here as a list of messages: you can open an individual message in the digest by double-
clicking it, then use the next and previous buttons in the reader window that opens to
step through the messages in the digest.

You can select a portion of the message body using either the mouse or the keyboard.
When a selection is active, you can copy it by pressing Ctrl+C, print it by pressing <P>
or clicking the "Print" button, or reply using only that text by pressing <R> or clicking the
"Reply" button. If you have created special reply templates, you can generate a reply
using a template by holding down <Shift> then pressing <R> or clicking the "reply" button.

Pressing the <Space> bar will move through the message body a page at a time.

If the message has long lines, you can force them to wrap by pressing <F5>. This
setting is "sticky" - Pegasus Mail will remember it from message to message.

More options for working with the message are available on the Reader menu, or by
right-clicking within the message body.



The message status indicators

This bank of small buttons reflects the status of the message. Each button indicates
whether or not a particular condition applies to the message - if the button is coloured,
then the condition applies; if the button is greyed, then the condition does not apply. As
you step through a folder using the next and previous buttons, these indicators will change
to reflect the status of the message being displayed.

The buttons are as follows:

Indicates that the message has attachments. Clicking the button will switch to
the Attachments view (the same as clicking on the Attachments tab)
Indicates that a reply has been sent for this message. Clicking the button
removes the indication from the message.
Indicates that the message has been forwarded to someone else. Clicking the
button removes the indication from the message.
Indicates that the message has been marked read-only and cannot be deleted.

Clicking the button removes the condition and allows the message to be deleted.
Indicates the folder display colour chosen for the message. Clicking the button
allows you to choose a new colour code for the message.
Indicates that the message comes from a mailing list that supports subscription
management commands. Clicking the button opens a dialog allowing you to
manipulate some aspects of your subscription to the mailing list.



The Message Reader's Attachment View

This section of the tutorial describes the reader's Attachment view, in
which you can examine the attachments and structure of your mail messages.

Click on each of the numbers for a description of that item.

You can click the tabs in the graphic above to switch the focus of this tutorial
to the description of that page.



The Message Reader's Annotation View

This section of the tutorial describes the reader's Annotation view, in
which you can attach dated notes to your mail messages.
Click on each of the numbers for a description of that item.

You can click the tabs in the graphic above to switch the focus of this tutorial
to the description of that page.



The Message Reader's Raw View

The Raw view simply shows the message in its raw, unexpurgated form, including
all header information and MIME preludes and epilogs. If the message contains
HTML data, the raw view will show the actual HTML tags; similarly, messages
containing attachments will show the attachments in their transit format (usually
a special format called BASE64 in modern mail).

Most users will not need to use the raw view often, but for advanced purposes
it provides an extremely useful way of viewing the message at a very low level.

You can switch between the raw and normal views by pressing Ctrl+H.

You can select text in the raw view using the mouse or keyboard, then copy it
by pressing Ctrl+C.



The Attachment Toolbar

The attachment toolbar contains buttons that give you easy access to the most common
tasks you will perform with attachments. Like other toolbars in the program, you can
change the layout of the toolbar by right-clicking anywhere within it. The toolbar buttons
are as follows:

Open If there is an application on your system that can open the currently-selected
attachment, clicking this button will open the attachment in that application.

CAUTION! Use extreme care when opening attachments - although Pegasus
Mail itself is completely immune to viruses and other nasties, other
applications may not be. You can create viewer definitions in Pegasus Mail to
protect you from inadvertently opening dangerous attachment types - see the
Pegasus Mail preferences help for more information on how to do this.

Save Save the attachment to a file on your computer's hard disk.
Delete Remove the attachment from the message permanently. This option is

currently only available for mail that is still in the new mail folder.
Print Print whatever is currently being displayed in the preview area.
Reply Generate a reply to the message using the contents of the selected section

as the source text for the reply.
Forward Forward the selected sections to another address.



The attachment list and structure diagram

This section of the window contains a list of all the various parts of the message.
Traditional e-mail consisted of a "body" and possibly some "attachments", but
modern e-mail can have much more complex structure than that - for example, you
will often encounter mail messages that contain other mail messages, which in turn
may have their own "body" and "attachments". Pegasus Mail's attachment list lets
you find your way around even the most complex messages with ease.

The Type column displays the type of data in each section; if a section can be
opened using an application on your system, Pegasus Mail will display the icon
and description appropriate for that application.

Where a section of a message has an identifiable filename, Pegasus Mail will show
that in the Filename column. Not all sections of a message will have identifiable
filenames.

The Description column contains any descriptive text associated with each section
of the message. Pegasus Mail will generate descriptions for some sections, such as
the mail message body, automatically. Not all sections will have descriptive text.

The Size column contains an approximate estimate of the size of the section.



Splitter bar

You can resize the relative sizes of the attachment list and the
preview area by moving the mouse cursor over this divider bar until
it changes to a resize cursor, then clicking and dragging until the
panes are laid out the way you want them.



The attachment preview area

Pegasus Mail can preview many types of data without assistance from other
applications - including most graphic types, Microsoft RTF (RichText) format 
documents, HTML, and any purely textual data. If a section can be previewed
it will automatically appear here when you select it in the attachment list.

The Print button on the attachment toolbar will print whatever is currently
displayed in the preview area.

For most types of data in the preview area, you can select a portion using
the mouse or keyboard, then copy it and paste it into other applications or
windows.



The annotation toolbar

Save Saves your annotations. Annotations are also automatically
saved when you close the window or load another message.

Delete Removes your annotations from the message.
Export Allows you to save the text of your annotations in a file on

your computer's disk. The file is plain text and can be read
using practically any application.

Import Loads a plain text file into your annotations.
Timestamp Inserts the current date and time at the cursor position.



Formatting your annotation text

Annotations are basically intended to be textual in nature, and only
limited text formatting is possible. The buttons on the toolbar allow you
to change the paragraph alignment and indentation, and to check the
spelling of your text.

Future versions of Pegasus Mail will allow you to store formatted text,
including pictures and tables, in your annotations.



The annotation editing area

Simply type in any comments you want to store with the message
in this area. The text you type will be saved automatically if you
close the reader window or load another message, or if you prefer,
you can explicitly save them by clicking the Save button on the
annotation toolbar.

Annotations can be any size, and will move with the message if
you transfer the message to another folder. Annotations are not
forwarded when you forward a message. When the message is
deleted, its annotations are also deleted.




